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Legal information 
Warning notice system 

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger. 

 DANGER 
indicates that death or severe personal injury will result if proper precautions are not taken. 

 

 WARNING 
indicates that death or severe personal injury may result if proper precautions are not taken. 

 

 CAUTION 
indicates that minor personal injury can result if proper precautions are not taken. 

 

 NOTICE 
indicates that property damage can result if proper precautions are not taken. 

If more than one degree of danger is present, the warning notice representing the highest degree of danger will 
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to 
property damage. 

Qualified Personnel 
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. 
Qualified personnel are those who, based on their training and experience, are capable of identifying risks and 
avoiding potential hazards when working with these products/systems. 

Proper use of Siemens products 
Note the following: 

 WARNING 
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended 
or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be complied with. The information in the relevant documentation must be observed. 

Trademarks 
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication 
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner. 

Disclaimer of Liability 
We have reviewed the contents of this publication to ensure consistency with the hardware and software 
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the 
information in this publication is reviewed regularly and any necessary corrections are included in subsequent 
editions. 
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This manual… 
… supports you when commissioning your SIMATIC NET PC modules in a PC station and 
helps you to use them successfully. 

… introduces all the tools made available by the SIMATIC NET software for solving your 
communication tasks. 

... answers your questions about communication together with the supplied OPC 
documentation: 

 

Documents on the Internet 
You can obtain numerous documents from the Internet. 

You can find the latest version of this manual on the Internet in the product support pages for 
the respective product. 
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Additional information on SIMATIC S7 and STEP 7 
The documentation on SIMATIC S7 and STEP 7 contains additional information on the 
STEP 7 basic software of the SIMATIC automation system. You can obtain this from your 
local Siemens office. 

References /.../ 
References to other manuals and documentation are indicated by numbers in slashes /.../. 
These numbers refer to the titles of manuals listed in the References section at the end of 
the manual.  

Trademarks 
The following and possibly other names not identified by the registered trademark sign ® are 
registered trademarks of Siemens AG: 

SIMATIC NET, HARDNET, SOFTNET, CP 1612, CP 1613, CP 5612, CP 5613, CP 5614, 
CP 5622 

Industry Online Support 
In addition to the product documentation, the comprehensive online information platform of 
Siemens Industry Online Support at the following Internet address: 
 
(http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo2&aktprim=99&lang=
en)  

Apart from news, there you will also find: 

● Project information: Manuals, FAQs, downloads, application examples etc. 

● Contacts, Technical Forum 

● The option submitting a support query: 
(https://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid
=38718979&caller=view) 

● Our service offer: 

Right across our products and systems, we provide numerous services that support you 
in every phase of the life of your machine or system - from planning and implementation 
to commissioning, through to maintenance and modernization. 

You will find contact data on the Internet at the following address: 
 (http://www.automation.siemens.com/partner/guiwelcome.asp?lang=en) 

http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo2&aktprim=99&lang=en
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo2&aktprim=99&lang=en
https://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=38718979&caller=view
https://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=38718979&caller=view
http://www.automation.siemens.com/partner/guiwelcome.asp?lang=en
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SITRAIN - Training for Industry 
The training offer includes more than 300 courses on basic topics, extended knowledge and 
special knowledge as well as advanced training for individual sectors - available at more 
than 130 locations. Courses can also be organized individually and held locally at your 
location. 

You will find detailed information on the training curriculum and how to contact our customer 
consultants at the following Internet address: 

 (www.siemens.com/sitrain) 

Security information 
Siemens provides products and solutions with industrial security functions that support the 
secure operation of plants, systems, machines and networks. 

In order to protect plants, systems, machines and networks against cyber threats, it is 
necessary to implement – and continuously maintain – a holistic, state-of-the-art industrial 
security concept. Siemens’ products and solutions only form one element of such a concept. 

Customer is responsible to prevent unauthorized access to its plants, systems, machines 
and networks. Systems, machines and components should only be connected to the 
enterprise network or the internet if and to the extent necessary and with appropriate security 
measures (e.g. use of firewalls and network segmentation) in place. 

Additionally, Siemens’ guidance on appropriate security measures should be taken into 
account. For more information about industrial security, please visit  
(http://www.siemens.com/industrialsecurity) 

Siemens’ products and solutions undergo continuous development to make them more 
secure. Siemens strongly recommends to apply product updates as soon as available and to 
always use the latest product versions. Use of product versions that are no longer supported, 
and failure to apply latest updates may increase customer’s exposure to cyber threats. 

To stay informed about product updates, subscribe to the Siemens Industrial Security RSS 
Feed under  
(https://support.industry.siemens.com/cs/ww/en/ps/15247/pm) 

http://www.siemens.com/sitrain
http://www.siemens.com/industrialsecurity
https://support.industry.siemens.com/cs/ww/en/ps/15247/pm
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SIMATIC NET glossary 
Explanations of many of the specialist terms used in this documentation can be found in the 
SIMATIC NET glossary. 

You will find the SIMATIC NET glossary on the Internet at the following address: 

50305045 (http://support.automation.siemens.com/WW/view/en/50305045) 

Recycling and disposal 
The products are low in harmful substances, can be recycled and meet the requirements of 
the Directive 2012/19/EU for disposal of waste electrical and electronic equipment (WEEE). 

Do not dispose of the products at public disposal sites. 

For environmentally compliant recycling and disposal of your electronic waste, please 
contact a company certified for the disposal of electronic waste or your Siemens 
representative. 

Note the different national regulations. 

http://support.automation.siemens.com/WW/view/en/50305045
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 The SIMATIC PC-Station 1 
1.1 Overview 

Use of PCs in automation 
A PC station is a PC with communications modules and software components within a 
SIMATIC automation solution. 

The hardware configuration of a PC station can be compared with the configuration of an S7 
controller In SIMATIC: 
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Software - The OPC server as central component 
A PC station contains SIMATIC NET communication modules and software applications. The 
SIMATIC NET OPC server is a typical software application that allows other application 
programs to communicate. 

Uniform engineering environment 
The PC station is handled in the configuration with STEP 7 in the same way as an S7 
controller: You connect S7 stations and PC stations to the networks in the network view and 
specify the communication connections. 

The project engineering data is downloaded to the stations at the touch of a button. With PC 
stations, you have 2 options: 

● Remote configuration and download: 

Direct initial configuration or modification of a configuration and transfer of the project 
engineering data to an (online) PC station available over an Ethernet adapter.  

● Load a PC station (XDB import): 

Configuration data are stored here in a file and can be imported into the PC station. 
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Index for every component 
To allow communication between the components in the PC station and to receive project 
engineering data, each component is assigned a unique identification number. The 
identification number for modules, applications, and other components in a PC station is the 
index. The index corresponds to a virtual slot in a PC station according to the slot of a 
module in an S7 controller. 

 

 Note 

Be careful not to confuse this "index" with a hardware slot, for example on the PCI bus of the 
PC. The slot on the PCI bus is not relevant for commissioning and is not used at any point.  
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1.2 A brief introduction to tools and utilities 
Once you have installed the "SIMATIC NET PC Software", you have the resources and tools 
listed below. Note that the STEP 7 configuration software is available as a separate software 
package. 

Basic tools: 

● "Station Configuration Editor" 
Use this tool to plug modules and components into the virtual slots of the PC station and 
assign addresses and parameters to them. 

● STEP 7 Professional configuration tool (TIA Portal) 
With STEP 7 Professional (TIA Portal), you can perform most PC configuration tasks, 
among other things. A STEP 7 Professional license is not required for PC configuration. 
You can find an introduction to PC configuration with STEP 7 Professional (TIA Portal) in 
the section ""STEP 7 Professional (TIA Portal)" (Page 178)" or in the documentation of 
STEP 7 Professional (TIA Portal). 

 

Additional tools and utilities: 

● Symbol Editor 
With the Symbol Editor, you can create symbol files that allow you the option of access to 
symbolic variables over the SIMATIC NET OPC server. 

● "Communication Settings" configuration program  
The "Communication Settings" configuration program provides a variety of options for 
configuration and diagnostics of PC hardware components and PC user programs as well 
as the OPC servers. 

● SIMATIC NET notification service 
The information service displays information on events that occurred due to activated 
trace requests. Trace requests can be made in the "Communication Settings" 
configuration program. 

● OPC Scout V10 
With the OPC Scout V10, you can test an OPC application or commission the OPC 
server. 

● DCOM settings (Windows system program)  
To allow a client to use a COM object on another computer, the properties of the COM 
object must be configured on the client and on the remote computer. 

● S7 connection diagnostics  
The "S7 Connection Diagnostics" program is useful for testing and commissioning 
configured S7 connections, especially high-availability S7 connections. 
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1.3 Guide to installation and commissioning 
Prior to commissioning, clarify the area of application of your PC station and determine the 
required operating mode of your communication module. Commissioning then differs 
depending on the intended operating mode of the communication modules. 

You can find an overview of the steps during commissioning in the following. The individual 
steps and tools are then described in more detail in the following sections.  

1.3.1 PG mode or configured mode - Considerations 
When commissioning and operating a SIMATIC PC station, distinctions must be made 
between the following areas of application. Depending on the application, select the mode of 
the communications module. 

● PG mode 

This is the default mode for a programming device (PG/PC) and HMI station. 

● Configured mode 

This mode should be selected for productive communication between applications in the 
PC station and the automation systems, for example SIMATIC S7. 

 
The primary use of your PC station is:  Resulting area of ap-

plication: 
 Selectable mode: 

• For diagnostics and maintenance and for 
programming and project engineering 
(STEP 7). 

 

 

Programming device 
(PG/PC) 

 

 
 

   
PG mode (default) 

• For process control tasks (operator control 
and monitoring). 
The station is used independent of a STEP 
7 project. 

• For project engineering (STEP 7) in an 
automated plant operated with S7 stations 

• For tasks in process control and visualiza-
tion. 

 

 
 

Engineering station 
(ES) 

 

 
 

  
  
  
 

Configured mode 

• As an automation system networked with 
programmable controllers. 

 

 
 

Runtime PC  
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Mixed operation is possible 
● If you set the mode for individual communications modules, you can also use the PC 

station in "mixed operation". 

● Mixed operation, in this sense, means the use of several communications modules, some 
in the configured and some in the PG mode. 

● Depending on the selected mode, the information below applies to the individual modules 
of the PC station. 

Characteristics of the selectable modes 
The table below shows the differences between the two selectable modes and how this 
affects handling of the PC station during commissioning and operation. 
 
Mode Characteristics / advantages when commissioning and during opera-

tion 
PG mode 
(default mode) 

A module in a PC station used in this mode is not included in the 
STEP 7 project. It is, however, possible to include it in the bus pa-
rameter calculation using the PG/PC station object. 
If your module in the PG or engineering station is configured for this 
mode, you must specify the interface on the PG or the engineering 
station explicitly with the "Set PG/PC Interface" or "Communication 
Settings" tool. 
With HMI stations, connections to communication partners are set up 
for process control over unconfigured S7 connections. 

Configured mode The PC station along with the modules planned in the project engi-
neering is included in a STEP 7 project so that the communication 
relations with the stations can be planned in the project. 
This has the following advantages: 
• Simple commissioning (initial configuration) by using this configu-

ration. 
• Networking parameters stored in the project are adopted 

(PROFIBUS). 
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1.3.2 Commissioning for PG mode - Overview 
PG mode is the default mode for programming devices (PG/PC) and HMI stations. 

 
Step How does it work? Tool 
1. Installing SIMATIC NET 
PC software 

install the SIMATIC NET PC software by following 
the installation instructions 

SIMATIC NET PC Software Installation 
Package 

2. Installing hardware (PC 
modules) 

Installing PC modules in the PC station See documentation of the PC modules 

3. Configuration for PG mode Assign addresses and interface parameters to the 
PC modules 

Communication Settings / 
Set PG/PC Interface 

 

Result: 
PC station is ready for operation in PG/PC mode. 

Next step for HMI stations only: 
4. Configuration for HMI 
stations 

Specify the access points for the applications Communication Settings / 
Set PG/PC Interface 

 

Result: 
The HMI station with its application are ready for operation. 
Communication via an unconfigured S7 connection is possible. 

5. Check configuration Set the communication parameters of the PC 
station 

Communication Settings 
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1.3.3 Commissioning for configured mode - Overview 
When commissioning in configured mode, 3 situations can be distinguished. The situation 
depends on whether or not project engineering data is already available in the form of an 
XDB file or whether commissioning is independent of project engineering (no XDB file). 

Initial configuration means the step in commissioning at which the PC module is switched to 
"configured mode" and obtains addresses and network parameters. 

● Case a) Initial configuration via remote configuration with STEP 7 

This procedure assumes that the PC stations and their components and applications are 
initially configured in STEP 7. The PC destination station, which can be reached (online) 
via an Ethernet card, is then configured remotely via STEP 7.  

The advantage of this is that the project engineering data and the PC configuration are 
consistent and the total effort is minimal. 

 
Step How does it work? Tool 
1 Install SIMATIC NET PC 
software on configuration 
PC/PG and on PC station 

install the SIMATIC NET PC software by follow-
ing the installation instructions 

SIMATIC NET PC Software Installation 
Package 

2. Installing hardware (PC 
modules) 

Installing PC modules in PC stations See documentation of the PC modules 

3. Configuring PC stations Configuration of the PC stations includes:  
• Creating PC stations in STEP 7 

STEP 7 

Entering PC modules and applications in STEP 
7 

Network view / Device view 

• Creating STEP 7 connections 
• Use symbols (in the project engineering of 

the OPC server) 

Network view / Device view 

4. Initial configuration Remote configuration with the menu command 
"PLC" > "Configure" 

STEP 7 

5. Load configuration data 
into PC stations 

Download the project engineering data with the 
menu command "PLC" > "Download" 

STEP 7 

 

Result: 
PC stations are ready for productive communication. 

6. Check configuration Configuration Console Communication Settings 
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● Case b) Initial configuration with existing project engineering data (XDB file) 

This procedure assumes that the PC stations and their components and applications are 
initially configured in STEP 7. This produces a database (XDB file) that is then made 
available to the commissioning engineer of the PC stations for the initial configuration. 

The advantage of this is that the project engineering data and the PC configuration are 
consistent and the total effort is minimal. 

 
Step How does it work? Tool 
Project engineering 
(as prerequisite for initial 
configuration) 

Configuration of the PC stations includes:  
• Creating PC stations in STEP 7 

STEP 7 

Entering PC modules and applications Network view / Device view 

• Creating connections 
• Use symbols (in the project engineering of 

the OPC server) 

Network view / Device view 

Configuration data of the PC stations is stored in 
an XDB file. 

STEP 7 

1. Installing SIMATIC NET PC 
software 

install the SIMATIC NET PC software by follow-
ing the installation instructions 

SIMATIC NET PC Software Installation 
Package 

2. Installing hardware (PC 
modules) 

Installing PC modules in the PC station See documentation of the PC modules 

3. Initial configuration Import XDB 
Configuration data is transferred to the PC sta-
tions. 

Station Configuration Editor 
(subsequent download of configuration 
data also possible with STEP 7) 

 

Result: 
PC stations are ready for productive communication. 

4. Check configuration Configuration Console Communication Settings 

 

● Case c) Initial configuration at the PC station 

The initial configuration of the PC modules can be performed directly at the relevant PC 
station using the Station Configuration Editor. An XDB file is not required in this case. 

This initial configuration can optionally be imported into the STEP 7 project for 
configuration of the PC station in STEP 7. 

After the import, the configured PC modules appear in the device view of the PC station 
in your STEP 7 project. Consistency with the real configuration is guaranteed. 

Once the configuration is completed, the configuration data must be transferred to the PC 
station. Depending on the availability of the station, this is achieved by download or 
loading the station (XDB import). 
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Step How does it work? Tool 
1. Installing SIMATIC NET 
PC software 

install the SIMATIC NET PC software by following 
the installation instructions 

SIMATIC NET PC Software Installa-
tion Package 

2. Installing hardware (PC 
modules) 

Installing PC modules in PC stations See documentation of the PC modules 

3. Initial configuration Module configuration Station Configuration Editor 

 

Result: 
The PC station with PC modules and applications are configured and 
ready to receive configuration data. 

4. Check configuration Configuration Console Communication Settings 
5. Optional: 
Data export 

Enter the configuration in a new (temporary) STEP 
7 project "PC station". 

STEP 7 

6. Configuration 
(this is not dependent on the 
previous steps but is required 
for step 7) 

Configuration of the PC stations:  
• Creating PC stations in STEP 7. 
• Optional (see step 5): Adopt the configuration 

from the project created in step 5. 

STEP 7 

Enter PC modules and applications in STEP 7 
(identical to information in the Station Configura-
tion Editor) 

Network view / Device view 

• Create connections in STEP 7 
• Use symbols (in the project engineering of the 

OPC server) 

Network view / Device view 

For "offline mode": Save the configuration data of 
the PC stations in XDB. 

Network view / Device view 

7. Download configuration 
data to the PC stations 

Depending on the accessibility of the PC stations:  
Online: Load (local or remote) configuration data 
into the PC stations 

STEP 7 

Import XDB Station Configuration Editor 

 

Result: 
PC stations are ready for productive communication. 

8. Check configuration Configuration Console Communication Settings 
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 Getting started 2 
2.1 "Configured mode" 

This section shows you how to commission your PC stations with PC modules for the 
"Configured operation" operating mode the first time (initial configuration). 

"Configured operation" mode is used for productive communication between the applications 
in the PC stations and the automation devices, e.g. SIMATIC S7. 

It also explains the relationship with the configuration and shows how data exchange 
between the PC stations and the configuration tool works. 

Requirement: "SIMATIC NET PC software" and hardware are installed 
Before you perform the steps described, you first need to install the SIMATIC NET PC 
software and hardware on your PC stations. 

● Installing "SIMATIC NET PC Software": 

To install the products of the "SIMATIC NET PC Software", proceed according to the 
corresponding installation instructions. 

The installed products are described in detail in the section "Tools (Page 171)". 

● Installing hardware (PC modules): 

Install the hardware in your PC as described in the operating instructions supplied with 
each PC module. 
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2.1.1 Steps in project engineering 
Use the STEP 7 tool or alternatively STEP 7 Professional (TIA Portal) to perform the 
configuration. Furthermore, only STEP 7 is mentioned for both software packages. 

Why do we need project configuration? 
To allow the devices networked in a plant to communicate, these devices must be supplied 
with data relating to the components and the communication connections. Before devices 
can go over to productive operation, the project engineering data must first be created and 
loaded on the devices. 

This project engineering includes not only the PLC such as SIMATIC S7 stations but also the 
PC stations so that the communication relations between all devices of the plant can be 
specified. This makes it possible to run a consistency check and synchronize the elements of 
the system. 

Apart from specifying the PLC and PC stations and their properties on the LAN, project 
engineering also includes defining communication connections and symbols for process 
variables on the OPC server. 

Result 
Once the project engineering data has been downloaded to or imported into the PC station, 
the applications can communicate over the established communication networks with the 
stations reachable over the network. 

Initial situation 
● Case a) Initial configuration via remote configuration with STEP 7 

In order to be able to perform the initial configuration at the PC station accessible online 
in the next step, you must first configure the PC station with STEP 7. 

● Case b) An XDB file is available for initial configuration 

To be able to make the initial configuration in the next step, you must first create the 
configuration data for the PC station with NCM PC / STEP 7 and then make this data 
available in an XDB file. 

● Case c) The initial configuration has already been made on the PC station 

Project engineering data is downloaded or imported as an XDB file following initial 
configuration. 
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Follow the steps below: 
1. Start STEP 7. 

2. Create a PC station in an existing or new project. 

3. Perform the device configuration of the PC station by entering the required PC modules 
and software applications. It is recommended to use the OPC server. 

4. Save the configuration. 

5. Now network the PC station with other stations via its PC modules as required. 

6. XDB export for "offline mode": 

Now configure the PC station so that a configuration file (XDB) is created and adapt the 
storage location if needed. If you now compile the station or the entire project, this 
configuration file is generated and saved. 

7. If the PC station can be reached online (local or remote), the next step is the initial 
configuration of the station. 

 
  Note 

If STEP 7 Professional (TIA Portal) and the SIMATIC NET PC software are installed on 
the same PC, you must load the configuration data locally. To do this, select "PC internal" 
as access. 

 

Summary 
In the "Configuration" step described here, you were shown the following actions: 

● Creating a STEP 7 project or using an existing STEP 7 project. 

● Creating a PC station in the STEP 7 project 

● Inserting and networking PC modules in the PC station 

● Creating applications 

● Configuring connections for the applications 

● Storing the project engineering data in an XDB database 

The XDB database is then available for offline mode and can be used to import the 
engineering data on the PC station. 

Where to go from here - optional activities 
Once the project engineering configuration has been accepted, the PC station is operational. 
The following steps allowing the use of symbols, diagnostics, and calling the OPC Scout V10 
are optional. You should, however, check that the modules in your PC station are operational 
using the diagnostics functions.  
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2.1.2 Steps for initial configuration 
For the initial configuration, use one of the following tools depending on the procedure: 

● Station Configuration Editor 

● STEP 7 

Why do we need an initial configuration? 
The initial configuration is necessary when a module is commissioned for the first time. This 
initial configuration is done for all newly installed modules. 

After initial configuration of the modules, the PC station is set up to receive the project 
engineering data. This step can be compared with inserting the component in the rack of an 
S7 station. 

Result 
When you start the PC station, the PC module of the PC station is initially in PG mode.  

By adding the communications module in the "Station Configuration Editor", the module is 
automatically switched to "configured mode" and the index (the "virtual slot number") of the 
module is set. 

Relationship between initial configuration and project engineering 
Depending on the area of application, two situations must be distinguished: 

● Case a) Initial configuration via remote configuration with STEP 7 (Page 25)  

● Case b) Initial configuration with XDB file (Page 28)  

● Case c) Initial configuration using the "Station Configuration Editor" (Page 30)  
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2.1.2.1 Case a) Initial configuration via remote configuration with STEP 7 

Advantage of remote configuration 
The PC destination station that can be reached online is remotely configured direct from 
STEP 7. 

The advantage of this is that the project engineering data and the PC configuration are 
consistent and the total effort is minimal. Address parameters are adopted from the project 
engineering. 

You can also transfer project engineering data to the PC station later by downloading or 
loading the station (importing an XDB file). 

Select PC module for remote configuration ("SIMATIC Shell") 
Requirement 
The PC module for remote configuration must only be selected if several network modules 
are installed in one PC. The selection may be required both in the destination computers and 
in the configuration station. 
If only one PC module is available in the PC, it is automatically used as the PC module for 
the remote configuration. 

Program for selection 
Use the "SIMATIC Shell" program to select the PC module used for remote configuration. 
The "SIMATIC Shell" program is installed with the SIMATIC NET PC software products. 
Alternatively, you can also select the PC module in "Communication settings". 

 

 Note 

Select only the PC module in the "SIMATIC Shell" program...  

Leave the defaults for all other settings. 
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Follow the steps below: 

1. Start the Explorer of the Windows operating system. 

2. Start "SIMATIC Shell". 

"Computer" > right-click on the "Simatic Shell" directory > shortcut menu "Settings..." 

Reaction: The "SIMATIC Shell" program is started and the "Communication settings" 
dialog box appears. 

 
  Note 

Alternatively, you can also start "SIMATIC Shell" via "Communication settings". 
 

 
3. Select network adapter intended for communication and confirm with "OK". 

4. As soon as the "Reinitialize" dialog appears, confirm with "OK". 

The name of the activated adapter is selected so that you can check it. 
 

  Note 

Note that a PC can only be configured via the network adapter that is marked in the 
"Network adapter" list in "SIMATIC Shell". 

 
  Note 

Make sure that the network cable is connected to the selected network adapter. 
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Performing an initial configuration with STEP 7 
Once you have specified the communication paths in the destination computers and the 
configuration station, you can start the initial configuration. 

 

 Note 

The "SIMATIC NET PC Software" must be installed on the configuration station to be able to 
configure via STEP 7. 

 

Follow the steps below: 

1. Select the configured PC station in your STEP 7 project. Switch to the network view in 
"STEP 7 Professional (TIA Portal)"; switch to the SIMATIC Manager in STEP 7 as of 
version 5.5. 

2. Open the "Configure" dialog. Click on "Online" > "Configure PC station online" in "STEP 7 
Professional (TIA Portal)"; click on "PLC" > "Configure" in STEP 7 as of version 5.5. 

 
3. Follow the instructions in the online help of the dialog to create and complete the remote 

configuration. 

Result: The PC station with PC modules and applications are configured and ready to 
receive configuration data. 
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2.1.2.2 Case b) Initial configuration with XDB file 
In this case, you can import the XDB file with the project engineering data for the PC station 
directly. 

The advantage of this is that the project engineering data and the PC configuration are 
consistent and the total effort is minimal. Address parameters are adopted from the project 
engineering. 

Follow the steps below: 
1. Start the "Station Configuration Editor" by double-clicking on its icon on the desktop. 

Reaction: You first see an empty configuration list. 

2. Import the XDB file using the "Import Station…" button. 

Reaction: All the PC modules and applications specified in the configuration are entered 
and displayed in a window. 

During import, all the project engineering data; in other words, device name, modules, 
applications, communication connections, and symbols are entered in the PC station. 

Importing is possible only when the imported configuration matches the existing local 
configuration. 

 



 Getting started 
 2.1 "Configured mode" 

Commissioning PC Stations - Manual and Quick Start 
Configuration Manual, 10/2018, C79000-G8976-C156-19 29 

3. To prevent project engineering data from being transferred online at a later point in time, 
select the "Work offline..." option. With the default setting (option is disabled by default), 
you ensure that configuration data can be transferred online. 

Result: The PC station is ready for productive communication: 

● Module addresses are set; 

● Communication connections configured in the project engineering are established; 

● Variables can be accessed using configured symbols. 

 
  Note 

You can also follow this procedure in the example "OPC Configuration for Industrial 
Ethernet" in this manual; refer to the section "OPC application for Industrial Ethernet 
(Page 109)". 

 

Where do we go from here? 
You can now use the other tools from SIMATIC NET for diagnostics, commissioning, and 
testing. 

See also the section "A brief introduction to tools and utilities (Page 14)". 



Getting started  
2.1 "Configured mode" 

 Commissioning PC Stations - Manual and Quick Start 
30 Configuration Manual, 10/2018, C79000-G8976-C156-19 

2.1.2.3 Case c) Initial configuration using the "Station Configuration Editor" 
In this case, you must first define the PC modules and applications (e.g. OPC server) locally 
on the PC station in the "Station Configuration Editor". 

You can transfer configuration data to the PC stations later by downloading or importing an 
XDB file. 

 

 Note 

You also have the option of importing the configuration data of the initial configuration into 
the engineering system. This makes it extremely simple to create a configuration in the 
configuration system that matches the configuration on the real PC stations. 

 

Follow the steps below: 
1. Start the "Station Configuration Editor" by double-clicking on its icon on the desktop. 

Reaction: You first see an empty configuration list. 

2. Assign the station name using the "Station Name…" button. 



 Getting started 
 2.1 "Configured mode" 

Commissioning PC Stations - Manual and Quick Start 
Configuration Manual, 10/2018, C79000-G8976-C156-19 31 

3. In the next step, you enter the components. 

Using the "Add..." button, select the module that will be put into configured mode. All the 
modules installed in the local station that are not yet configured are displayed for 
selection. 

 
  Note 

If there are several SOFTNET PROFIBUS modules, only one can be configured in project 
engineering. 

 

 
4. In the properties dialog that opens, give the PC module an address. 

In some cases, you can also set further module parameters, for example bus parameters, 
(mandatory with PROFIBUS). 

5. Repeat the steps for all other PC modules that exist in the local PC stations and that you 
want to operate in configured mode. 

6. Use the "Add..." button to add applications that are to be operated in the station. 

7. Repeat the steps for all other applications you want to use for the configured mode. 
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Result: The PC station with PC modules and applications are configured and ready to 
receive configuration data (select online mode!). 

 

 Note 

You will also find this procedure in our example "Configuration Example for PROFIBUS"; 
refer to the section "OPC application for PROFIBUS DP (Page 116)". 

 

Where do we go from here? 
In the next step, you supply the PC station with project engineering data.  
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2.2 "PG mode" 

Configuration for PG mode - Programming device (PG/PC) 
The configuration is performed via the "Communication settings" tool, see section 
""Communication Settings" (Page 198)". 

Proceed as follows to configure for PG mode: 

1. Start "Communication settings", for example, from the Start menu. 

2. Assign the appropriate PC module to the pre-defined "S7ONLINE" access point to make 
your PC module usable for STEP 7. To do this, select the "Access points" page in 
"Communication settings" and open the "S7ONLINE" access point. 

3. Assign the appropriate interface configuration. Some PC modules offer alternatives, e.g. 
the CP 1623 as follows (the number at the end stands for the numbering of PC modules 
of the same type): 
- If you use the TCP protocol – "CP1623.RFC1006.1": 

- If you use the ISO protocol – "CP1623.ISO.1". 

Or for CP 5623 as follows: 

- Normal case – "CP5623.PROFIBUS.1" 

- On the MPI string – "CP5623.MPI.1" 

4. If needed, set the appropriate communication parameters. Under "Module", search for the 
PC module corresponding to the selected interface configuration. For the configuration 
"CP1623.ISO.1", for example, this is the PC module "CP 1623"; for 
"CP5623.PROFIBUS.2" this would be the PC module "CP 5623(2)". 
 You can open configuration pages (e.g. "Address") for the selected PC module and 
make the required settings. 

Setting communication parameters – extra information 
Prior to operation, the following communications parameters must be set: 

● For PROFIBUS modules: 

– PG/PC is the only master on the bus 

– Address 

– Transmission speed 

– Profile (depending on application: DP for the DP protocol, otherwise the fast setting 
"Standard" or the safe setting "Universal") 

● For HARDNET IE TCP: 

– The IP address, subnet mask and gateway address 

● For SOFTNET IE TCP: 

The IP address, subnet mask and gateway address must be set. You can do this directly 
in the network settings of the Windows Control Panel, or by click on the "Network 
Properties..." button. 
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● HARDNET IE ISO, SOFTNET IE ISO: 

No settings are required for the ISO protocol. 

Please also note the diagnostic options provided in "Communication Settings". 

2.2.1 Configuration for PG mode - HMI stations 
The settings for using the communication modules by HMI applications are the same as for 
normal PG mode. However, you are not necessarily limited to the "S7ONLINE" access point. 
You can also use other access points suitable for the application.  

If the access points to be used have not already been created, you can create new access 
points using the "Communication Settings" configuration program. Create a new access 
point with the appropriate name (e.g. "HMI_Access") and configure it as described above. 
Then an application can use the set communication module via this access point.  

Unconfigured S7 connections, for example, can be operated via OPC. Use the OPC Scout 
V10 for testing and commissioning, for example. You can find information on the operation of 
such S7 connections via OPC in Industrial Communication with PG/PC Volume 2 - Interfaces 
/1/. 
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2.3 Using additional functions - points to note 

2.3.1 Checking the configuration and diagnostics 
The "Communication Settings" tool is a central tool for access to the components and data of 
the PC station during the following tasks: 

● Commissioning and operation 

● Editing the configuration 

● Diagnostics 

For more detailed information on the available functions, refer to the description in the 
section ""Communication Settings" (Page 198)". 

2.3.2 Testing with OPC Scout V10 
If you have entered the "OPC server" component in the configuration, you can test the 
function of your communication system as the final step. 

With the OPC Scout V10, via the OPC server you have access to all process variables that 
you can reach via the configured protocols and connections. 

2.3.2.1 Detecting communication errors with OPC Scout V10 

Introduction 
The OPC Scout V10 shows you the status of the communication connections. To do this, it 
makes use of the properties of the process variables or uses information variables. You can 
then recognize when a partner device is not accessible. 
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Errors when connecting with the OPC server  
● The locally installed OPC server cannot be started. 

Possible causes for this are as follows: 

– The PC station is currently receiving a new configuration. 

– By installing an OPC server of another manufacturer that has not kept to the 
guidelines laid down by the OPC Foundation common files have been corrupted. 

● The remote OPC Server is not accessible. 

This can occur when using DCOM and can have various causes: 

– The network connection is down. 

– The DCOM configuration of the local and remote server is not correct. 

– The remote server is not correctly installed or configured. 

● The firewall settings have not been made or have been made incorrectly. 

Use the "Communication Settings" program for this. 
"Communication Settings" > "..." > "Security". 

Errors when adding variables  
● Variable cannot be added 

Adding some or all variables is denied in the Navigator of the OPC Scout V10. Possible 
causes for this are as follows: 

– The variable name entered does not have the correct syntax. 

– When using symbolic variables: The symbol file does not match the configuration. 

– Access rights for the variables are restricted: Neither read nor write permissions. 

● A protocol or connections are not visible 

No protocols are visible in the lefthand window of the navigator or protocols or 
connections are missing. Possible causes for this are as follows: 

– Some of the required connections were not created during configuration in the project 
engineering. 

– A module configured in the project engineering does not exist or was not correctly 
initialized. 

– The configuration data created in the project engineering has not yet been transferred 
or transfer was unsuccessful. 

– The relevant protocol was not selected in the OPC protocol selection. 
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Checking the status of process variables  
● Quality of the variables is "bad" 

In the table view of the process variables, the value "bad" is entered for some or all 
variables in the "Quality" column. Possible reasons for this are as follows: 

– The network connection to the partner device is down. 

– The partner device is not configured in the project engineering. 

– The bus parameters of the PC station and partner device do not match. 

● The value of the information variable for the connections status is "Down" 

The information variable has the quality "good", however, the value is not "Up". 

These variables are generated by the OPC Server and always have the quality "good". 
The possible reasons for the value on the variable identical to those for quality = "bad". 

2.3.3 Further functions / special features 

2.3.3.1 Applying the configuration, symbols and SIMOTION Scout 
You can also use the symbols of SIMOTION Scout with the OPC server. These symbol files 
include not only the symbols but other project engineering information so that additional 
connection configuration for the PC station is not necessary.  

Adopting the project engineering and symbols 
Call the corresponding export functions for SIMATIC NET OPC symbol files in the 
corresponding engineering programs, e.g. SIMOTION Scout. Follow the instructions in the 
corresponding documentation. 

 

 
 

Transfer the created symbol file to your PC station. You can specify the required symbol file 
in the "Communication Settings" configuration program. 
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To use symbols for SIMOTION Scout, the PC module and thus the subnet via which the 
PROFINET or SIMOTION partner stations are connected must also be selected. You make 
this setting in an extra dialog when selecting the symbol file in "Communication Settings". 

You can check the selected module with the "Communication Settings" program using the 
"Access points" function:  

● Fixed access point SIMOTION CP_SM_1: e.g. "CP_SM_1:" > "CP5623.PROFIBUS.1" 

● Fixed access point PROFINET CP_PN_1: e.g. "CP_PN_1:" > "CP1623.RFC1006.1" 

For more information on PROFINET and SIMOTION, refer to the documentation of the 
SIMOTION Scout engineering program. 

2.3.3.2 Points to note with SOFTNET Industrial Ethernet modules 

Introduction 
Modules operated with the "SOFTNET Industrial Ethernet" software product are integrated in 
Windows just like a standard network adapter but with additional protocols. The station 
parameters for such modules can only be set with the standard mechanisms of Windows. 

Parameter 
The parameters to be set with Windows mechanisms are as follows: 

● IP address 

● Subnet mask 

● Gateway address 

Even when changing the station parameters during the initial configuration, the Windows 
configuration program must be used. During the initial configuration, you are prompted to 
start this tool. 

Transferring the project engineering data 
 

 Note 

Make sure that the network parameters of the PC station match the information entered in 
the configuration in your project. If this is not the case, it is not possible to establish 
connections. 

 

When a configuration is transferred from the project engineering system to a PC station and 
the transferred configuration contains different network parameters from those configured 
locally on the PC station, a warning is displayed. In this case, you will need to adapt the 
project engineering configuration in your project or set the local parameters according to the 
project engineering configuration. 
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2.4 Configuring the OPC server 

OPC server 
With the SIMATIC NET OPC Server described here, SIMATIC NET offers you a convenient 
tool with which your PC applications can write and read process data and receive notification 
of process events.  

By creating a project engineering database, you can specify the behavior of the OPC Server. 
Load the configuration data into the PC station with STEP 7. 

This section introduces the available options for configuring the OPC server with the STEP 7 
configuration tool. 

● Using default settings or project engineering parameters 

The parameters that can be set with STEP 7 are fully supplied with default settings, which 
ensures smooth communication in most cases. 

This section is only relevant for you if you want to change settings. 

Where to find further information 
● Using the interface to the OPC server in PC applications. 

How you address the OPC Server in your PC application and how the PC application 
reacts to the behavior of the OPC server is not described in this documentation. 

For more information on this topic, please read the detailed OPC documentation provided 
by SIMATIC NET /1/. 
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2.4.1 Significance of project engineering 

The OPC server application type 
The OPC server can be configured as an interface to all available communication protocols. 
You can create this object only once in a PC station. 

You can then use this OPC server for communication from user programs (OPC clients). 

What can be configured? 
 

 
 

Standard situation: Using the default settings 
In the simplest case (in other words, the standard situation), you simply need to create the 
OPC Server in the PC station. You must also create the communications modules used in 
the PC station and configure the communication connections. 

This is described in detail in the section ""STEP 7 Professional (TIA Portal)" (Page 178)". 

Using default settings or project engineering parameters 
The parameters are fully supplied with default settings, which ensures smooth 
communication in most cases. 
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2.4.2 Configuring the properties of the OPC server 
For the OPC server in the PC station, all protocol-specific parameters can be checked and 
set in addition to the general properties of the application. 

These parameters are independent of the communication connections to be configured 
separately or a DP master system or PROFINET IO system to be configured. 

The table below provides you with an overview of the possible parameter settings depending 
on the protocol or service type. 

 
Parameter / 
function 

Possible settings / signifi-
cance 

Can be set for a specific protocol ... 
DP FDL S7 ISO/TCP DP class 2 PROFINET IO SNMP 

Scan cycle 
time 

Here, you make the set-
tings to control updating 
by the OPC Server. 
The scan cycle time de-
cides how often the OPC 
server updates the values 
the OPC items. 

x x x x x x x 

Access pro-
tection 

You can specify the ac-
cess rights to individual 
variables or variable 
groups for each specific 
protocol. You can, for 
example, prevent varia-
bles calculated internally 
by the controller from 
being overwritten. As 
default, no access protec-
tion is activated. 

x x x x x x x 

Connection 
parameters 

Here, you can make the 
communication settings 
for services that do not 
require specific connec-
tions to be configured in 
project engineering. 

- - x - - - - 

Segmenta-
tion 

Special settings for 
providing the data buffers 
independent of specific 
connections. 

- -  x - - - 

Use symbols The symbols of the STEP 
7 project are used for the 
OPC server. 

- - x - - - - 

For a description of the parameters, refer to the online help of STEP 7. 
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2.4.3 Specifying connection properties for the OPC server in project engineering 
If you use OPC, communication connections are established and managed by the OPC 
Server. As a result, you create the communication connections only for the "OPC Server" 
application. 

If a connection is created for the OPC Server, the properties dialog for the connection 
includes an additional tab, "OPC - Properties". 

 

 NOTICE 

Configuration of the default parameter assignments 

Only qualified personnel should change the default parameter assignments. Changes can 
lead to unexpected situations and cause major system disruption. After changing 
parameters, they must be downloaded or exported and the import of an XDB started. 
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2.4.4 Using symbols for S7 connections 
Symbol tables are created during project engineering with STEP 7 on a central engineering 
station in the form of "ATI" files. 

You can continue to use the symbol definitions specified in the STEP 7 configuration in OPC. 
This is necessary if user applications (OPC clients) are to access symbolic variables via the 
OPC server.  

The symbol tables used are those of the CPUs for which S7 connections are planned for the 
OPC server. The symbols in the symbol table, that relate, for example, to data blocks (DB), 
inputs and outputs are taken into account. 

You can define which STEP 7 symbols you want to use in the OPC server in the properties 
for the S7 protocol of the OPC server. 

2.4.5 Configuring OPC properties for SNMP in project engineering 

2.4.5.1 Significance in SIMATIC NET 
You configure the OPC server as SNMP client in the "SNMP" tab. Here, you specify the 
protocol properties for SNMP for the transfer and a node list for the SNMP queries. To do 
this, click on the "Edit Plant Configuration..." button in the "SNMP" tab on the OPC server 
property page.  

 

 Note 

You need STEP 7 V5.5 or higher for the configuration. OPC SNMP cannot be configured 
with STEP 7 Professional (TIA Portal). For more detailed information on the use of SNMP 
over the OPC Server, refer to the documentation on OPC /1/ or the Quick Start in the section 
"SNMP communication with OPC (Page 128)". 

You will also find valuable information on the Internet at: 

SNMP OPC server: (http://www.automation.siemens.com/mcms/industrial-
communication/en/ie/software/network-management/snmp-opc-server/Pages/snmp-opc-
server.aspx)  

 

http://www.automation.siemens.com/mcms/industrial-communication/en/ie/software/network-management/snmp-opc-server/Pages/snmp-opc-server.aspx
http://www.automation.siemens.com/mcms/industrial-communication/en/ie/software/network-management/snmp-opc-server/Pages/snmp-opc-server.aspx
http://www.automation.siemens.com/mcms/industrial-communication/en/ie/software/network-management/snmp-opc-server/Pages/snmp-opc-server.aspx
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Device profiles for the SIMATIC NET PC software 
Device profiles are available for the following PC modules for the "SIMATIC NET PC 
Software": 

● HARDNET IE CPs > "MIBII_V10.txt" 

● CP 1613 A2 > CP1613_V10.txt 

● CP 1623 > CP1623_V10.txt 

● CP 1628 > CP1628_V10.txt 

● OSM > "Profil_OSM_V10.txt" 

● ELS > "Profil_ELS_TP40_V10.txt" 

You can find these files in the following directory: 
"<Installation drive>\Programs (x86)\Siemens\Step7\S7data\SNMP\Profile" 

 
  Note 

Note also the detailed parameter description in the online help of the dialog in STEP 7.  
 

2.4.5.2 SNMP traps 

Introduction 
Traps are messages that can be sent to the OPC Server without it requesting them. There 
are seven generic traps available on every SNMPcompliant device. There are also device-
specific traps that are described in the MIB file. 

Generic traps 
 
Parameter Meaning 
warmStart This is sent after a warm restart on the device. 
coldStart This is sent after a cold restart on the device. 
linkDown This is sent when a connection from the device was terminated. 
linkUp This is sent when a connection from the device was established. 
authenticationFailure This is sent when there was unauthorized access to the device. 
egpNeighborLoss The EGP neighbor (EGP = Exterior Gateway Protocol) of the de-

vice is not operational. The Exterior Gateway Protocol is used to 
exchange routing information between two neighboring gateway 
hosts. 

enterpriseSpecific This is sent when a devicespecific trap was sent. 
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 DCOM security 3 
 

 

Description 
DCOM must be configured for network access from an OPC client to an OPC server (does 
not apply to OPC UA servers). 

● For a client to utilize a COM object on another PC, the properties of the COM object must 
be configured. 

● The Windows system program "dcomcnfg" is used to configure DCOM and the required 
COM objects. 

Below, you will find the settings required and examples of client/server mode of the SIMATIC 
NET OPC server.  

We recommend that you keep to the following order: 

1. Enable network detection, see section "Enabling network discovery (as of Windows 7) 
(Page 46)". 

2. First, close your OPC applications and OPC servers using the "Communication Settings" 
> "Exit OPC Server" program. 

3. Make the initial setting of the OPC-DCOM configuration with the "Communication 
Settings" program.  
A general share should be set up in the "Security" branch of the "Communication 
Settings" program. This combines the required general individual steps into one action, 
see section "Enabling the DCOM configuration "Security" for OPC client/server operation 
(Page 46)". 

4. It is recommended to use the existing SIMATIC NET user group for the desired SIMATIC 
NET OPC-DCOM users. 
Add the desired users to the SIMATIC NET user group in the user management, see 
section "Configuration of the SIMATIC NET user group (Page 47)". 

5. Make the settings with the "dcomcnfg" system program. 
The possible settings and functionality depend on whether you are active in a domain or 
workgroup environment. see sections "Functions of the "dcomcnfg" system program for 
the computer workstation (Page 51)" and "Functions of the "dcomcnfg" system program 
for DCOM configuration of OPC servers (Page 60)" for the DCOM configuration of the 
OPC server". 
Examples for typical user configurations: See sections "Example - Windows domain 
operation (Page 76)", "Example - Windows workgroup operation (Page 93)" and 
"Example - Client computer operation only (Page 100)" 

6. Then restart your computer. 

 

In this section, you will, find information in the form of an example of configuring the client 
computer and configuring the PC with the OPC server for the situation where exactly one 
client is connected to the OPC server that is running on a different PC.  
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If you want to use more than one OPC server from a client, refer to the DCOM 
documentation.  

3.1 Enabling network discovery (as of Windows 7) 
For the different network profiles of Windows (public, private, domain, etc.), network 
identification and file and printer sharing must be activated for mutual visibility for DCOM 
operation. The computers should then be able to see each other under "Network" in the 
Explorer and should be reachable with a "PING". 

3.2 Enabling the DCOM configuration "Security" for OPC client/server 
operation 

"DCOM configuration security" for OPC client-server mode can be set in advance with the 
"Communication Settings" program. 

Proceed as follows to enable the DCOM "Security" configuration for OPC client/server 
operation: 

1. Start the "Communication Settings" program (Start menu "Start" > "..." > "SIMATIC NET" 
> "Communication Settings"). 

2. Select the "Security" setting in the tree structure ("SIMATIC NET Configuration" > "OPC 
Settings" > "Security"). 

3. Select the option "Remote basic and remote OPC communication (UA and COM). 

 
  Note 

Remember that the Allow function also affects applications, for example for DCOM port 
135, that also use this access method. 
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3.3 Configuration of the SIMATIC NET user group 
For the required users of SIMATIC NET OPC DCOM, it is advisable to use the existing user 
group SIMATIC NET. 

 

Follow the steps below: 

1. Go to the "Computer Management" menu (Start menu "Start" > "..." > "Computer 
Management"). 

2. In the tree structure of Computer Management, select "System Tools" > "Local Users and 
Groups" > "Groups". 

3. In the detailed window, select the "SIMATIC NET" group. 

4. Select the "Properties" entry in the shortcut menu. 

Reaction: The "Properties SIMATIC NET" dialog box opens. 

 



DCOM security  
3.3 Configuration of the SIMATIC NET user group 

 Commissioning PC Stations - Manual and Quick Start 
48 Configuration Manual, 10/2018, C79000-G8976-C156-19 

5. Click the "Add..." button. 

Reaction: The "Select Users" dialog box opens. 

 
6. Add the required DCOM users to the group, here, for example user "Alpha",  

member of the "Administrators" group and user "Beta" member of the "Users" group. 

 
The group can now be selected by the COM server for launch and access permissions 
for DCOM configuration.  
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3.4 Turning off a COM server 

Preventing OPC communication via COM 
If for security reasons you do not want to allow any classic OPC communication via COM in 
addition to OPC UA communication, you can make this setting using the system program 
"dcomcnfg".  

Follow the steps outlined below: 

1. Start the system program "dcomcnfg" and go to "Component Services > Computers > My 
Computer > DCOM Config", where all COM servers of this computer are listed. 

2. Select the relevant COM server and open its properties dialog box to prevent COM 
communication with one of the OPC protocol servers. The following table provides an 
overview showing which server is responsible for which communications protocol: 

 

Communications protocol COM server 
S7 SCoreS7 
S7OPT SCoreS7OPT 
DP SCoreDP 
DP2 SCoreDP2 
SR SCoreSR 
FDL SCoreFDL 
SNMP SCoreSNMP 
PROFINET IO SIMATIC NET core server PROFINET IO 

3. In the properties dialog box of the COM server select the "Security" tab and there under 
"Launch and Activation Permissions", select the option "Customize". 

4. With "Edit..." open the dialog box for setting the permissions. If the user group "Everyone" 
does not yet exist in "Groups and user names:". 
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5. Select the "Everyone" user group and set the selection for "Local Launch", "Remote 
Launch", "Local Activation" and "Remote Activation" to "Deny". 

 
6. Click the "OK" button and answer the prompt for confirmation the with "Yes". 

7. Then confirm the following properties dialog box with "OK". The launch and activation of 
the COM server is now explicitly denied for every user. 

 

 Note 

Explicit "Deny" settings are also not overwritten by the OPC security settings with the 
"Communication Settings" program. These settings can only be reset using the "dcomcnfg" 
system program. To do this, set the settings in the "Everyone" user group to "Allow" or 
remove the "Everyone" user group. Then make the required OPC security settings with the 
"Communication Settings" program. 
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3.5 Functions of the "dcomcnfg" system program for the computer 
workstation 

This section describes the functions of the "dcomcnfg" system program for the computer. 
 

 NOTICE 

Remember that after installing the SIMATIC NET PC software and enabling it as described 
in the earlier sections, the standard setting will assume an open system.  

It is the responsibility of the user to adapt the security settings to meet the actual 
requirements. 
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3.5.1 General settings for the workstation 
To make general settings for the workstation, proceed as follows: 

1. Start the "dcomcnfg" tool and open "My Computer" ("Component Services" > "Computer" 
> "My Computer"). 

2. Then open the properties of "My Computer" via the shortcut menu. 

Reaction: The "My Computer Properties" dialog opens with the following tabs: 

– General 

– Options 

– Default Properties 

– Default Protocols 

– COM Security 

– MSDTC 

 
 

  Note 

The "General", "Options" and "MSDTC" tabs are not required for commissioning the 
DCOM protocol and not discussed further here. 
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3.5.2 "Default Properties" tab 

Description of the settings 
In the "Default Properties" tab, you specify basic properties of DCOM.  

Operation on a domain server or in a workgroup 
 

 Note 

The settings made in the DCOM configuration depend on whether the computer with the 
OPC Server is logged on in a domain or is operated within a workgroup. 

 

If it operates within a domain, the server computer can check the configured rights of other 
accounts over the network (authentication). This is only possible when the accounts of the 
user are created with this domain. 

If there is a domain controller, it is advisable to work in a domain. 
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Proceed as follows to set the "Default Properties": 

1. For the sake of security, set the default authentication level to "Connect" and the default 
impersonation level to "Identify". 

2. Select the "Enable DCOM (Distributed COM) on this computer" check box. 

3.5.3 "COM Security" tab 

Description of the settings 
With the "COM Security" tab, you specify the permissions for DCOM. These properties are 
used by all COM objects that do not have their own settings. 

These settings make sure that only clients with the correct permissions can use the server. 
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 Note 

The settings listed in this description guarantee simple installation and startup of the DCOM 
protocol. Some of the security settings of the operating system are reduced. To meet stricter 
security requirements, you must increase the settings according to the DCOM guidelines. 

The settings are different if you use domains and workgroups. 
 

 Note 

If you change the security settings, the system must be restarted to activate the changes. 

The settings are described in sections "Example - Windows domain operation (Page 76)", 
"Example - Windows workgroup operation (Page 93)" and "Example - Client computer 
operation only (Page 100)". 
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The following default permissions are relevant in conjunction with DCOM: 
 
Default permissions Meaning 
Access permissions 
with the  
"Edit Default..." button 

The default access permissions for all COM objects specify which ac-
counts are allowed to access the object; in other words, call the meth-
ods and which accounts are explicitly denied access. 
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Default permissions Meaning 
Access permission limits 
with the  
"Edit Limits..." button 

Here, the absolute limits for access permissions must be expanded. 
 

 
 

Communication over OPC requires the following security limits: 
Local and remote access for the ANONYMOUS LOGON in the access 
permissions. 
These settings are made by "Communication Settings" at the touch of a 
button (see section " Enabling the DCOM configuration "Security" for 
OPC client/server operation (Page 46) "). 
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Default permissions Meaning 
Launch and activation per-
missions with the  
"Edit Default..." button 

The default launch and activation permissions for all COM objects 
specify which accounts have the right to create the object and which 
accounts are explicitly denied this permission. 
 

 
 

These permissions can be set individually for each object and the default properties are then 
ignored. 
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3.5.4 "Default Protocols" tab 

Description of the settings 
● In the "Default Protocols" tab, you specify the network protocols that are available for 

DCOM. 

● The priority is set by the order of the protocols in the dialog. DCOM uses the top protocol 
if a protocol is available. 
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3.6 Functions of the "dcomcnfg" system program for DCOM 
configuration of OPC servers 

This section describes the functions of the "dcomcnfg" system program for the DCOM 
configuration of the OPC server. 

Description of the settings 
1. First open the "DCOM Configuration" folder in "My Computer" to display all the COM 

objects available on the PC. 

2. Select the COM object "OPC.SimaticNET" to configure the individual properties and 
select "Properties" in the shortcut menu. 

 
  Note 

The Data Access OPC server for SIMATIC NET is listed as "OPC.SimaticNET". 
 

  Note 

The following description also applies analogously to the other OPC servers from 
SIMATIC NET listed below. 
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● OPC.SimaticNET.DP: High-speed data access server for the DP protocol 

● OPC.SimaticNET.PROFIdrive: Data access server for PROFIdrive (bus server) 

● OPC.SimaticNETAlarms: Alarms and events server for S7 protocol 

● OPC.SimaticNETAlarmsSNMP: Alarms and events server for SNMP protocol 

● OPC.SimaticNET.AE: Alarms and events server for S7 and SNMP protocol 

 



DCOM security  
3.6 Functions of the "dcomcnfg" system program for DCOM configuration of OPC servers 

 Commissioning PC Stations - Manual and Quick Start 
62 Configuration Manual, 10/2018, C79000-G8976-C156-19 

3.6.1 "General" tab 

Description of the settings 
On the OPC server, the default setting assumes an open system with the authentication 
level "None". It is up to the user to set the system to meet higher security requirements. 

 
If you select the "Security" tab with this authentication level, you can adapt the permissions 
in the "Properties of OPC.SimaticNET - Security" dialog. 

See also 
"Security" tab (Page 69) 
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3.6.2 "Location" tab 

Description of the settings 
In the "Location" tab, you specify the PC on which the server is started. To configure the PC 
with the OPC server, select the "Run application on this computer" check box. 
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To operate as pure OPC client computer, see "Example - Client computer operation only 
(Page 100)", a remote PC with SIMATIC NET OPC server can also be selected. To do this, 
select the "Run application on the following computer:" check box and use the "Browse..." 
button to select the desired PC or enter the PC name directly. 
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3.6.3 "Identity" tab 

Description of the settings 
The settings made in the "Identity" tab specify the account to be accessed to check the 
permissions of the user of the object. The following settings are possible in this tab: 

● "The interactive user" 

● "The Launching User" 

● "This User" 

The following table describes the meaning of the identity settings: 
 
Setting Meaning 
"The interactive user" The account of the user currently logged on at the PC is used.  

If, however, no user uses the computer, there is no interactive user 
and the COM object cannot be created. If you operate without a 
logged-on user, use the "This user" setting.  
"The interactive user" is the default setting for the OPC server for 
SIMATIC NET. 

"The Launching User" The account of the user that launched the OPC client is used.  
This user must then also have the required permissions; in other 
words, must be entered in the "Security" tab. The user must also 
have the default permissions entered in the user group on this PC, 
in other words must belong to the user group. 
Note: 
This mode must not be used with the OPC server for SIMATIC 
NET, since the OPC server would otherwise be started more than 
once by different user accounts and this is not permitted. 

"This User" The account of a specified user is used. This user must have the 
required permissions; in other words, must be entered in the "Se-
curity" tab. The user must also have the default permissions en-
tered in the user group on this PC, in other words must belong to 
the user group. 
This setting must be used to operate the OPC server for SIMATIC 
NET if more than one user is logged on (multi-terminal operation) 
or server operation if no interactive user is logged on. 
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"The interactive user" mode 
In this situation, a user with suitable permissions is logged on. This user starts an OPC client 
with its rights. In this OPC application, the local OPC server is started and executed in the 
user context of the logged on interactive user. 
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"This user." mode (server or service mode) 
In this situation, the PC has booted but no user is logged on. 
The system then displays the logon dialog. 

● In this case, in "This user" configure the user account with the rights with which the OPC 
server will be executed. 

● Select a user with adequate launch and access permissions for the OPC server. 

The OPC server can then be operated as a server to which one or more remote OPC clients 
with users with differing permissions have access over DCOM (server mode). 

The OPC server can also be started and operated by a local service and the OPC server is 
then started automatically without a logged-on user when the PC boots (service mode). 

Such an OPC application that is implemented as a service can also be started automatically 
by the SIMATIC NET configuration service after the SIMATIC PC station has booted. 

Enter the values in the "Services to be started after starting at the PC station" dialog (Start 
menu "Start" > "..." > "SIMATIC NET" > " Communication Settings" and then in "SIMATIC 
NET Configuration" > "Applications" > "Autostart" > "Services which should be started after 
start-up of the PC station"). 

With the "This user" setting, the OPC server is started and executed exclusively in this user 
context even when no user is logged on. 
With this setting, multiple instances of the OPC server are prevented since this would lead to 
illegal and inconsistent access. 
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"This user." mode (multi-terminal server mode) 
In this situation, several users are logged on at the terminal server and want to use the OPC 
server at the same time (multiterminal server mode). In this case, the OPC server must 
nevertheless be configured as "This user". 

Select a user with adequate launch and access permissions for the OPC server. This does 
not need to be one of the logged-on users.  
With the "This user", setting, the OPC server is launched and executed only in this user 
context even when several users are logged on. This setting prevents multiple instances of 
the OPC server since this would lead to illegal and inconsistent access. 
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3.6.4 "Security" tab 

Description of the settings 
You specify the access permissions for the OPC server in the "Security" tab. 

For the three aspects relevant to COM objects, you can either use the default permissions or 
adapted permissions for the selected COM object. 

Specifying the default permissions 
The users that are allowed to use the OPC server must be entered in the default access 
permissions, launch permissions, and configuration permissions. Several users have been 
entered in the following examples of the required permissions. 

For workgroup mode, the logons and therefore the information about permissions in the 
logon of the other PC must exist both on the server and on the client PC. 

Example of workgroup mode 
The "Alpha" user is registered on the PC with the server, "Beta" on the PC with the client. 
For DCOM operation a "Beta" account is required on the server PC (with the same password 
as on the client machine) and an "Alpha" account is required on the client PC (same 
password). 
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Example of domain mode 
The use of a group with logons is advisable when using a domain. The information about 
permissions is then fetched from the domain server. It is recommended that you use the 
SIMATIC NET user group. The required users are added as members of this group. This 
group can be used for the access and start permissions of the OPC server. 
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Adapted security settings 
If, for security reasons, you do not want a particular user to have all COM objects of the 
system available, configure user-defined, adapted permissions.  

Enter the users that are allowed to use the OPC server with the following permissions: 

● Launch and activation permissions 

● Access permissions 
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Additional rights for "ANONYMOUS LOGON" 
Communication over OPC requires that the following additional rights are set up: 

● Local and remote launch for the ANONYMOUS LOGON in launch and activation 
permissions; 

● Local and remote activation for Anonymous Logon in the launch and activation 
permissions 

● Local and remote access for the Anonymous Logon in the access permissions 

These settings are implemented at the touch of a button by the "Communication Settings" 
(refer to the section "Enabling the DCOM configuration "Security" for OPC client/server 
operation (Page 46)"). 

Multiterminal server mode, service or server mode with the identity "This user" of the OPC server 
In multiterminal-server mode or service or server mode in which the OPC server is started 
with the identity of a certain user ("This user"), you assign access, launch and activation 
permissions to this user. 
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Specifying access permissions 
Proceed as follows to define the access authorization: 

1. In the "Security" tab of the "OPC.SimaticNET Properties" dialog box, select the "Edit" 
button in the "Access Permissions" group box. 

Reaction: The "Access Permission" dialog box opens. 

 
2. Add the account of the user under which the OPC server will start.  

Access must be permitted for the "SYSTEM" account to allow use of the SIMATIC NET 
system services. 

 
  Note 

The default is "Everyone". 
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Setting launch and activation permissions 
Proceed as follows to define start and activation authorizations: 

1. In the "Security" tab of the "OPC.SimaticNET Properties" dialog box, select the "Edit" 
button in the "Launch and Activation Permissions" group box. 

Reaction: The "Launch and Activation Permissions" dialog box opens. 

 
2. Add the account of the user under which the OPC server will start. It is advisable to 

manage the user in the SIMATIC NET user group and to add the group here. 

 
  Note 

The default is "Everyone". 
 

Specifying configuration permissions 
Here you can adapt the configuration permissions. Normally, it is not necessary to change 
these configuration permissions to use DCOM OPC.  
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3.7 Example - Windows domain operation 
Windows domain mode is the recommended mode for OPC with DCOM because the users 
and their permissions are managed using a common domain server. 

 

 Note 
Requirements for the examples 
• The user must have extensive knowledge of computer administration. 
• The domain controller must be set up. 
• The terminal services must be working on the computers. 

 

Follow the steps below: 
1. Set up a SIMATIC NET group in the domain. 

2. Enable security in the "Communication Settings" program. 

3. Use one of the following examples for DCOM configuration: 

– Logged-on user, interactive mode 
"Example of a logged-on user in the domain, interactive mode (Page 77)" 

– User not logged on, server mode, service mode 
"Example of a non logged-on user in the domain - server mode, service mode 
(Page 89)" 

– Logged-on user, multiterminal server mode 
"Example of multiple logged-on users in the domain - multiterminal server mode 
(Page 90)" 
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3.7.1 Example of a logged-on user in the domain, interactive mode 

Configuration of the domain controller computer 
The following steps are necessary on the domain controller computer: 

● Configuration of the domain controller computer 

● General configuration of the client and server computer 

● Configuration of the server computer 

● Configuration of the client computer 
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General configuration of the client and server computer 
The following steps are necessary on the client and server computers: 

1. First set the remote OPC DCOM configuration using the "Communication Settings". 
Activate a general "Allow" in the security settings.  
This combines many necessary general single steps in one action. 

2. Set the DCOM configuration of the computer using the "dcomcnfg" program. 
When operating in a domain, the "Default Authentication Level" can by set to "Connect" 
and the "Default Impersonation Level" to "Identify" for security reasons (should be the 
default setting). 

 



 DCOM security 
 3.7 Example - Windows domain operation 

Commissioning PC Stations - Manual and Quick Start 
Configuration Manual, 10/2018, C79000-G8976-C156-19 79 

Configuration of the server computer 
1. Set the DCOM configuration of the OPC server "OPC.SimaticNET" using the "dcomcnfg" 

program. 

2. Select "Default" in the "Authentication Level" drop-down list box on the "General" tab. 
The SIMATIC NET OPC server "OPC.SimaticNET" is installed with the authentication 
level "None". For DCOM mode in the domain, access can be restricted by setting the 
authentication level to "Default". 
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3. Check "Run application on this computer" in the "Location" tab. 
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4. Adapt the security access and launch settings in the "Security" tab. 

 
5. In the "Launch and Activation Permissions" group box, click the "Edit..." button. 

 
  Note 

Do not add the "NETWORK" and local "Administrators" entries for the access and launch 
permissions otherwise all members of the domain will have access rights. 

 

Reaction: The "Launch and Activation Permissions" dialog box is displayed. 

Instead of the "Everyone" entry, the users or groups on the OPC client computer and on 
the OPC server computer must be entered explicitly in the access and launch 
permissions of "OPC.SimaticNET" security and in COM default security. Remember that 
users or groups added to the launch and access permissions are assigned all the listed 
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permissions. 
Use the domain group SIMATIC NET (with users Alpha and Beta) for the launch and 
access permissions. Further users such as "Gamma" are denied access even with 
domain administrator permissions. 
The following launch permissions are also required for the ANONYMOUS LOGON: 

– "Local Launch" 

– "Remote Launch" 

– "Local Activation" 

– "Remote Activation" 
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6. Click the "Edit..." button in the "Access Permissions" group box. 
Reaction: The "Access Permission" dialog is displayed. 
The various OPC protocol servers are implemented as services and therefore require 
"Local Access" permission for the SYSTEM account. 
The following is required for the access permission for "ANONYMOUS LOGON": 

– "Local Access" 

– "Remote Access" 

 
7. "Identity" tab 

In this application example, the identity remains "The interactive user". 
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Configuration of the client computer 
Configure DCOM of the OPC client 

 "OPC Scout V10" using the "dcomcnfg" program. 

1. DCOM object "OPC Scout V10" 

Select the DCOM object "OPC Scout V10" and select "Properties" in the shortcut menu. 

Reaction: The "OPC Scout V10 Properties" dialog box opens.  

Select the "Default" entry in the "Authentication Level" drop-down list box. 
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2. "Launch and Activation Permissions" and "Access Permissions" dialog boxes with the 
"Security" tabs 

Use the domain group SIMATIC NET (with users Alpha and Beta) for the launch, 
activation and access permissions. Further users such as "Gamma" are denied access 
even with domain administrator permissions. 
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3. Testing the settings made up to now 

This means that the logged-on domain user "Beta" on the client computer can access the 
server computer (here address 192.168.1.11) over DCOM and can therefore access the 
OPC server "OPC.Simatic.NET". 

 
 

  Note 
OPC security settings when changing domains 

In the "Communication Settings" configuration program, you can enable the OPC security 
settings for the Windows firewall and DCOM. Remember that the settings for the 
Windows firewall and DCOM configuration depend on the Windows logon. If, for example, 
you later join a Windows domain with the PC, it may be necessary to enable the OPC 
security settings for the Windows firewall and DCOM again in "Communication Settings".  
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3.7.2 Example of a non logged-on user in the domain - server mode, service mode 
In this situation, the computer has booted but no user is logged on.  

The system displays the logon dialog.  

The OPC server can: 

● then be operated as a server to which one or more remote OPC clients with users with 
differing permissions have access over DCOM ⇒ server mode. 

● also be launched and executed by a local service that is started automatically even 
without a logged-on user when the PC boots ⇒ service mode. 

Advanced configuration of the server computer 
Apart from the settings in the "Identity" tab described below, the settings are the same as 
those in "Example of a logged-on user in the domain, interactive mode (Page 77)". 

1. Set the DCOM configuration of the OPC server "OPC.SimaticNET" using the "dcomcnfg" 
program. 

2. Select the "This user" check box in the "Identity" tab of the "OPC.SimaticNET Properties" 
dialog of the OPC server. 

3. Click the "Browse..." button and select a user with adequate launch and access 
permissions for the OPC server and enter the password and password confirmation. 
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3.7.3 Example of multiple logged-on users in the domain - multiterminal server mode 
In this situation, more than one user is logged on at the terminal server (Windows 
Server 2003) and they want to use the OPC server at the same time ⇒ multiterminal server 
mode.  

Advanced configuration of the server computer 
Apart from the settings in the "Identity" tab described below, the settings are the same as 
those in "Example of a logged-on user in the domain, interactive mode (Page 77)". 

Set the DCOM configuration of the OPC server "OPC.SimaticNET" using the "dcomcnfg" 
program. 

1. Select the "This user" check box in the "Identity" tab of the "OPC.SimaticNET Properties" 
dialog of the OPC server. 

2. Click the "Browse..." button and select a user with adequate launch and access 
permissions for the OPC server and enter the password and password confirmation.  
This does not need to be one of the logged-on users. With the "This user", setting, the 
OPC server is launched and executed only in this user context (even when several users 
are logged on). 
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Testing on the server computer with terminal user "Alpha" 
A user "Alpha" logged on at the local terminal server can access the local OPC server 
"OPC.SimaticNET" over a remote connection. 
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Testing on the client computer with user "Beta" 
User "Beta" accesses the OPC server "OPC.SimaticNET" (the computer "s037402" in this 
example) from a remote computer via DCOM. 
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3.8 Example - Windows workgroup operation 
Windows workgroup mode is the simple but not recommended mode for OPC with DCOM 
because the users and their permissions are managed only locally.  

To use DCOM, the security checks must be reduced or disabled. 

Follow the steps below: 
1. General configuration of the client and server computer (Page 93)  

2. Configuration of the server computer (Page 96)  

3. Configuration of the client computer (Page 98)  

3.8.1 General configuration of the client and server computer 

Follow the steps below: 
1. Communication Settings - Allow security. 

2. Set the DCOM configuration for the workgroup. 
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Configuring the client and server computers 
1. Allow 

First set the remote OPC DCOM configuration using the "Communication Settings". 
Activate a general "Allow" in the security settings.  
This combines many necessary general single steps in one action. 

2. Set the DCOM configuration of the workplace using the "dcomcnfg" program.  
When working in a workgroup, due to the enable in the "Default Properties" dialog, the 
"Default Authentication Level" must be set to "None" and the "Default Impersonation 
Level" to "Anonymous". 
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3. In the "Default Protocols" tab, you specify the network protocols that are available for 
DCOM. The "Connection-oriented TCP/IP" protocol must be set at the top. 
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3.8.2 Configuration of the server computer 
The following table describes the settings for the server page of the OPC server 
"OPC.SimaticNET". 
 

Setting Meaning 
"Launch and activation permis-
sions" 

Allow launch and activation for administrators, everyone, network, 
system, ANONYMOUS LOGON and interactive (if not already set) 
- local! 

"Access permission" Allow access for administrators, everyone, network, system, 
ANONYMOUS LOGON and interactive (if not already set) - local! 
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3.8.3 Configuration of the client computer 
The following table describes the settings for the client page of the "Default Security" tab. 
 

Setting Meaning 
"Launch and activation permis-
sions" 

Allow launch and activation for administrators, everyone, net-
work, system, ANONYMOUS LOGON and interactive (if not 
already set) - local! 

"Access permission" Allow access for administrators, everyone, network, system, 
ANONYMOUS LOGON and interactive (if not already set) - 
local! 
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With these extensive default permissions, every OPC client in the workgroup can now 
access the OPC server over DCOM. This also applies to non-registered DCOM clients.  

First test DCOM access with the registered client "OPC Scout V10" and then with your OPC 
client.  

You can now replace the general user "everyone" with the users or user groups you require.  
 

 Note 

Recommendation: Replace "Everyone" with the "SIMATIC NET" group. 
 

Remember that the users must exist on all machines involved.  
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3.9 Example - Client computer operation only 

3.9.1 Example - Set client computer mode 

Overview 
When operating with DCOM, the OPC server runs on a different PC from the OPC clients 
(applications). This is why no process for the OPC server is visible in the Windows Task 
Manager of the client computer.  

To allow the OPC clients to access the OPC server, the following requirements must be met 
for this mode: 

● Registering the OPC server 

The OPC server and its location must be registered on the client computer.  

This registration is necessary so that the COM library knows the required object making 
configuration possible.  

Specify the user account that will be used to access the OPC server. 

● Registering the OPC client 

When necessary access permissions and security settings must be made for the OPC 
clients. 

 
 

 
 NOTICE 

Higher security requirements 

As shown below in the example of the OPC Scout V10, the default setting assumes an 
open system and assumes that the user will adapt the settings when higher security is 
required. 

 

Make the required settings analogous to the description of configuring the server 
computer in the section "Functions of the "dcomcnfg" system program for DCOM 
configuration of OPC servers (Page 60)".  

Below, you will find instructions on registering, for example the OPC Scout V10 as a 
client. 

● Providing "OPC proxy" libraries 

The OPC Proxy libraries ("OPC Core Components") provided by the OPC Foundation are 
required on the client computer. These libraries are used to convert the COM calls to a 
data stream so that they can be transferred over the network. 
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Registering the OPC server 
Specify the location of the server in the "Location" tab.  
For DCOM operation, only the check box "Run application on the following computer" may 
be selected.  
Click "Browse..." to select the server computer. 
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Register the OPC client, for example OPC Scout V10 
The OPC Scout V10 is an OPC client that you will find in DCOM as a registered object. 

 
If you display the properties of the OPC Scout V10 application in DCOM, "None" is displayed 
as the authentication level. 
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The default setting therefore assumes an open system and assumes that the user will adapt 
the settings when higher security is required. 

Register other OPC clients as DCOM objects. The advantage of this is that you can 
configure the security settings with "dcomcnfg" without needing to modify systemwide 
settings. 

Security settings per user program 
You can also make the security settings described in the earlier sections using the user 
program. To do this, you use the "CoIntializeSecurity ( )" call from the Windows 
programming interface with which you can specify the DCOM security. 

 

 Note 

Remember that the security settings made in the user program have priority over the settings 
made in the DCOM dialog!  

 



DCOM security  
3.9 Example - Client computer operation only 

 Commissioning PC Stations - Manual and Quick Start 
104 Configuration Manual, 10/2018, C79000-G8976-C156-19 

3.9.2 Example - Setting up the OPC client for client-computer mode 

Scope and purpose of the software package 
If only remote SIMATIC NET OPC servers are to be accessed in the Intranet, a complete 
installation of the "SIMATIC NET PC Software" is not required. In this case, you only need to 
install the OPC client setup for DCOM. 

Installation for DCOM mode 
To use DCOM, a minimum installation is required on the client computer. The necessary 
components (provided by the OPC Foundation) and the OPC Scout V10 are installed and 
registered. 

Following installation, DCOM must be set up. Refer to the section "OPC Scout V10" 
(Page 231) for this. 

Installing the software for the OPC client computer 
Proceed as follows to install the "SIMATIC NET PC Software": 

1. Start your PC. 

2. Log on as administrator in your Windows system. 

3. Insert the "SIMATIC NET PC Software" data medium into your drive. 

 
  Note 

If the "SIMATIC NET PC Software" installation program is started automatically, end it 
with "Cancel", since the installation of the entire "SIMATIC NET PC Software" is not 
required for the OPC client installation.  

 

4. In the Explorer, open the drive and start the "Setup.exe" program in the "\sw\OPC_Scout" 
folder. 
Follow the instructions in the installation dialogs. 

After successful installation of the software, if required set the DCOM configuration for the 
OPC client computer as described in the manual. 
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3.9.3 Advanced firewall settings 

Advanced firewall security settings 
The advanced security settings require advanced firewall settings for DCOM OPC operation.  

Two changes must be made in the Windows firewall: 

● Add the OPC Scout as an exception. 

● Add Port 135, type TCP as an exception. 

The following sections describe the steps involved. 

Adding the OPC Scout as an exception 
Follow the steps below: 

1. Open the configuration of the Windows firewall in the Control Panel. 

2. In the "Exceptions" tab, click the "Add Program" button and then "Browse...". 
You will find the OPC Scout program in "<Installation 
path>\simatic.net\opc_client\opc_scout\opc_scout.exe". 

Add Port 135, type TCP as an exception 
Follow the steps below: 

1. Open the configuration of the Windows firewall in the Control Panel. 

2. Go to the "Exceptions" tab, click the "Port" button and select Port 135, type TCP. 

3. Select a name, for example "DCOM". 

DCOM port 135, type TCP as inbound rule 
Follow the steps below: 

1. Start the program Windows Firewall with extended security "WF.msc". 

2. Click on "Inbound Rules" on the left. 
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3. Right click on "Inbound Rules" and then on "New Rule...". 

 
4. When asked "What type of rule would you like to create", select the "Port" button. 

5. Click the "Next" button. 

6. In answer to the question "Does this rule apply to TCP or UDP?", click the "TCP" button. 

7. In the "Specific local ports" text box, enter the port with number 135. 

8. Click the "Next" button. 

9. In answer to the question "What action should be taken when a connection meets the 
specified conditions?", click the "Allow the connection" button. 

10.Click the "Next" button. 

11.In this dialog, select the buttons "Domain", "Private" and "Public". 

12.Click the "Next" button. 

13.Enter a name for your inbound rule in the input field, e.g. the name "DCOM". 

14.Click the "Finish" button. 
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3.9.4 Advanced DCOM settings 

Advanced DCOM configuration 
The advanced security settings require advanced settings for DCOM OPC operation.  

Make sure that newly added users or groups are assigned all listed permissions in the 
launch and access permissions. 

Changes need to be made: 

● Restriction of the access permissions for COM security 

● Launch and activation permission for OPC.SimaticNET 

The following sections describe the steps involved. 

Making the settings to restrict the access permissions for COM security 
Follow the steps below: 

1. Go to the COM security settings as described in the section "Enabling the DCOM 
configuration "Security" for OPC client/server operation (Page 46)". 

2. Click on the "Add User" button. 

3. Add the "ANONYMOUS LOGON" user. 

4. Check the "Local Access" and "Remote Access" boxes. 

Make the settings for launch and activation permission for OPC.SimaticNET 
 

 Note 

As of Windows 7, the step "Launch and Activation Permission for OPC.SimaticNET" is no 
longer necessary. 

 

Follow the steps below: 

1. Go to OPC.SimaticNET as described in the section "Functions of the "dcomcnfg" system 
program" for the DCOM configuration of the OPC server. 

2. Click on the "Add User" button. 

3. Add the "ANONYMOUS LOGON" user. 

4. Check the "Local Launch", "Remote Launch", "Local Activation" and "Remote Activation" 
boxes. 
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 Examples 4 
4.1 OPC application for Industrial Ethernet 

4.1.1 Overview 

Explanation of the configuration example 
In the configuration example presented here, typical communication partners are coupled to 
Industrial Ethernet and can be reached via the OPC server.  

Example of an Industrial Ethernet configuration 

 
There is communication between two devices or modules. Communication with an S7-1500 
station via the S7 protocol is described in detail below. 

You will learn which tools you can use to plan and configure a PC station for coupling with an 
S7-1500 station. You will see how symbolic variables in the S7 program are made available 
in OPC. You will also see how to use the OPC Scout V10 program that ships with the 
product for communication with the OPC server. 
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Requirements 
If you want to try out the example yourself, you require the following: 

● A PC with "SIMATIC NET PC Software" installed and a CP 1623 communication 
processor plugged in 

● An S7 device with CPU 1516-3 PN/DP and CP 1543-1 

● Industrial Ethernet cabling between communication processor and S7 device 

For the S7 device and the PC station, you need a STEP 7 project (license is required), which 
was created on an engineering station. In the project, you specify the hardware configuration 
and the programs and data blocks and define a symbol table.  

4.1.2 Creation of the STEP 7 project 

PC station 
Proceed as follows to configure the PC station in STEP 7: 

1. In a new STEP 7 project, create a "SIMATIC PC station" from the hardware catalog via 
"PC Systems" > "PC General". 

2. Insert an OPC server in the hardware catalog via "PC systems" > "User applications". 

3. Configure the generation of an XDB file for the PC station via "Properties" > "General" > 
"XDB Configuration". 

4. Insert a CP 1623 communication processor into the PC station from the hardware catalog 
via "PC Systems" > "Communication Modules" > "PROFINET/Ethernet". 

S7 station 
Proceed as follows to configure the S7 station in STEP 7: 

1. In the STEP 7 project, create an additional S7-1516-3 PN/DP from the hardware catalog 
via "Controller" > "SIMATIC S7-1500" > "CPU" and ensure that the firmware versions of 
the configured device and your S7-1500 match. 

2. Insert a CP 1543-1 communication processor into the S7 station from the hardware 
catalog via "Controller" > "SIMATIC S7-1500" > "Communication Modules" > 
"PROFINET/Ethernet". 

3. Create a new variable table with one variable for the S7 CPU. 

4. Also create a new data block. 

5. Set up a suitable access protection for the S7 CPU and a suitable display protection via 
"Properties" > "General" > "Protection & Security" or "Display". 



 Examples 
 4.1 OPC application for Industrial Ethernet 

Commissioning PC Stations - Manual and Quick Start 
Configuration Manual, 10/2018, C79000-G8976-C156-19 111 

Networking 
Proceed as follows to network the stations in STEP 7: 

1. Network the two stations by dragging a line from the Ethernet interface of the CP 1623 to 
the Ethernet interface of the CP 1543-1 with the mouse. 

2. In the network view, switch to connection configuration and select "S7 connection" as the 
connection type. Create an S7 connection between the two stations by dragging a line 
from the OPC server to the S7 CPU with the mouse. 

3. The two stations are thus networked and prepared for communication via a configured S7 
connection, which can be operated via the OPC server. 

The picture shows the created and networked configuration: 

 

Symbols 
Proceed as follows to configure access to symbolic variables in STEP 7: 

1. Finally, configure access to symbolic variables for the OPC server. For this example, 
select the symbols pre-configured for the S7 connection in the OPC server properties, via 
"Properties" > "General" > "S7" > "OPC Symbols". 

2. Select the "Configured" option. Clicking on the "Configure …" button opens a 
configuration window, which in the symbol selection shows the variable and the data 
block you have previously configured with the respective symbolic name and makes them 
configurable for symbolic access. 

This provides you a fully functional system that you can compile and load into the 
appropriately equipped stations (alternatively load the PC station by importing the generated 
XDB file). 

When the stations are loaded, the namespace of the OPC server contains the configured S7 
connection with access to the data of the S7-1500 and all configured symbolic names in the 
"SYM:" namespace. 
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4.1.3 Commissioning and testing 
Now use the "OPC Scout V10" included in the "SIMATIC NET PC Software" for testing and 
commissioning the example project configuration. For example, navigate to the symbol 
namespace: For the COM server "OPC.SimaticNET", you can find it directly in the "\SYM:" 
group. The UA server "OPC.SimaticNET.S7" shows the "SYM:" group under "Objects". The 
symbol namespace contains all symbols accessible via the S7 connection. Depending on 
how the access rights for the symbols are configured, you can read and monitor or even 
change them. 
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4.2 OPC application for S7-REDCONNECT 

4.2.1 Overview 
S7-REDCONNECT enables a PC station to connect to an S7-400H station, i.e. a high-
availability S7 automation system. This example shows the creation of a corresponding 
STEP 7 configuration. You will need the following components and software: 

● A PC with "SIMATIC NET PC Software" installed and two CP 1623 communication 
processors plugged in 

● An S7-400H automation system with redundant CP 443-1 communication processor and 
redundant CPU 417-5H 

● STEP 7 version 5.5 or higher, usually installed on another PC. You need a license for 
STEP 7. Note that "STEP 7 Professional (TIA Portal)" cannot be used for configuring S7-
REDCONNECT. 

You can find additional information on high-availability S7 connections in the document 
"Industrial Communication with PG/PC - Basics" /1/, which is supplied with the "SIMATIC 
NET PC Software". 

4.2.2 Creation of the STEP 7 project 

PC station 
Proceed as follows to configure the PC station in STEP 7: 

1. In a new STEP 7 project, create a "SIMATIC PC station" from the hardware catalog via 
"PC Systems" > "PC General". 

2. Insert an OPC server in the hardware catalog via "PC systems" > "User applications". 

3. Configure the generation of an XDB file for the PC station via "Properties" > "General" > 
"XDB Configuration". 

4. Insert two CP 1623 communication processors into the PC station from the hardware 
catalog via "PC Systems" > "Communication Modules" > "PROFINET/Ethernet". 

5. Network each of these two communication processors to a newly created subnet. 
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S7 station 
Proceed as follows to configure the S7 station in STEP 7: 

1. Create a "SIMATIC H-Station" with redundant rack in the STEP 7 project, in the hardware 
catalog via "SIMATIC 400". 

2. Insert a redundant CPU 417-5H PN/DP communication processor and a redundant CP 
443-1 communication processor into each of the redundant S7 stations from the 
hardware catalog via "SIMATIC 400". 

The figure shows the device configuration created: 
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Networking 
Proceed as follows to network the stations in STEP 7: 

1. Network the two CPs of the S7 station so that you get a network as shown in the following 
figure and make sure that the stations are wired accordingly: 

 
Figure 4-1 S7400HNetwork_xx 

2. Insert a new connection with the type "S7 connection fault tolerant" into the connection 
table of the OPC server. 

3. The two stations are thus networked and prepared for communication via a configured 
high-availability S7 connection, which can be operated via the OPC server in the same 
way as a standard S7 connection. 

This provides you a fully functional system that you can compile and load into the 
appropriately equipped stations (alternatively load the PC station by importing the generated 
XDB file). 

When the stations are loaded, the namespace of the OPC server contains the configured S7 
connection with access to the data of the S7 station. 

4.2.3 Commissioning and testing 
For initial tests and the commissioning of the example configuration, you can search the 
OPC namespace with the OPC Scout V10 and read or edit data on the S7 station. This 
works in the same way as with configured standard S7 connections. 

You can monitor the connection status with the "S7 Connection Diagnostics" tool. Simulate a 
fault on one of the connection paths to see how the connection diagnostics shows the 
changed connection state. 

The status of the S7 connections and the high-availability S7 connections as well can also 
be monitored via the OPC server (but in this case exclusively via the OPC Scout V10). Read 
the online help of OPC Scout V10 on the topic "Diagnostic view". 
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4.3 OPC application for PROFIBUS DP 

4.3.1 Overview 

Explanation of the configuration example 
This example illustrates how to couple an ET 200S DP slave with a CP 5623 in a PC station 
over PROFIBUS DP. 

In the configuration example presented here, typical communication partners are coupled 
over PROFIBUS and can be reached via the OPC server. 

Example of a PROFIBUS configuration 

 
There is communication between two devices or modules. Communication with an ET 200S 
s described in detail below. 

You will see which tools are used for configuration and project engineering of a PC station 
and a DP slave. You will also see how to use the OPC Scout V10 program for 
communication with the OPC server. 

Requirements 
If you want to try out the example yourself, you require the following: 

● A PC 

● A CP 5623 communication processor 

● "SIMATIC NET PC Software" 

● An ET 200S DP slave. 

● PROFIBUS cabling between communication processor and ET 200S 
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4.3.2 Creation of the STEP 7 project 

PC station 
Proceed as follows to configure the PC station in STEP 7: 

1. In a new STEP 7 project, create a PC station from the hardware catalog via "PC 
Systems" > "PC General" and insert an OPC server from the hardware catalog via "PC 
Systems" > "User Applications". 

2. Configure the creation of an XDB file for the PC station, "Properties" > "XDB 
Configuration". 

3. Insert a CP 5623 communication processor into the PC station from the hardware catalog 
via "PC Systems" > "Communication Modules" > "PROFIBUS". 

ET200S 
Proceed as follows to configure the ET200S in STEP 7: 

1. In the STEP 7 project, additionally create a DP slave ET 200S PROFIBUS from the 
hardware catalog via "Distributed I/O" >"ET 200S" > "Interface modules" > "PROFIBUS". 

2. Switch to the device view by double-clicking on the module. The hardware catalog now 
offers context-sensitive modules that you can insert into the DP slave. 

3. Insert one of the power supplies in slot 1 from the hardware catalog via "PM". 

4. Also insert an I/O module, for example. 

5. Finally, switch back to the network view. 

Networking 
Proceed as follows to network the modules in STEP 7: 

Connect the DP slave to the CP 5623 by drawing a line between the PROFIBUS interfaces 
of these modules with the mouse. The result is as follows: 

● The CP 5623 is now in DP master mode, a corresponding DP master system has been 
created automatically. 

● The relevant devices are networked via PROFIBUS. 

● The DP slave is connected to the DP master system of the CP 5623. 

The figure shows the configuration created: 
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This gives you a fully functional system that you can compile and load into the appropriately 
equipped PC station. 

When the PC station is loaded, the namespace of the OPC server contains the 
corresponding DP items with access to the CP 5623 as DP master and the I/O modules of 
the DP slave. 

4.3.3 Commissioning and testing 
Now use the "OPC Scout V10" included in the "SIMATIC NET PC Software" for testing and 
commissioning the example project configuration. The OPC namespace contains the 
configured CP 5623 as DP master with the DP slave. 
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4.4 Unspecified S7 connection from a PC application 

4.4.1 Overview 

Explanation of the configuration example 
In this section, you will learn how to configure and commission an S7 connection from an 
existing PC application using the "SIMATIC NET PC Software". 

In the configuration example presented here, typical communication partners are coupled 
over Industrial Ethernet and are reached over the OPC server. 

Example of an Industrial Ethernet configuration 

 
There is communication between two devices or modules. The communication with an S7-
400 station via the S7 protocol with unspecified S7 connection is described in detail below. 

Requirements 
To understand this example, you need the following:  

● A PC with "SIMATIC NET PC Software" installed and a CP 1623 communication module 
plugged in. 

● A SIMATIC S7-400 with a CPU-400 in slot 3, the CPU has the IP address 140.101.10.3, 
netmask 255.255.0.0. 
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4.4.2 Creation of the STEP 7 project 

PC station 
Proceed as follows to configure the PC station in STEP 7: 

1. In a new STEP 7 project, create a "PC station" from the hardware catalog via "PC 
Systems" > "PC General". 

2. Insert an OPC server in the hardware catalog via "PC systems" > "User applications". 

3. Insert a CP 1623 communication processor into the PC station from the hardware catalog 
via "PC Systems" > "Communication Modules" > "PROFINET/Ethernet". 

4. Configure the generation of an XDB file for the PC station via "Properties" > "General" > 
"XDB Configuration". 

5. Network the CP 1623 with a newly created subnet. 

 

S7 connection 
Proceed as follows to configure an unspecified S7 connection for the PC station: 

1. In the network view, switch to connection configuration and select "S7 connection" as the 
connection type. 

2. Select the OPC server and create an S7 connection (shortcut menu of the OPC server > 
"Add new connection"). The newly created S7 connection appears in the connection list 
of the network view. 

3. Select this connection and click on "Properties". 
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4. Enter the IP address of the partner station in the general properties. Leave the "TCP/IP" 
protocol activated. 

 
5. Go to the page with the address details and enter the rack and slot of the S7 CPU, rack: 

0, slot in this case: 3. 

 
6. Select any local connection resource, e.g. 10. 

7. Select the connection resource "03" for the partner. This setting is suitable if the 
connection partner is the passive side of the S7 connection. 

This provides you a fully functional system that you can compile and load into the 
appropriately equipped stations (alternatively load the PC station by importing the generated 
XDB file). 

The S7 namespace of the OPC server contains the S7 connection just configured and 
functions as usual for S7 connections. 
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4.4.3 Commissioning and testing 
If the PC station is loaded and the S7-400 can be reached via TCP/IP, you can operate the 
S7 connection with the OPC Scout V10, for example. You connect to the SIMATIC NET 
OPC UA server for this, for example. You will find the S7 connection in the S7 namespace 
and can use it to read or change data of the S7-400. 
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4.5 Unconfigured S7 connection with the SIMATIC NET OPC server 

Overview 
Below, you will find three examples of configurations in which an unconfigured S7 
connection is established: 

● Industrial Ethernet via TCP/IP (Page 123)  
Unconfigured S7 connection with a CP 1623 to a SIMATIC S7-400 with a CPU 414-3 DP. 

● Industrial Ethernet via ISO (Page 126)  
Unconfigured S7 connection with a general communications module for Industrial 
Ethernet to a SIMATIC S7-400 with a CPU 414-3 DP. 

● PROFIBUS (Page 127)  
Unconfigured S7 connection with CP 5624 to a SIMATIC S7-400 with CP 414-3 DP. 

4.5.1 Industrial Ethernet via TCP/IP 
This example shows you how to connect a SIMATIC AS S7-400 to a CPU 414-3 DP with CP 
434-1/CP 434-1 Advanced using an unconfigured S7 connection via Industrial Ethernet (via 
TCP/IP). 

 

Requirements 
To understand this example, you need the following: 

● A PC with "SIMATIC NET PC Software" installed and a CP 1623 communication module 
plugged in. 

● A SIMATIC S7-400 

● Industrial Ethernet cabling between PC module and S7-400 

● The SIMATIC AS used in this example has the station address "140.101.10.3" with 
netmask "255.255.0.0", a remote TSAP of "02.03" and the data element "MB0". 
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4.5.1.1 Engineering of the unconfigured S7 connection - Example 1 
The example shows the use of the OPC server for S7 connections. To do this, the S7 
protocol must first be activated for use with OPC-UA. 

You can find a description of creating unconfigured S7 connections with the OPC server in 
detail in the manual "Industrial Communication with PG/PC volume 2", section "Unconfigured 
S7 connections" /1/ 

Proceed as follows to activate the S7 protocol: 

1. In the "Communication Settings" configuration program, select the page "OPC protocol 
selection" ("SIMATIC NET configuration" > "OPC settings" > "OPC protocol selection"). 

2. On the "OPC protocol selection" page, select "S7". Enable "UA" if you want to use the 
OPC UA server. 

3. Press the "Apply" button. 

4. You are asked whether the OPC servers should be stopped and restarted. Confirm with 
"Yes". The OPC servers are then closed and started later if required. 

The S7 protocol can then be used for the OPC server. 

Since an application access point must be specified for an unconfigured S7 connection, you 
need to configure an access point to the communication module as a preparation. To do this, 
use the "Communication Settings" configuration program. 

Proceed as follows to set the access point: 

1. In the "Communication Settings" configuration program, select the "Access points" page 
and open the pre-configured access point "CP_H1_1:". 

2. Assign the interface configuration "CP1623.RFC1006.1". 

3. Press the "Apply" button. 

Now you have to set a suitable IP address and netmask for the CP 1623. 

Proceed as follows to set the IP address and netmask: 

1. In the "Communication Settings" configuration program, select the page "Modules" > "CP 
1623" > "Address". 

2. In the "IP Addresses" field of the "Industrial Ethernet:" section, enter a suitable IP address 
and netmask, e.g.: 
- IP address: 140.101.1.1 
- Netmask: 255.255.0.0 

3. Press the "Apply" button. 

This completes all required preparations and you can operate an unconfigured S7 
connection with the SIMATIC NET OPC server via the configured access point. 
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4.5.1.2 Generation and operation of an unconfigured S7 connection 
To set up and operate an unconfigured S7 connection to the SIMATIC NET OPC server, an 
OPC item with a specific syntax must be created and activated in the S7 namespace of the 
OPC server. How you can use the OPC Scout V10 is demonstrated here. 

Connecting to a server 
Drag the COM server "OPC.SimaticNET" ("Server Explorer" > "COM Server" > 
"OPC.simaticNET") onto the worksheet, specifically there into the directory "Project …" > 
"Server" > "COM Server". The OPC Scout V10 connects automatically to the OPC DA 
server. 

Creating an OPC item 
Since unconfigured S7 connections are initially not available in the S7 namespace, you must 
create the S7 connection by manually creating a specific OPC item.  

Proceed as follows to create a specific OPC item: 

1. In a DA view, click on the "…"" button in empty line of the "ID" field. A dialog box appears 
with the option of entering an item ID. 

2. In the "Item ID/Name:" field, enter the following ID: 
S7:[ConnNew_1|VFD1|CP_H1_1:|02.00,140.101.10.3,02.03,1]MB0 
The IP address at the end of the item ID is the IP address of the S7. In this case, the 
name of the S7 connection is "ConnNew_1". 

3. You can select the OPC server you have connected in the "Server" drop-down list. Select 
it and click on the "OK" button. 

The OPC item is now entered in the DA view and the newly created S7 connection 
"ConnNew_1" is available in the S7 namespace of the OPC-DA server. Verify this by 
updating the namespace ("Server Explorer" > "Local COM Server" > shortcut menu 
command "Update search"). You can find the new S7 connection under "OPC.SimaticNET" 
> "\S7:". As long as the OPC item is active, the S7 connection can be used like a configured 
S7 connection. It is sufficient to specify the name for an OPC item in the S7 namespace 
(here: "S7:[ConnNew_1]MB0"). 
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4.5.2 Industrial Ethernet via ISO 

Description 
This example shows you how to connect a SIMATIC AS S7-400 with a CPU 414-3 DP with 
CP 443-1/CP 443-1 Advanced using an unconfigured S7 connection via Industrial Ethernet 
(via ISO). 

 

Requirement 
If you want to try out the example yourself, you require the following: 

● A PC with "SIMATIC NET PC Software" installed and an Ethernet communication module 
plugged in. 

● A SIMATIC automation system S7 (e.g. S7 1200, S7 1500, S7 300, S7 400) 

● Industrial Ethernet cabling between the communication module and the SIMATIC AS. 

● SIMATIC AS 400-S7-OPC used in this example has the station address 
"00.1B.1B.47.EF.5A", a remote TSAP of "02.03" and the data element "MB1". 

Procedure 
Proceed in the same way as described in Example 1, with the following changes: 

● Assign the "CP_H1_1:" access point to an ISO interface configuration of the 
communication module used. 

● IP address settings are not required 

● The OPC item ID to be used contains the MAC address of one of the S7-400 CPs (in this 
example "00.1B.1B.47.EF.5A"), the data element is MB1: 
S7:[ConnNew_1|VFD1|CP_H1_1:|02.00,00.1B.1B.47.EF.5A,02.03,1]MB1 
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4.5.3 PROFIBUS 

Description 
This example shows you how to couple an AS S7-400 with a CPU 414-3 DP via CP 443-5 
using an unconfigured S7 connection via PROFIBUS. 

 

Requirement 
If you want to try out the example yourself, you require the following: 

● A PC with "SIMATIC NET PC Software" installed and a CP 5624 communication module 
plugged in. 

● A SIMATIC AS 400-S7-OPC is coupled with a CPU 414-3 DP via a CP 443-5 and CP 
443-5 Advanced. 

● PROFIBUS cabling between the PC module and S7 device. 

● The SIMATIC AS 400-S7-OPC used in this example has station address "4", a remote 
TSAP of "02.03" and the data element "MB1". 

Procedure 
Proceed in the same way as described in Example 1, with the following changes: 

● Assign the access point "CP_L1_1:" to a PROFIBUS interface configuration of the 
communication module used. 

● The OPC item ID to be used contains the PROFIBUS address of one of the S7-400-CPs 
(in this example 4), the data element is MB1: 
S7:[ConnNew_1|VFD1|CP_L2_1:02.00,4,02.03,1]MB1 
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4.6 SNMP communication with OPC 

Introduction 
This section describes how you couple network components and nodes with an SNMP agent 
with a PC station over an SNMP OPC server. You will learn which tools to use to configure a 
PC station to implement the interfacing of a device with SNMP capability and how make the 
SNMP variables and SNMP traps available on the OPC interface. 

You will find information about the SNMP OPC server on the Internet at: 

Link to the SNMP OPC server: (http://www.automation.siemens.com/mcms/industrial-
communication/en/ie/software/network-management/snmp-opc-server/Pages/snmp-opc-
server.aspx)  

Requirements 
If you want to try out the example yourself, you need the following: 

● A PC with "SIMATIC NET PC Software" installed 

● An SNMP-compliant device (for example SIMATIC NET OSM/ESM) 

● A network connection between the OPC SNMP server and the SNMP-compliant device 

SNMP communication with OPC is configured via STEP 7 as of version 5.5. 

http://www.automation.siemens.com/mcms/industrial-communication/en/ie/software/network-management/snmp-opc-server/Pages/snmp-opc-server.aspx
http://www.automation.siemens.com/mcms/industrial-communication/en/ie/software/network-management/snmp-opc-server/Pages/snmp-opc-server.aspx
http://www.automation.siemens.com/mcms/industrial-communication/en/ie/software/network-management/snmp-opc-server/Pages/snmp-opc-server.aspx
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4.6.1 Configuration of the SNMP OPC server 

Follow the steps below: 
1. Start the SIMATIC Manager. 

2. Double-click on the configuration icon. 

Doubleclick on the "OPC Server" box in the section "(0) PC" to configure the OPC server. 

 
Reaction: The "Properties - OPC Server" dialog box opens. 
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3. Select the "SNMP" tab. Change the cycle time if necessary. 

The cycle time is the minimum time in which the variables of the SNMP OPC server are 
polled. For more detailed information on the cycle time, refer to the online help available 
with the "Help" button. 

 
4. Click on "Edit plant configuration...". 

Reaction: A dialog box appears in which all the devices registered with the OPC Server 
are listed. 
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4.6.2 Editing the plant configuration 

Follow the steps below: 
1. In this case, no devices have been registered yet. 

Click the "Add..." button to make a new node known in the plant configuration of the OPC 
server. 

Reaction: The "Add node" dialog box opens. 

2. Enter the required information for your device in the "Add nodes" dialog box: 

– Enter a node name in the "Name" box. 

– Enter the IP address of the device. 

– Select a device profile. The device profile describes the mapping of SNMP variables 
and traps to the OPC interface. You can also create your own profiles from MIB files 
(see below, "Generating a profile"). You open the relevant dialog box when you click 
the "Create Profile ..." button. 

Devices without SNMP capability can also be entered to allow uniformity. For these 
devices, a "PING" is mapped on a signoflife variable. 

– Enter a "SNMP-Community" for the device. This decides whether or not read-only 
access or write access is permitted with the device. 

– As a comment, you can enter a maximum 255 characters long text. 

Note: 

The fields "sysLocation", "sysContact" and "sysName" are disabled for SNMP-enabled 
devices because these parameters are defined during device configuration and can be 
called up in the device. 
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3. Confirm your entries by clicking "OK". 

4. The settings are visible in the window of the plant configuration. 

With "Import node", all devices that have an IP address and are available under the 
current project can be automatically transferred to the list of the plant configuration. If the 
device supports Web based management, this can be started with the "Web based 
Management…" button (make sure your browser settings are suitable). 

5. Click "OK" to close the plant configuration window. 

6. Click "OK" again in the dialog box for the properties of the OPC server to complete 
configuration of the SNMP OPC server. 

7. In the menu, select the command "Station" > "Saver and Compile". 

8. In the menu, select the command "PLC" > "Download to Module". The configuration data 
is downloaded to the OPC server. 

9. The OPC server starts with the new configuration data. 

Confirm the next window with "OK". 
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4.6.3 Commissioning and testing 
Now use the "OPC Scout V10" included in the "SIMATIC NET PC Software" for testing and 
commissioning the example project configuration. Since the OPC server with this 
configuration is an SNMP management application, the OPC namespace contains the plant 
configuration under "SNMP:". The following describes how you can use the OPC server as a 
receiver for SNMP traps with OPC Scout V10 as a OPC client. 

Writing values 
You set the trap recipient of an OSM/ESM by assigning suitable values to two OPC items. 
The procedure described here is also an example of how to write values for OPC items using 
the OPC Scout V10. 

Maximum of ten trap recipients 
To specify the trap recipients, you use the variables snTrapAddress and snTrapState. These 
variables each have ten instances (snTrapAddress1 to snTrapAddress10 and snTrapState1 
to snTrapState10). On the OSM/ESM, you can therefore enter up to ten trap recipients. The 
device sends the trap frames to all registered recipients. 

Writing values for snTrapAddress and snTrapState 
In the navigation area of the OPC Scout V10, the folder icon "SNMP" also contains a 
subfolder with the configured connection name. This folder contains a group with trap 
variables. If you use the profile supplied with the OSM, the name of this group is "Privat-
Common". If you use a newly created profile, the trap variables are in the group specified for 
it.  

Follow the steps below: 

1. Click on the icon of the group with the trap variables to display a list of these variables in 
the information area. Select the variables snTrapAddress1 und snTrapState1 and drag 
these to the view area. The snTrapAddress1 variable contains the IP address of the trap 
receiver, snTrapState1, determines whether the entry is enabled (2) or disabled (3): 

2. Click on the column "New value" to change the value for the snTrapAddress1 item. 

3. Enter the IP address of the trap recipient and click the OK" button. 

 
4. Click the "Write" button in the view area. 

5. Click on the column "New value" to change the value for the snTrapState1 item. 
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6. Enter "2" to activate the trap recipient and click the "OK" button. 

 
7. Click the "Write" button in the view area. 

 
  Note 

You can drag items from the information area to the view area. 
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4.6.4 Creating a device profile with the MIB compiler 

Device profile 
A device profile contains the SNMP objects (OPC items) required for the SNMP interface of 
the OPC server. It maps SNMP variables and SNMP traps on the OPC interface. Device 
profiles are stored in profile files. 

MIB files and MIB compiler 
MIB files (Management Information Base) are descriptions of SNMP variables and SNMP 
traps in a form specified by Internet standards. There are standard MIBs specified for 
devices with the same functionality and device/vendorspecific MIB files. 

You create a device profile with the MIB compiler from an existing MIB file.  

Calling and handling the MIB compiler. 
Follow the steps below: 

1. Start the "SIMATIC Manager". 

2. Double-click on the configuration icon. 



Examples  
4.6 SNMP communication with OPC 

 Commissioning PC Stations - Manual and Quick Start 
136 Configuration Manual, 10/2018, C79000-G8976-C156-19 

3. Double-click on the "OPC Server" field in the section "(0) PC" to configure the OPC 
server. 

 
Result: The "Properties - OPC Server" dialog box opens. 
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4. Select the "SNMP" tab and click on the "Edit Plant Configuration..." button. 

 
Reaction: A dialog box appears in which all the SNMPcompliant devices registered with 
the OPC server are listed.  

5. Select the device for which you want to create a profile and click the "Edit ..." button to 
display the dialog box with the node data of the device. 

Under the "Edit" button, you can modify node data. 

6. Click the "Create Profile ..." button to open the dialog box of the MIB compiler. 
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7. The dialog box of the MIB compiler has three areas: 

– Left area: 
MIB area for displaying the MIB objects from the loaded MIB files. 

– Right area: 
Profile area for adopting and displaying the OPC items / OPC events. 

– Lower area: 
Output window for compiler messages. 

Click the "Load MIB..." button. In the dialog for opening a file, select the required MIB file 
(for example "RFC1213-MIB.mib"). The content of this file is shown in the lefthand area: 

 
8. Select the MIB objects for the profile in the structure tree on the left and drag them to the 

profile area of the dialog box. You can also select a node and drag it to the righthand 
area. In this case, all the SNMP variables belonging to the node are adopted as OPC 
variables. 

9. Structuring of the variables in the profile area is possible in keeping with the OPC 
specification by creating groups. To do this, click the "Create Group" button. 

10.Check whether or not the adopted SNMP variables still include unspecified instances of 
variables. Such elements are indicated by a "!".  
Double-click on such elements to open the "Enter Instances" dialog box. 
(For example, for an 8port switch, the object "ifOperStatus" must be assigned the 
instances 1-8 so that the OPC items "ifOperStatus.1" to "ifOperStatus.8" can be formed). 

11.Save the profile by clicking on the "Save" button. You can select the newly created profile 
in the "Device profile" list box of the "Add nodes" dialog box. 
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4.7 Use CP 5623, CP 5613 A2, CP 5603 and CP 5622 as DP slaves 

General 
 

 Note 

This section describes the communication processors  
• CP 5603 
• CP 5613 A2/CP 5613 A3 
• CP 5623 

are called simply CP 56x3. The following instructions apply the same to all three 
communications processors. 

 

The example shows the configuration of CP 56x3 and CP 5622 as DP slaves, with a CP 
5624 as DP master with STEP 7 Professional (TIA Portal) as of V14 SP1. You do not need a 
license for the example, since only PC stations are configured. 

 

 Note 
• A DP configuration created for a CP 56x3 is not compatible with a CP 5614 A2/A3 or CP 

5624 slave and vice versa. For this reason, the configuration must be adapted and 
reloaded if a CP 5614 is to be physically replaced by a CP 56x3 or vice versa. 

• If you want to connect the CP 56x3 as a DP slave to a DP master of a third-party 
manufacturer, you must use the supplied GSD files, "SLV80b4.GSD" or 
"SLV180b4.GSD". 

• If you want to use the CP 5614 or CP 5624 as DP slave, import the GSD file, 
"siem80b4.gsd" or "siv180b4.gsd" (DPV1). You can find these components in the 
hardware catalog under "Other field devices" > "PROFIBUS DP" > "General" > 
"SIEMENS AG". 

 

Configuration 
1. Create a STEP 7 project with two PC stations from the hardware catalog under "PC 

Systems" > "PC General" and insert an OPC server in each of these PC stations (in the 
hardware catalog under ""PC Systems" > "User Applications"). 

2. Configure the generation of XDB files for both PC stations (tag "Properties" > "General" > 
"SIMATIC PC Station" > "XDB Configuration"). 

3. Insert a CP 5624 in the first PC station (hardware catalog under "PC Systems" > 
"Communication Modules" > "PROFIBUS") and configure it as a DP master (tab 
"Properties" > "General" > "Operating mode"). 

4. Plug a CP 5623 and a CP 5622 into the second PC station from the hardware catalog 
and configure them as DP slaves with assignment to the previously created DP master. 
In order to operate the CP 5623 slave via SIMATIC NET OPC, it must be set to "DPV0 
compatible" DP mode, which is also configurable under "Operating mode". 
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Result: The communication processors were networked automatically via PROFIBUS and 
the DP master system was created. OPC access with the OPC server is also possible. 

 
The DP slaves must now be configured with the desired transfer ranges (tab "Properties" > 
"Operating mode" > "I-slave communication"). You can configure the transfer areas as soon 
as you have selected the type "MS" under "Transfer areas" on the configuration page. Other 
configurations such as "Bidirectional address mapping" are possible if you select one of the 
created transfer areas in the navigation. 

This gives you a fully functional DP system that you can compile and load into the 
correspondingly equipped PC stations, alternatively by importing the XDB files that have now 
been created. 

When the PC stations are loaded, the namespace of the OPC server contains the 
corresponding additional elements and the OPC server can be operated as a DP master 
application or DP slave application. With OPC Scout V10, you can select the corresponding 
OPC items from the namespace and make first attempts with your DP configuration. Some 
OPC item definitions are available by default. 
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4.8 Using the CP 1616 as a PROFINET IO controller / IO device / IO 
router 

 

 Note 

As of STEP 7 V5.3 SP3, the CP 1616 is part of the hardware library.  

If you want to operate the CP 1616 with an earlier version of STEP 7, you can install an HSP 
update.  

You will find information on this in the online help of STEP 7 under the keyword "Hardware 
update".  

 

 Note 
No simultaneous operation 

Parallel operation of a PCI board CP 1616 or a PCI 104 board CP 1604 with a 
communication processor CP 1616 onboard the Microbox 427 B / 427 C is not possible. 

 

Introduction 
The CP 1616 communications processor is a PCI module for connecting PCs or SIMATIC 
PGs/PCs to PROFINET IO.  

Its essential characteristics are: 

● Optimized for PROFINET IO 

● With Ethernet realtime ASIC ERTEC 400 

● 4 x RJ45 ports 

● Integrated 4port realtime switch  
(If used with an external power supply, the integrated realtime switch can also operate 
when the PC is turned off.) 

● Relieves the PC due to event mechanisms  
(automatic detection of data changes) 

● Automatic hardware detection is supported. 

● Extensive diagnostics options 

The chapter describes the configuration of the CP 1616 for the following four use cases: 

● IO controller 

● IO device 

● Use as IO controller and IO device at the same time 

● IO router 
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CP 1616 as IO controller  
A PC communicates over Industrial Ethernet with PROFINET IO devices. 

In the following example, the user program runs on the PC. Data traffic is handled over the 
CP 1616 with several SIMATIC S7 PROFINET IO devices (for example the ET 200S) over 
Industrial Ethernet. 
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CP 1616 as IO device  
In this example, the IO Base device user program runs on a PC with a CP 1616 installed in 
it. The data exchange with the controller is handled over the CP 1616 and Industrial 
Ethernet. 

 



Examples  
4.8 Using the CP 1616 as a PROFINET IO controller / IO device / IO router 

 Commissioning PC Stations - Manual and Quick Start 
144 Configuration Manual, 10/2018, C79000-G8976-C156-19 

4.8.1 Initialize CP 1616 (IP address and device name) 
When a CP 1616 communications processor ships, only the MAC addresses are set up. If 
you require an IP address and a PROFINET IO name for your application, you will have to to 
set these manually. This is known as "node initialization of the CP 1616". 

Assigning the IP address 
Follow the steps below:   

1. Open the SIMATIC Manager. 

2. Select the menu command "PLC" > "Edit Ethernet Node". 

Reaction: The "Edit Ethernet Node" menu opens. 

3. Click on "Browse" under "Nodes accessible online" and select the CP 1616 named "S7-
PC". 

4. In the "Set IP configuration" area, set the IP address of the CP 1616 and the subnet mask 
and click "Assign IP Configuration". 

The IP address entered here must match the configured address. 

5. In the "Assign device name" area, enter the device name of the CP 1616 and click 
"Assign Name". 

The device name entered here must match the configured device name because when 
the CP 1616 is configured as a device, only the device name is relevant (not the IP 
address). 

 

 Note 

If the CP 1616 was configured previously as a controller, you must first run a complete 
memory reset before the device name can be changed.  

Following every complete memory reset, the CP must be restarted (from STEP 7) otherwise 
device mode is not possible! 

 

 
 

 Note 

When loading the firmware or commissioning the module, please remember that the CP 
1616 has two MAC addresses (always consecutive). 
The first address printed on the module is used for layer 2 communication, the second for 
the PROFINET protocol (the first address plus one). 

Example: 
The address "08.00.06.93.DA.76" printed on the communications processor is the address 
for layer 2 communication. This means that "08.00.06.93.DA.77" is the MAC address for 
Ethernet/PROFINET communication. 
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4.8.2 Configuring the CP 1616 

4.8.2.1 Using the CP 1616 as a PROFINET IO controller 
 

 Note 
Remember the version! 

In the procedure described below, for example, the CP 1616 Version 1.0 (V1.0) is used. The 
configuration procedure is illustrated here using STEP 7 (not TIA Portal) as an example. 

 

Follow the steps below: 
1. Create a new project in the SIMATIC Manager with the "File" > "New" menu command. 

2. Using the "Insert" > "Station" > "SIMATIC PC Station" menu command, insert a PC 
station in the project. 

3. In HW Config, open the configuration of the PC station in which you want to install the CP 
1616. 

4. In the hardware catalog ("SIMATIC PC Station" > "CP Industrial Ethernet") select the 
CP 1616 (V1.0) and position it in slot 1 (index 1) of the PC station. 

Confirm with "OK". 

5. Select the CP 1616 and then select "Edit" > "Object Properties", to set parameters for the 
CP 1616. 

6. In the "General" tab, click the "Properties…" button. 

7. In the "Parameters" tab, you can select the IP address, subnet mask, subnet and 
gateway. 

Then confirm your entries with "OK". 

Reaction: You return to the properties dialog of the CP 1616. 

8. In the "PROFINET" tab, you set the mode of the CP 1616. 

Select only the option "PROFINET IO Controller" for the configuration described above. 
Assign a device name. 

Then confirm your entries with "OK". 
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9. Select the CP 1616 and, if necessary, select the "Insert" > "PROFINET IO System" menu 
command. 

Reaction: Following your confirmation, the PROFINET IO system is inserted 
automatically. 

10.Now configure the IO devices in the PROFINET IO system to meet your requirements. 

 
When engineering is completed, (for example, CP 1616 as PROFINET IO controller and ET 
200S as PROFINET IO device), the project can be compiled and downloaded (to the PC) 
with "PLC" > "Download to Module". 
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4.8.2.2 Using the CP 1616 as a PROFINET IO device 
To use the CP 1616 as PROFINET IO device, select (or create) a project containing a 
PROFINET IO controller, a PROFINET IO system and possibly also IO devices (for example 
ET 200S). 

 

 Note 
Remember the version! 

In the procedure described below, for example, the CP 1616 Version 1.0 ("V1.0") is used. 
 

Follow the steps below: 
1. Open the project in the SIMATIC Manager. 

2. Open the configuration (HW Config) of the station containing the PROFINET IO 
controller. 

3. In the hardware catalog ("PROFINET IO" > "I/O" > "SIMATIC PC CP") select the CP 1616 
(V1.0) and position it in the network (PROFINET IO system). 

Reaction: This configures the CP 1616 (V1.0) as an IO device in the network. 

4. Select the CP 1616 and then select "Edit" > "Object Properties". 

5. Enter the device name in the "Device name" input box. 

6. If the "Assign IP address via IO Controller" option is selected, deselect it.. 

Result: The CP 1616 is configured in the PC station. This means that the IP address can be 
assigned during compilation based on the device name. 

 

 Note 

If the CP 1616 was configured previously as an IO controller, you must first run a complete 
memory reset before the device name can be changed.  

Following every complete memory reset, the CP must be restarted (from STEP 7) otherwise 
IO device mode is not possible! 
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4.8.2.3 Using the CP 1616 as PROFINET IO controller and IO device 
You can also use the CP 1616 as an IO controller and IO device at the same time. This 
means that the same CP 1616 has the function of an IO controller and an IO device. 

The following figure shows such a sample configuration with CP 1616 as IO controller and IO 
device. 

 
The CP 1616 in the PC station is an IO controller; the two ET 200S are IO devices. The 
same CP 1616 is in the PC station "SOFTNET" IO device of a CP 1612 IO controller. 

 

 Note 
Remember the version! 

In the procedure described below, for example, the CP 1616 Version 1.0 ("V1.0") is used. 
 

Follow the steps below: 
1. The CP 1616 is configured as IO controller in the PC station "KH1F150D" as described in 

the section "Using the CP 1616 as a PROFINET IO controller (Page 145)" (step 1 to 10). 

2. Select the CP 1616 and then select "Edit" > "Object Properties". 

3. In the "PROFINET" tab, you can set the mode of the CP 1616. 

4. Here, also select the "Enable PROFINET IO device operation" option. 

5. Then confirm your entries with "OK". 

6. Create a "SOFTNET " SIMATIC PC station. Insert a CP 1612 and an OPC server in it. 

7. Select the CP 1612 and then select "Edit" > "Object Properties". 



 Examples 
 4.8 Using the CP 1616 as a PROFINET IO controller / IO device / IO router 

Commissioning PC Stations - Manual and Quick Start 
Configuration Manual, 10/2018, C79000-G8976-C156-19 149 

8. In the "PROFINET" tab, you can set the mode of the CP 1612. 

9. Select the "PROFINET IO Controller" mode. The inserted OPC server is automatically 
assigned to the CP 1612 as a user application. 

10. Then confirm your entries with "OK". This inserts a PROFINET IO system. 

11.With "PROFINET IO" > "I/O" > "SIMATIC PC CP" in the hardware catalog, select the CP 
1616 (V1.0) and position it in the network (PROFINET IO system). 

Result: This configures the CP 1616 as an IO device in the network. 
 

  Note 
Readme file 

You will find information on the combinations of controller and device one module in the 
readme file of the DK-16xx product. 

 

 
12.Select the CP 1616 and then select "Edit" > "Object Properties". 

13.Enter the device name in the "Device name" input box. 
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14.Disable the "Assign IP address via IO Controller" option. 

Based on the device name, the IP address of the CP 1616 is then assigned at the PC 
station during compiling.  

15. Confirm completion of the assignment in the dialog box with "OK". 

16.Open the PC station. 

Reaction: The device configuration of the PC station appears in "HW Config". 

17.Couple the device in the "IO Device Coupling" dialog. 

18. Open "Index 1" with the "Object Properties" menu command. 

Reaction: The "Properties" dialog box opens. 

19. Click the "IO Device Coupling" button in the "PROFINET" tab. 

Reaction: The "IO Device Coupling" dialog box opens. 

20. Click the "Couple" button. 

Reaction: The entry in the "Active Coupling" group box changes.  

21. Confirm twice with "OK". 

22.Once the configuration is completed, the project can be compiled and downloaded to the 
two stations, for example with HW Config ("PLC" > "Download to Module"). 
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4.8.2.4 Using the CP 1616 as a PROFINET IO router 

Requirements 
The following description assumes that you are familiar with the basic functions of the IO 
router as described in the operating instructions "CP 1616/CP 1604".    

Description of the configuration example 
Configuration is described below based on two examples. 

The automation system "SIMATIC 400" station and the PC station "Router" are involved: 

● "SIMATIC 400" station 

The "SIMATIC 400" station contains a CP 443-1 as PROFINET IO controller.  

The PROFINET IO system configured for this CP is called IO system for the control level 
in the following description. 

● PC station "router" 

The "router" PC station contains a CP 1616 communications processor as IO controller.  

The PROFINET IO system configured for this CP is called IO system for the robot level in 
the following description. 

The main feature of the configuration of an IO router is that the CP 1616 communications 
processor is used both as an IO device in the IO system for the control level and at the same 
time as an IO controller in the IO system for the robot level. 
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Outline of the procedure 
The following description outlines the procedure for using the CP 1616 as an IO router:  

1. Configure the CP 1616 in 2 IO systems: 

– In the IO system for the control level as an IO device. 

– In the IO system for the robot level as IO controller. 

How to do this is described in this manual in the section "Using the CP 1616 as 
PROFINET IO controller and IO device (Page 148)". 

2. Configure the IO router: 

– If you want to read input modules, move on to example 1 below. 

– If you want to write outputs bit-by-bit, move on to example 2 below. 

Example 1: Read input module 
Example 1 describes the configuration of the IO router ("router"). In the example, the IO 
router is configured so that the IO controller of the management level ("SIMATIC 400") can 
read a module of the IO device "DeviceX1" in the IO system for the robot level. 

 

 Note 

Whenever possible, you should configure bit-oriented writing sparingly. It makes the 
configuration complicated and increases the likelihood of application errors. 

 

The data path from the IO device "DeviceX1" through the IO router to the "SIMATIC 400" 
automation system is indicated at the bottom of the schematic by a red arrow (the red arrow 
simply illustrates the text in this document and is not visible in the original STEP 7 view). 

 



 Examples 
 4.8 Using the CP 1616 as a PROFINET IO controller / IO device / IO router 

Commissioning PC Stations - Manual and Quick Start 
Configuration Manual, 10/2018, C79000-G8976-C156-19 153 

Follow the steps below: 

1. Open "HW Config" (for example by double-clicking on the "router" IO device) and the 
"catalog" (click on the "Catalog" icon in the toolbar at the top). 

2. Click on the "(1) Router" IO device. 

3. Select the 1 byte DI transfer module and place it on the first slot of the IO device "(1) 
Router". 

Catalog "PROFINET IO" > "I/O" > "SIMATIC PC-CP" > "CP 1616" > "Migration" > "V2.1" 
> "Transfer module" > "DI" > "1 Byte". 

Reaction: The transfer module is given the "I-address" (input address) "0". 

 
 

  Note 

The IO modules in the "Migration" folder are intended for use with PROFINET Version 
V1.0 IO controllers. You will find the possible combinations in the readme file. 
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4. Interconnect the transfer module with the real IO module in the IO system for the robot 
level: 

Open the "Properties" dialog of the 1-byte module, for example by double clicking on the 
row of slot 1. 

Reaction: The "Properties - 1 byte - (R-/S1)" dialog appears. 

5. Open folder "0.0-0.7" of the transfer module in the "PROFINET IO Transfer Module" tab. 
The folder name corresponds to the I/O address being used. 
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6. Open the drop-down list box in the "Device name" column in byte 0 and select the 
"DeviceX2" IO device. 
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7. Open the "Module (slot)" drop-down list box in byte 0 and select the "4DI DC24V HF" 
module in slot 2. 

 
You can see that bits 0 to 3 of the transfer module were assigned to the four bits of this 
module. 

8. In the "Transfer update time [ms]" drop-down list box in the lower part of the dialog, set 
the interval at which the data of this module is transferred to the IO controller of the 
management level. The default is 72 ms which means that a change at an input of the 
"4DI DC24V HF" module is detected in the IO controller of the management level at the 
latest after 72 ms. 

Select a value less than 72 ms if you want the IO system for the control level to access 
the IO system for the robot level faster. 

 
  Note 

Note that the time must not be shorter than the following times: 
• Update times of the PROFINET IO systems in the IO system for the control level and 

IO system for the robot level. 
• A CP 1616-specific transfer time of 8 ms. 
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9. Confirm the configuration of the IO router with "OK". 

When you have completed the configuration, the project must be compiled and downloaded 
(to the CP 1616 with "Download to Module - Target System"). 

 

 Note 

Remember that the configuration must also be downloaded to the automation system 
"SIMATIC 400" (IO controller of the IO system for the control level). 

 

The input data of the "4DI DC24V HF" module in the "DeviceX2" IO device of the IO system 
for the robot level can now be read by the IO controller of the management level at address 
0. 

Example 2: Writing outputs bit-oriented 
Example 2 describes the configuration of the IO router ("router"). In this example, the IO 
router is configured so that bit 0 of an output module is written by the IO controller of the 
management level, the remaining bits by the IO controller of the robot level. 

 

 Note 

Whenever possible, you should configure bit-oriented writing sparingly. It makes the 
configuration complicated and application errors are more likely to occur. 

 

Follow the steps below: 

1. Open HW Config (for example by double-clicking on the "router" IO device) and the 
"catalog" (for example by clicking on the "Catalog" icon in the toolbar at the top). 

2. Click on the "(1) Router" IO device. 
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3. Select the 1 byte DI transfer module and place it on the first slot of the IO device "(1) 
Router". 

Catalog "PROFINET IO" > "I/O" > "SIMATIC PC-CP" > "CP 1616" > "Migration" > "V2.1" 
> "Transfer module" > "DI" > "1 Byte". 

Reaction: The transfer module is given the "O address" (output address) 100. 

 
 

  Note 

The IO modules in the "Migration" folder are intended for use with PROFINET Version 
V1.0 IO controllers. You will find the possible combinations in the readme file for 
PROFINET IO. 

 



 Examples 
 4.8 Using the CP 1616 as a PROFINET IO controller / IO device / IO router 

Commissioning PC Stations - Manual and Quick Start 
Configuration Manual, 10/2018, C79000-G8976-C156-19 159 

4. Interconnect the transfer module with the real IO module in the IO system for the robot 
level: 

Open the "Properties" dialog of the 1-byte module, for example by double clicking on the 
row of slot 1. 

Reaction: The "Properties - 1 byte - (R-/S1)" dialog appears. 

5. Open the "0.0-0.7" folder of the transfer module in the "PROFINET IO Transfer Module" 
tab and select "DeviceX1" in the drop-down list box of the "Device name" column in byte 
0. 

You will see that all four bits of the "4DO DC24V/0.5A ST (3)" module have automatically 
been assigned to the transfer module. 
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6. To control only the first bit of the module from the IO controller of the management level, 
enter the address 100.0 in the "End" box of the "Byte 0" row. 

 
You will see that only bit 0 of the "4DO DC24V/0.5A ST (3)" module has been assigned to 
the transfer module. As a result, bits 1 to 3 of the module are controlled by the IO 
controller of the process level. 

7. In the "Transfer update time [ms]" drop-down list box below the large table, set the 
interval at which the data of this module is transferred to the IO controller of the 
management level. The default is 72 ms which means that a change at an input of the 
"4DI DC24V HF" module is detected in the IO controller of the management level at the 
latest after 72 ms. 

Select a value less than 72 ms if you want the IO system for the control level to access 
the IO system for the robot level faster. 

 
  Note 

Note that the time must not be shorter than the sum of the following times: 
• Update time of the PROFINET IO systems in the IO system for the management level; 
• Update time of the PROFINET IO system for the robot level; 
• A CP 1616-specific transfer time of 8 ms. 

 

8. Confirm the configuration of the IO router with "OK". 
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When you have completed the configuration, the project must be compiled and downloaded 
(to the CP with "PLC - Download to Module"). 

 

 Note 

Remember that the configuration must also be downloaded to the automation system 
"SIMATIC 400" (IO controller of the IO system for the control level). 

 

The first bit of the "4DO DC24V/0.5A ST (3)" module in the "DeviceX2" IO device of the IO 
system for the robot level can now be written by the IO controller of the management level at 
address 100. 

 

 Note 
• Although the IO controller of the process level writes in bytes, its bit 0 is irrelevant for the 

output status of the "4DO DC24V/0.5A ST (3)" module because it is assigned to the IO 
controller of the management level. 

• Although the IO controller of the management level writes byte-oriented, bits 1 to 7 are 
irrelevant for the output status of the "4DO DC24V/0.5A ST (3)" module. They can be 
written by the IO controller of the process level. 
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4.8.2.5 Copying a PROFINET IO router 

Purpose 
If you are already using a router, you can copy this along with its entire functionality. 

Requirement 
The following description is based on the example described in the previous section "Using 
the CP 1616 as a PROFINET IO router (Page 151)". 

 

Procedure 
Copying a PROFINET IO router involves 3 steps: 

1. Copying the PC station (in this example: "Router"). 

2. Copying the IO device (in this example: "Router"). 

3. Coupling the new PC station with the new IO device. 
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Stage 1 - Copying the PC station "Router" 
Before you can copy, there must be a PC station that is already operating as an IO router. 
When you copy this, all connected IO devices of this "IO system for the robot level" are also 
copied. 

Follow the steps below: 

1. Open the project in the "SIMATIC Manager". 

2. Copy the PC station "Router" ("Copy" shortcut menu command). 

3. paste the copied PC station into the project: 

With the right mouse button, select the project in the directory tree and select the "Paste" 
menu command.  

Reaction: The PC station "Router(1)" appears. 

4. If necessary, rename the new PC station ("Rename" shortcut menu command). 

5. Assign a different IP address to the copied PC station ("Router(1)"): 

– Right-click on "Router(1)". 

Reaction: The shortcut menu opens. 

– Click the "Open Object" menu item. 

Reaction: The new PC station appears in "HW Config". 

– Open "Index X1" by clicking on the "Object properties" entry in the shortcut menu. 

Reaction: The "Properties" dialog box opens. 

– In the "General" tab, click the "Properties" button. 

Reaction: The "Properties" dialog box opens. 

– Enter a different IP address in the "IP address" box. 

6. Connect the new PC station with the existing subnet: 

– Select the subnet in the "Subnet" box and confirm with "OK". 

Reaction: The following warning appears: "Address conflicts were found. Do you want 
the IP addresses of the IO Devices to become unique again?". 

– Confirm with "Yes". 

Reaction: The configuration system now selects new free IP addresses for the IO 
devices. You can change these later if necessary. 

– Confirm with "OK". 

7. Change the device names of the IO devices one after the other: 

With the right mouse button, select "O-device" in "HW Config" > menu command "Object 
properties" > "Device name" box. 
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Stage 2 - Copying IO device "Router" of the SIMATIC S7-400 
Once you have copied the PC station along with the connected IO devices, it is then the turn 
of the IO device of the SIMATIC-S7-400. 

Follow the steps below: 

1. Open the SIMATIC 400 station "SIMATIC 400" in the "SIMATIC Manager": 

– Right-click on "SIMATIC 400". 

Reaction: The shortcut menu opens. 

– Click the "Open Object" menu item. 

Reaction: "HW Config" appears with the message: "The data is read-only.". 

– Confirm with "OK". 

2. Copy the IO device "Router" ("Copy" shortcut menu command). 

3. Paste the copied IO device in the existing PROFINET IO system: 

– Select the "PROFINET IO system" with the right mouse button and click the "Paste" 
shortcut menu entry. 

Reaction: The following warning appears: "You want to edit the configuration of an 
additional station.". 

– Confirm with "OK". 

Reaction: The IO device "Router-1" is added to the PROFINET IO system. 

4. If necessary, change the device name of the copied IO device. 

Stage 3 - Coupling PC station "Router(1)" with IO device "Router-1" 
In the last step, the transfer relations between the PC station, in this example, "Router(1)" of 
the "IO system for the robot level" and the IO device, in this example, "Router-1" of the "IO 
system for the management level" are adopted. 
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Follow the steps below: 

1. Open the PC station "Router(1)" in the "SIMATIC Manager": 

– Right-click on "Router(1)". 

Reaction: The shortcut menu opens. 

– Click "Open Object" in the shortcut menu. 

Reaction: A new PC station appears in "HW Config". 

 
2. Couple the device in the "IO Device Coupling" dialog 

– Open "Index 1" by clicking on the "Object properties" entry in the shortcut menu. 

Reaction: The following warning appears: "You want to edit the configuration of an 
additional station.". 

– Confirm with "OK". 

Reaction: The "Properties" dialog box opens. 

– Click the "IO Device Coupling" button in the "PROFINET" tab. 

Reaction: The "Device Coupling" dialog box opens. 

– Click the "Couple" button. 

Reaction: The entry in the "Active Coupling" group box changes. 

– Confirm twice with "OK". 

Reaction: The following message appears: "You have now connected the device with 
another device using a PROFINET device name and now you can modify.......". 

– Confirm with "No" (!). 

3. Save and compile the project. 
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4.8.2.6 Configuring prioritized startup of the CP 1616 in PROFINET IO 

Functions 
● Prioritized startup is used in fast processes when IO devices change quickly, for example 

changing the tools of a robot. A CP 1616 communications processor supports prioritized 
startup of SIMATIC S7 IO devices in RT or IRT communication. Depending on the device, 
this allows a time < 0.5 s to be achieved following completion of a restart to the beginning 
of user data exchange. 

 
  Note 

To achieve short communiction times, the Ethernet connections must have fixed settings 
so that no time is lost in "negotiation" when establishing the connection. 

To achieve a stable Ethernet connection, both ports of an Ethernet connection must be 
set to "100 Mbps full duplex" and autonegotiation disabled (click on the port -> "Object 
Properties" -> "Options").  

 

● As a PROFINET IO controller, the CP 1616 can establish communication with prioritized 
startup with a maximum of 5 IO devices. 

Configuration 
Prioritized startup planning in STEP 7 is only required and possible for SIMATIC S7-IO 
devices. Follow the steps below: 

1. Open the hardware configuration (HW Config) of the PROFINET IO system. 

2. Select the relevant IO device in the PROFINET IO system. 

3. Open the object properties of slot "X1". 

4. In the "General" tab, select the "Prioritized Startup" option. 

For more detailed information on configuration, and, in particular, on the cabling rules, refer 
to the STEP 7 online help for the "General" tab described above. 

After reconfiguring an IO device for prioritized startup, the first startup takes place in the 
normal time without being prioritized. All subsequent startups will then be completed in the 
reduced time of < 0.5 s. 

 

 Note 

Including an IO device with prioritized startup in a ring with media redundancy serves no 
practical purpose since the ring is interrupted at each IO device change. 
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4.8.2.7 Configuring media redundancy of the CP 1616 

Functions 
You can use the CP 1616 communications processor in a media redundancy ring topology. 
As PROFINET IO controller, the CP 1616 itself can be the redundancy manager. 

If you use IRT communication, media redundancy is not supported. 

Configuration 
Configuration is performed in STEP 7 in the "Media redundancy" tab of the CP 1616 
("HW Config" > Select "CP 1616" IO Controller > Open "Index X1" in the "Object properties" 
shortcut menu > "Media redundancy" tab). Then configure the required properties: 

● Domain - Name of the IRT domain 

● Role 

– Not node in the ring - media redundancy is disabled. 

– Manager - the CP 1616 as a PROFINET IO controller is redundancy manager. 

– Client - the CP 1616 as a PROFINET IO device is redundancy client. 

For more detailed information on configuration, refer to the online help of the "Media 
Redundancy" tab. 

If a CP 1616 is used as an IO device in the media redundant ring topology, the media 
redundancy is handled in the same way. 
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4.8.3 Example: Installing Linux drivers (Suse Linux) 
The CD "DK 16xx PN IO" contains the drivers for a Linux PC.   

Follow the steps below: 

1. Copy the driver file "host-xxx.tar.gz" (xxx = versionspecific) from the CD to any directory 
of your choice. 

2. Extract the file and change to the current directory. 

3. Run the "make" command in the "/host-xxx/" path. 

4. Log on as the root user with the "su" command. 

5. Install the driver with the "make install" command. 

6. Start the driver with the "make load" command in the path of the driver. 

 

 Note 

The driver is stopped again with the "make unload" command. 
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4.8.4 Installing the PROFINET IO sample program (Suse Linux) 
The "pniotest" sample program is restricted to the use of the CP 1616 as controller.   

Follow the steps below: 

1. Run the "make test" command in the "/host-xxx/" (xxx = versionspecific) directory. 

2. Run the "./pniotest" command in the "/host-xxx/testapps/" directory to start the program. 

3. Set the number of modules in "pniotest.c in the /host-xxx/testapps/". 

 
Setting  
const PNIO_UINT32 g_deviceInputCount=3; 
volatile PNIO_IOXS g_deviceInputState[g_deviceInputCount]= 
{PNIO_S_BAD,PNIO_S_BAD,PNIO_S_BAD}; 
PNIO_UINT32 g_deviceInputLength[g_deviceInputCount] ={ 1, 1, 1}; 
PNIO_ADDR g_deviceInputAddress[g_deviceInputCount]= 
{ 
 { PNIO_ADDR_LOG, PNIO_IO_IN, 0}, 
 { PNIO_ADDR_LOG, PNIO_IO_IN, 1}, 
 { PNIO_ADDR_LOG, PNIO_IO_IN, 2} 
}; 

▶ Number of input modules 
▶ One PNIO_S_BAD per  
 input module 
▶ One "1" per input module 
  
  
▶ Address 1st input module 
▶ Address 2nd input module 
▶ Address 3rd input module 

 

 
These settings must also be made for the output modules. 
const PNIO_UINT32 g_deviceOutputCount=3; 
volatile PNIO_IOXS g_deviceOutputState[g_deviceOutputCount]= 
{PNIO_S_BAD,PNIO_S_BAD,PNIO_S_BAD}; 
PNIO_UINT32 g_deviceOutputLength[g_deviceOutputCount] ={ 1, 1, 1}; 
PNIO_ADDR g_deviceOutputAddress[g_deviceOutputCount]= 
{ 
 { PNIO_ADDR_LOG, PNIO_IO_IN, 0}, 
 { PNIO_ADDR_LOG, PNIO_IO_IN, 1}, 
 { PNIO_ADDR_LOG, PNIO_IO_IN, 2} 
}; 

▶ Number of output modules 
▶ One PNIO_S_BAD per  
 output module 
▶ One "1" per input  
 module 
 
▶ Address 1st output module 
▶ Address 2nd output module 
▶ Address 3rd output module 
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 Tools 5 
5.1 "Station Configuration Editor" 

With the "Station Configuration Editor", you can access the component management of the 
Station Manager in the PC station. You require the "Station Configuration Editor" for the 
initial configuration (as an alternative to remote configuration) and for project engineering 
and maintenance of a PC station. 

5.1.1 Characteristics, functions and activation 
The "Station Configuration Editor" is the user interface of the Station Manager. 

The components are the modules and the applications involved in communications in the PC 
station. These components require configuration and project engineering data that is 
managed by the Station Manager in component management (database). 

Apart from component configuration, the "Station Configuration Editor" can also be used for 
diagnostics purposes. 

Area of application / use cases 
● Initial configuration (commissioning) 

When a module is put into operation for the first time, an initial configuration is necessary. 
This initial configuration is done for all newly installed modules. The initial configuration 
sets the index (the "virtual slot number") of the module. 

After initial configuration of the modules, the PC station is prepared to receive the project 
engineering data. This step can be compared with inserting the component in the rack of 
an S7 station. 

● Project engineering and maintenance 

Changes in the project engineering and in the configuration data can be downloaded from 
the project engineering tool to the PC station (local and remote). As an alternative, it is 
possible to transfer data using an XDB file (if the station is not networked). 

Using the "Station Configuration Editor", you can check the effects in the "Components" 
tab. The "Diagnostics" tab provides you with information on the operating state at any 
time. 

By adding the module to the PC configuration in the "Station Configuration Editor", the 
module is automatically switched to the "configured mode"; the modules are set to the "PG 
mode" by default. 

The "Station Configuration Editor" is always available and started on the PC station on which 
you have installed the "SIMATIC NET PC Software". You can access it from the info bar of 
the Windows desktop. 
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5.1.2 Managing components: "Components" tab 
In the "Components" tab, you will find the essential functions for PC configuration and project 
engineering: 

● Assigning the station name 

● Creating new components 

● Adopting a component configuration and project engineering data (online or offline mode) 

● Setting the mode - online or offline 

● Checks and diagnostics 
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 Note 

You will find more information on the meaning of the display boxes and the buttons in the 
integrated help system. 

 

Assigning the station name 
You can assign a name for the PC station by clicking the "Station Name..." button.  

In order to be able to identify a locally loaded configuration, the name here must match the 
name that you have assigned for the PC station in the communication configuration with 
STEP 7. 

Creating new components 
You can select the components installed on your PC station (applications, OPC Server, 
modules such as controllers) by clicking the "Add..." button. The modules are detected 
automatically. 

 

 Note 

The components in the configuration list you can edit here must be entered in exactly the 
same order as in the component image you created in STEP 7 with HW Config. If the 
configuration differs from the list, the configuration data that you download from STEP 7 to 
the PC station will not be adopted correctly. 

 

The status display constantly informs you whether the component you have created matches 
the current hardware configuration and whether it matches any project engineering data that 
has already been downloaded. 

 

 Note 

Remember that you have the option of a partial download if you have set the properties of 
the "Station Configuration Editor" accordingly. 

For more detailed information, refer to the next section "Setting the "Station Configuration 
Editor": "Properties" dialog (Page 177)". 
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Adopting the component configuration and project engineering data 
For productive operation, you require not only the component configuration but also the 
project engineering data for the communication connections and possibly also for the 
symbols of variables. 

You have the following options: 

● Downloading using the project engineering tool 

In online mode, you can load configuration data directly into the PC station using STEP 7. 
You can download both locally or over the network.  

● Station import 

If the station is not networked, you can load the component configuration and project 
engineering data by importing the XDB file on the PC station (for details on creating an 
XDB file, refer to the section "Downloading the project engineering data to the PC station 
(after the initial configuration) (Page 191)"). 

The XDB file can be imported using the "Import Station" button in the "Station 
Configuration Editor". 

Importing the XDB file is possible only when compatible modules are installed in the 
computer and the actual current module configuration exactly matches the information in 
the XDB file. 

You can import an XDB file at any time regardless of the current mode (online or offline). 
You can also specify (option) whether you want the "offline mode" to be set following the 
import. 
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Setting the online or offline mode 
The current mode is displayed in the in the title bar of the "Station Configuration Editor". 

● Offline mode 

In offline mode, you can make changes to the configuration only by entering them directly 
or by importing the station (XDB file). 

In offline mode, you can click the active "Change mode" button to change to online mode.  

● Online mode 

In online mode, you can load configuration data directly into the PC station using STEP 7. 
You can download both locally or over the network.  

In online mode, you can also import an XDB file at any time. You can also specify (option) 
whether you want the "offline mode" to be set following the import. 

Checks and diagnostics 
● Note on diagnostics entries 

The entry in the "Status" field in the configuration list constantly informs you whether or 
not the created component matches the actual hardware configuration and whether there 
is a match to an existing loaded project engineering database.  

If this is the case, you will be prompted to select new diagnostics entries in the 
"Diagnostics" tab. 

● Checking the accessibility of the module - "ring" function 

Once you have completed the configuration, you can check whether or not modules are 
accessible using the "Ring" button. If the module supports this function, you will see an 
indicator respond on the module. 

With the help of the Ring function, you can distinguish between several modules of the 
same type installed on the computer. 

Disable/enable station 
As an administrator, you have the option of protecting the station configuration against 
changes ("Disable Station" button). In the disabled state, the configuration cannot be 
changed; XDB import, remote configuration and loading of the station as well as changes to 
the station in the "Station Configuration Editor" itself are disabled. The disable can be 
released again by pressing the "Enable Station" button. The current status is displayed in the 
"Operating mode" field: 

● RUN: The PC station is locked against changes. 

● RUN_P: The PC station is unlocked for changes. 
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5.1.3 Evaluating messages: "Diagnostics" tab 

How it works 
The "Station Configuration Editor" manages a diagnostic buffer in which the PC station 
components (hardware and software) enter event information.  

You can use this list to analyze configuration or communication problems. 
 

 Note 

You will find more information on the meaning of the display boxes and the buttons in the 
integrated help system. 

 

 Note 

The diagnostic buffer entries that you can read from the "Diagnostics" tab in the "Station 
Configuration Editor" can also be read remotely via STEP 7 Diagnostics. 
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5.1.4 Setting the "Station Configuration Editor": "Properties" dialog 
You reach this dialog by right-clicking on the "Station Configuration Editor" icon in the 
Windows info bar. Select the properties in the shortcut menu and you can then make the 
following settings in the "Station Configuration Editor": 

Configuring activation of warnings 
The warning activation leads to a warning display (exclamation mark) above the station 
manager icon in the info bar as soon as a new event is in the diagnostic buffer. Whether a 
warning is indicated depends on the set warning level. 

You can configure the warning display here. The following settings depending on the error 
weighting are possible:  

● Only when important errors occur 

● If an error occurs 

● Power on 

● Off 

Default setting: Only when important errors occur. 

Accept partial loading  
If the "accept partial loading" property is activated, the Station Manager also accepts project 
engineering that contains only part of the configuration visible in the "Station Configuration 
Editor". 

The components (modules and applications) that do not receive an engineered configuration 
are fully deleted if you download only part of the configuration (engineered configuration is 
lost). However, they are retained in the configuration of the Station Manager (with 
corresponding status display: The component exists in the current actual configuration of the 
PC station but it was not created in the project engineering). 

Default setting: Accept partial loading. 
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5.2 "STEP 7 Professional (TIA Portal)" 
In the TIA Portal, there is an alternative configuration tool which will replace the previous 
STEP 7 Professional V5.5 configuration tool. The alternative configuration tool is called 
STEP 7 Professional (TIA Portal). It brings together the functions found in STEP 7 
Professional V5.5 and WinCC. This means that a STEP 7 configuration no longer needs to 
be transferred to WinCC via the Mapper. 

STEP 7 Professional (TIA Portal) is the main tool with which you can configure the 
communication services for your PC station. You download or export the configuration data 
created with this tool to the PC station. The PC station is then prepared for communication. 

 

 Note 

You have the choice of carrying out STEP 7 configuration with STEP 7 as of V5.5 or with 
STEP 7 Professional (TIA Portal) as of V11. 

 

 Note 

If you want to use symbols with optimized data blocks (S7-1200 and S7-1500), you must use 
at least OPC Server V12 and STEP 7 Professional (TIA Portal) V12.01. 

 

5.2.1 Characteristics, functions and activation 

Functions 
To create the configuration and project engineering data of a PC station, use the following 
functions: 

● Create and configure components of the PC station. 

● Configure the communication properties of the SIMATIC NET OPC server. 

● Configure connections. 

● Adopt the symbols from the SIMATIC S7 configuration. 

● Configure DP operation. 

● Set network parameters for PROFIBUS and Ethernet operation. 

● Configure the PC station remotely. 

● Download configuration data to the PC stations. 

● Store configuration and project engineering data in an XDB file. 

● Monitor the communication to connected S7 stations with diagnostic functions. 
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Initial configuration 
You can generate the initial configuration of your PC station in STEP 7 Professional (TIA 
Portal): 

● Configuration with STEP 7 Professional (TIA Portal) 

● Transfer of configuration and project data via the XDB file 

Further information in Help 
You will find help on all topics as well as detailed information in the integrated information 
system available with the menu command: 

● "Help" > "Show help" 

Here you will find help topics relating to the PC station under: 

Editing devices and networks > Configuring devices and networks > Creating 
configurations > Configurations for PC stations 

See also 
Commissioning for configured mode - Overview (Page 18) 

5.2.2 Creating a PC station 

The PC station in the STEP 7 Professional project  
The "SIMATIC PC Station" is an object in a SIMATIC STEP 7 Professional project. A typical 
PC station consists of the following elements: 

● One or more communications modules (CPs) 

● An OPC server application and/or other applications 

● In some situations, other controlling elements such as soft PLC or slot PLC 

One CP is connected to a PROFIBUS or Ethernet network over which other communication 
partners can be reached. 

Within the OPC server application, connections can be created and used for various 
protocols that describe the communications relations with the partner devices. 
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Aims 
You want to create configuration and project engineering data for communication services 
for individual PC stations. This database will then be downloaded to the PC station. After 
this, the PC applications can use the communications services. 

You can use this in the following ways: 

● On a local station, in other words, when your engineering station is the PC station at the 
same time, the parameters specified in the initial configuration with the "Station 
Configuration Editor" tool can be transferred later to the local project engineering system. 

● For transferring the data to an engineering station 

To allow the information from the project engineering to be transferred from an 
engineering system to the PC station, the local configuration must match the 
configuration data entered in the project engineering. To make sure of this, you can 
create project engineering data locally on the PC station and then download it to the 
target PC station or import it using an XDB file. 

Creating and managing objects 
After starting SIMATIC STEP 7 Professional (TIA Portal), you either open an existing project 
or create a new one. You use projects to manage your configurations consisting of all or part 
of the stations of your plant. 
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Within a project, objects are arranged in the "Network view". For each PC station, a separate 
object of the type "PC station" is created. The configuration and parameter assignment data 
of the hardware and software is located within these objects. These objects are then used to 
assign the communications services. 

 

 Note 

The name of the PC station you select here identifies the PC configuration. 
• If you configure on the local station with STEP 7 Professional (TIA Portal), select the 

name identical to the name in the local configuration. 
• If you configure a remote PC station, the name you select must not be identical to the 

local PC configuration! When you download, you would otherwise overwrite the local 
configuration. 

Tip: You can also adapt names, when necessary, in the Station Manager using the "Station 
Configuration Editor". 

 

Follow the steps below: 
1. Start STEP 7 Professional (TIA Portal). 

2. Change to the project view. 

3. Select the "Devices and networks" view 

4. You can create the PC station with the "Add new device" function or using the .hardware 
catalog. 

5.2.3 Configuring the PC station in STEP 7 Professional (TIA Portal) 

Creating an image of the PC configuration 
To allow the configuration data sent by the configuration system to be assigned to a module 
or an application, it must have a unique identification number. The identification number for 
modules, applications, and other components in a PC station is the index.  

You place your applications and modules in slots in a "virtual rack". This slot number then 
corresponds to the index mentioned above. 
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Component management of a PC station  

 
This procedure corresponds to the one already described for the "Station Configuration 
Editor" tool. 

 

 Note 

Be careful not to confuse this "index" with a hardware slot, for example on the PCI bus of the 
PC station. The slot on the PCI bus is not relevant for commissioning and is not used at any 
point. 
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Follow the steps below: 
Drag the components from the catalog to the PC station in the network view ("virtual rack") in 
STEP 7 Professional (TIA Portal). 

 

 Note 

Please note the following if you are transferring data by downloading: 

Make sure you arrange the components exactly the same as in the configuration list of the 
"Station Configuration Editor" (refer to the section "Managing components: "Components" 
tab (Page 172)"). If the configuration differs, the configuration data that you download from 
STEP 7 Professional (TIA Portal) to the PC station will not be adopted correctly. 
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PC components in the catalog 
For the SIMATIC PC station, you can select the following components: 

●  User applications 

– Application (standard application) 

You use standard interfaces to communicate with other applications and devices via 
your PC module. 

The user programs included in the application use suitable interfaces for 
communication, such as the SAPI programming interface or the SEND/RECEIVE 
programming interface. 

You can configure the following communications services depending on the module 
inserted: 

- Connectionoriented services 

- DP services (for example, DPV0 and DPV1) 

- PROFINET IO 

Note how these differ from the user programs that use the communication service as 
OPC clients via an OPC Server as described below. 

– OPC server 

You use the convenient interface to an OPC server to communicate with a 
programmable controller such as a SIMATIC S7400. 

The OPC server can be configured as an interface to all available communication 
protocols. You can create this object only once in a PC station.  

You can then use this OPC server for communication with any number of user 
programs (OPC clients).  

The following communications services can be used depending on the modules 
inserted: 

- All types of connection 

- DP services 

- PROFINET IO 

●  Communications modules > PROFINET / Ethernet 

This contains all the CP modules for attachment to Industrial Ethernet. 

●  Communications modules > PROFIBUS 

This contains all the CP modules for attachment to PROFIBUS. 
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5.2.4 Creating a DP master system 
Read the information below if you want to use a PROFIBUS CP and configure a DP master 
system. 

Significance of the configuration data in a DP master system 
The configuration data inform the DP master in the PC station of the data and address areas 
of the attached slaves. 

Depending on the type of slave, this information is either implicitly linked to the entry in the 
catalog or must be configured here additionally as, for example, when using an intelligent DP 
slave such as the CP 3425. 

Follow the steps below: 
1. Insert an OPC server and a "CP 5623" PROFIBUS communication module into a PC 

station. 

2. After you have taken the module from the catalog, you can select the PROFIBUS 
interface of the CP and then select "Assign master system" from the shortcut menu. The 
CP then automatically becomes the DP master. 

3. If suitable, save the configuration. 

 
  Note 

You will find information on configuring the DP slave in the section "Configuring a PC 
station as a DP slave (Page 188)". 

 

5.2.5 Creating a PROFINET IO system 
The following versions apply if you use a SOFTNET-IE-CP as PROFINET IO controller in the 
PC station and want to configure a PROFINET IO system. 

Significance of the configuration data in a PROFINET IO system  
The configuration data inform the PROFINET IO controller in the PC station of the data and 
address areas of the connected PROFINET IO devices.  

This data also includes the device names which the PROFINET IO controller assigns to the 
PROFINET IO devices during startup. 



Tools  
5.2 "STEP 7 Professional (TIA Portal)" 

 Commissioning PC Stations - Manual and Quick Start 
186 Configuration Manual, 10/2018, C79000-G8976-C156-19 

Follow the steps below: 
1. Insert an OPC server and a PROFINET/Ethernet "IE General" communication module 

into a PC station. 

2. After you have taken the module from the catalog, you can select it and create a 
PROFINET IO system with "Assign IO system" in the shortcut menu. 

If required, you can also connect an existing PROFINET IO system with the PROFINET 
IO controller you have just created by selecting the CP, right-clicking, and then selecting 
the "Connect PROFINET IO System" menu command. 

3. Select the application (OPC server) under "OPC configuration" in the Inspector window 
that will address the PROFINET IO system (the PROFINET IO devices). 

4. Now go to the catalog and insert the IO devices that will be addressed over the 
application. 

 

PROFINET IO devices 
PROFINET IO devices can be connected either directly to Ind. Ethernet or can be connected 
as PROFIBUS DP slaves to a DP master system. By using, for example, an IE/PB Link PN 
IO, you can address the DP slaves of a DP master system just like PROFINET IO devices. 

You will find further information here 
● Configuration 

In the information system of STEP 7 Professional (TIA Portal), you will find detailed 
instructions on configuring a PROFINET IO system in the following topic: Editing devices 
and networks > Creating configurations > Configurations for PROFINET IO 

● PROFINET IO - system descriptions: Refer to /2/ and /3/ in the section "References and 
literature (Page 233)". 
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5.2.6 Configuring connections 

Meaning 
During operation, configured connections are established either implicitly or on request, 
depending on the parameter assignment. They are then available to the OPC server or the 
PC application for communication.  

Procedure 
Regardless of the application type, the general rules for connection configuration apply:  

● Communication connections are always assigned to an application. 

● In the PC station, the CP that supports the type of connection is used for the data 
transfer. 

● If there is more than one CP with this capability, you can use Routing to select the 
transmission path. 

Follow the steps below 
How to configure connections is described in detail in the information system of STEP 7 
Professional (TIA Portal) in: 

Configuring devices and networks > Configuring networks > Communication via connections 

Connections to SIMATIC S7 stations 
When you configure systems that include PC stations and SIMATIC S7 stations, the use of 
STEP 7 or STEP 7 Professional (TIA Portal) is generally advisable. You can then edit and 
process every station type completely and with full functionality. 

After creating a new project in STEP 7 Professional (TIA Portal), you may find that the 
required destination station (for example an S7 station) may not exist depending on the 
particular application. You then have the following options: 

● Create an unspecified connection: 

Select "unspecified" as the connection partner. In the Properties dialog box, you can then 
set the address parameters for the connection partner.  

● Create a copy of an S7 station: 

Insert the copy of an S7 station that you have created in another project using STEP 7 
Professional (TIA Portal). You can then select this S7 station as your destination station.  
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5.2.7 Configuring a PC station as a DP slave 
This section explains how to create the project engineering for a PC station with the CP 5622 
as DP slave. 

Two situations can be distinguished: 

● The PROFIBUS DP master engineering was created in STEP 7 Professional (TIA Portal) 
(in the example as other PC station); 

● The PROFIBUS DP master cannot be configured in STEP 7 Professional (TIA Portal). 

In both cases, a CP 5622 is used as the DP slave. We are assuming a project in which a 
PROFIBUS DP master system has already been created. For a description, refer to the 
section "Creating a DP master system (Page 185)" 

5.2.7.1 DP master is known to STEP 7 Professional (TIA Portal) 
As an example, we first create a PC station that can take on the role of a DP slave (I-slave). 

Follow the steps below: 
1. Open the project with the DP master system. 

2. Insert a new SIMATIC PC station. The PC station adopts the role of the DP slave. 

3. Add a user application of the type OPC server or application in the PC station. 

4. Insert a module of the type CP 5622. 

5. Network the PROFIBUS interface with the DP master system you created earlier. 

6. Set the operating mode of the CP 5622 in the Inspector window to "DP Slave" and select 
the station configured as DP Master under "Assigned DP Master". 

7. Save the configuration. 

In the next section, the submodules of the DP slave will be configured with the inputs and 
outputs. 

Follow the steps below: 
To configure the inputs and outputs, you need to set up the transfer areas for the I-slave 
communication. 

1. Select the CP 5622 configured as DP slave in the network view. 

2. In the Inspector window, under "Mode > I-slave communication" select the table in which 
you can configure the inputs and outputs of the transfer areas. 

3. In the table view, click "Add new" to create a new transfer area. 

4. In the "General" tab, select the newly created transfer area. 
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5. Configure the inputs and outputs in the "Properties" dialog.  
If you want to create an I/O transfer area, enable the "Bi-directional address mapping" 
check box. 

6. Save and compile the configuration. 
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5.2.7.2 Configuration with a "third-party" DP master 

DP master system for configuring the DP slave 
If the DP master engineering cannot be done in STEP 7 Professional (TIA Portal), however 
you want to engineer the DP slave used in the PC station in STEP 7 Professional (TIA 
Portal), you will have to create a substitute DP master with a DP master system in the STEP 
7 Professional project. This can be a PC station as already described in this chapter or a 
SIMATIC S7 station. 

Create this substitute master in the project engineering just like a real DP master. You then 
simply require the project engineering data for the DP slave. 

Supplying the DP master with data from the GSD file 
The real DP master is supplied with the configuration data of the DP slave from a GSD file. 

Examples/model 
 

 Note 

Remember that a SOFTNET DP slave operated with OPC must have the PNO identification 
number 0x9001. 

 

There are sample GSD files in the "SIMATIC.NET\dp\demo_gsd" folder. 

● Two GSD files are intended for the CP 5613 A2/CP 5623 in the DP slave mode. 

– slv80b4.gsd 
Use this sample file when operating the CP 5613 A2/CP 5623 as a modular DP-V0 
slave or 

– slv180b4.gsd 
Use this sample file when operating the CP 5613 A2/CP 5623 as a non-modular DP-
V1 slave. 

● Two GSD files are intended for the CP 5614. 

– siem80b4.gsd 
Use this sample file when operating the CP 5614 as a modular DP-V0 slave or 

– siv180b4.gsd 
Use this sample file when operating the CP 5614 as a non-modular DP-V1 slave. 

● Two are intended for the SIMATIC NET SOFTNET PROFIBUS modules. 

– siem8076.gsd 
Use this sample file when operating the DP slave with an application of your own. 

– siem9001.gsd 
Use this sample file when operating the DP slave with OPC. This modular DP slave 
can be configured with STEP 7 Professional (TIA Portal). 
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5.2.8 Downloading the project engineering data to the PC station (after the initial 
configuration) 

To allow applications to exchange information over configured communication connections, 
the project engineering data created with STEP 7 Professional (TIA Portal) must be loaded 
on the PC station.  

If the initial configuration was performed with XDB import of the project engineering data, 
"loading" is already completed with the initial configuration. 

Refer to the explanations relating to initial configuration in the section "Steps for initial 
configuration (Page 24)". 

The section below describes how project engineering data can be downloaded to the PC 
station after the initial configuration. This is necessary when the project engineering data is 
not yet available at the time of the initial configuration, or to make changes to the project 
engineering data. 

Network, local load, and XDB file 
There are three possible ways of transferring a configuration from the project engineering to 
the PC station: 

● Online mode 

– Networked (engineering station networked with runtime PC) 

– Locally (project engineering station and PC station one and the same) 

● Offline mode (engineering station and runtime PC separate) - XDB import 
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5.2.8.1 Online mode 
 

 Note 

Downloading as described below only results in successful installation of the 
communications services on your PC station if the arrangement of the components in the 
configuration data is identical to that of the configuration data on the PC station.  

 

The online mode allows you to download the configuration data directly to a PC station 
attached to the network (MPI, PROFIBUS or Ethernet), or to load the data on the local PC 
station if you are using this as the configuration station. 

Online mode - networked (engineering station networked with runtime PC) 

 
Use this option when the following requirements are met: 

● The PC station (runtime PC) is also the configuration station. 

● The PC station (runtime PC) is coupled with the configuration station via a network. The 
PC station is accessible as a communications node, for example after setting the 
parameters in the initial configuration. 

● An existing connection is checked, for example, using the "Accessible Nodes" function. 
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Follow the steps below: 
 
Procedure for "downloading project engineering data to the PC station" 
 - online - networked 

Tool 

1. Check the following on the runtime PC: 
• The mode is set to online; 
• The runtime PC is not disabled. 

"Station Configu-
ration Editor" 

2. Select the station you want to download to in the STEP 7 Professional 
project. 

STEP 7 Profes-
sional (TIA Portal) 

3. Download the engineering data with Online → Download to device 
If you use PG mode: Make sure that you set the correct interface with 
Set PG/PC Interface (access point "S7ONLINE"). 

STEP 7 Profes-
sional (TIA Portal) 

Online mode - local (configuration station and PC station identical) 

 
This situation occurs when the configuration system is installed on the PC station 
(engineering station). 

In this case, the configuration data is transferred directly over an internal PC connection. 
Within the configuration system, you still use the known mechanisms for accessing the target 
system. 

Follow the steps below: 
 
Procedure for the step "downloading project engineering data to the PC station" 
 - online - local 

Tool 

1. Make sure that the following requirement is met: 
The access point of the application must be set as follows: 
S7ONLINE (STEP 7) → PC internal (local) 

STEP 7 Profes-
sional (TIA Portal) 

2. Select the station you want to download to in the STEP 7 Professional 
project. 

STEP 7 Profes-
sional (TIA Portal) 

3. Download the engineering data with Online → Download to device STEP 7 Profes-
sional (TIA Portal) 
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5.2.8.2 Offline mode (engineering station and runtime PC separate) - XDB import 
If you are working offline, you will require an XDB file to transfer the data. The project 
engineering system generates an XDB file for each configured PC station.  

The storage location of the configuration file can be found in the properties of the "PC 
Station" object in the configuration system. On the PC station, this file can be imported with 
the "Station Configuration Editor". 

 

Follow the steps below to create and import an XDB file: 
 
Procedure for "downloading project engineering data to the PC station" - offline Tool 

1. Select the station you want to download to in the STEP 7 Professional 
project. 

STEP 7 Profes-
sional (TIA Portal) 

2. Select the entry "XDB configuration" in the Inspector window. STEP 7 Profes-
sional (TIA Portal) 

3. Enable the check box beside "Generate XDB file" and check the set-
ting for "Path of the XDB configuration file". If necessary, change this 
setting. 

STEP 7 Profes-
sional (TIA Portal) 

4. Save and compile your project. You will then find the required XDB file 
in the folder you have selected. 

STEP 7 Profes-
sional (TIA Portal) 

5. Copy the XDB file onto a data medium that the destination station can 
access. 

Windows Explorer 

6. Import the XDB file into your destination PC station using the "Station 
Configuration Editor". 

"Station Configu-
ration Editor" 
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5.2.9 Adapting a configuration that does not match 

The "Station Configuration Editor" displays assigned indexes 
If you cannot download configuration information to the PC station, this may be due to a 
mismatched configuration. The "Station Configuration Editor" will provide you with an 
overview of the indexes allocated to the PC station. This is the tool for setting up the 
components installed in the PC station. 

Adapting the configuration 
There are two ways of matching up the actual local configuration of the PC station and the 
engineering as in your project. 

● Adapting the assignment in the project engineering 

Change the index assignment of the modules configured on the PC in the project 
engineering using STEP 7 Professional (TIA Portal) so that it matches the configuration in 
the "Station Configuration Editor". 

You will find the index assignment for each PC component under "General" in the 
Inspector window. 

● Changing the configuration on the PC station 

Using the "Station Configuration Editor" program, you can assign a different index to a 
component and change modules that are not set for configured mode to the configured 
mode.  

See also the description in the section ""Station Configuration Editor" (Page 171)". 

5.2.10 Initial configuration using remote configuration with STEP 7 Professional (TIA 
Portal) 

If you are putting PC modules into operation the first time, you will need to perform an initial 
configuration. After initial configuration of the PC modules, the PC station is set up to receive 
the project engineering data. 

You can perform an initial configuration for a PC station that can be accessed online and 
then load the configuration data. 

 

 Note 

If the PC station cannot be reached online, the initial configuration can also be performed 
offline in the PC station by importing an XDB file. 
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Requirements 
● You are in the network view. 

● On the target PC station, at least the "Remote basic communication" setting must be 
selected in the "Security" menu in the "Communication Settings" configuration program. 

Procedure 
Follow the steps outlined below to configure a PC station: 

1. From "PC systems" in the hardware catalog, drag a device for a PC station to the network 
view. 

2. Select the PC station. 

3. Under "Properties > General" in the Inspector window, change the name of the PC station 
to suit your application. 

4. Drag-and-drop other required components from the hardware catalog into the PC station. 
An inserted component is placed on a new index. 

5. Select the PC station in the network view. 

6. Select "Configure PC station online" in the shortcut menu to be able to perform the initial 
configuration of the PC station. 

7. In the "Configure" dialog, you can make various settings for your local area network, the 
reachable computers and the target PC station. 

8. Click "Configure...". You obtain an overview of the configuration to be adopted. 

9. Click "OK" to download the configuration to the target PC station. 
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5.3 "Symbol Editor" 
With the Symbol Editor, you can create symbol files of the type "ATI" that allow you the 
option of access to symbolic variables over the SIMATIC NET OPC server.  

Area of application / use cases 
The Symbol Editor is additional support tool. If you can access symbol files for the S7 
protocol that have already been created in STEP 7, you do not need the Symbol Editor. 

You can access existing symbol files and expand or modify them. 

Range of functions of the Symbol Editor 
The Symbol Editor provides the following options: 

● Creating your own hierarchical name space 

● Setting the properties of a symbol: 

– Visibility in OPC browsing 

– Access rights (readable/writable) for OPC clients 

– Value range of variables to support the "Percent Deadband" OPC functionality 

– Entry of the runtime name 

– Assigning the runtime name 

– Importing/exporting "CSV" files 

– Importing/exporting symbol files of the type "ATI" 

Startup and operation 
Select the following from the Start menu of the Windows operating system: 

Start menu "Start" > "..." > "SIMATIC NET" > "Symbol Editor" 

 The symbol editor with operation and symbol management is described in detail in the 
online help ("Help" >"Contents" menu). 
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5.4 "Communication Settings" 
The "Communication Settings" configuration program provides a variety of options for 
configuration and diagnostics of PC hardware components and PC user programs. 

The "Communication Settings" configuration program supports the following tasks in the 
communications system of a SIMATIC PC station: 

● Commissioning and operation 

● Editing the configuration 

● Diagnostics 

● Settings of the SIMATIC NET OPC servers 

How to start the "Communication Settings" configuration program 
Select the following from the Start menu of the Windows operating system: 

Start menu "Start" > "..." > "SIMATIC NET" > "Communication Settings" 
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Structure 
In the "Communication Settings" configuration program, you navigate as in the Windows 
Explorer, for example. Navigate on the left side (navigation area). On the right side 
(input/output area), you see the properties of the selected element (property object). The 
elements in the navigation area are grouped as follows: 
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① SIMATIC NET configuration *) > OPC settings, Autostart behavior 
② Modules *) > Configuration and restart of communication modules 
③ PC Configuration > Manage PC configuration components 
④ Trace settings *) > Set traces for OPC and applications 
⑤ Access points > Assign access names for modules 
⑥ Configure memory card > Manage interfaces for memory cards 
⑦ LLDP/DCP > Select communication modules for LLDP and DCP protocol 
⑧ PNIO adapter > Select communication modules for PNIO protocol 
⑨ SOFTNET-IE RNA (optional) > Set RNA configuration 
⑩ SIMATIC SHELL > Select communication module for WinCC communication 
⑪ System information > Display version numbers of installed SIMATIC software 
These elements are hierarchical. Clicking the arrow icon displays additional subfolders or elements. 

You will find the following elements in the menu bar above: 

● File > Refresh view and module list 

● Language > Set interface language 

● Help > Open online help, display program information 

 

5.4.1 Overview 
The following table and the following sections provide an overview of the available property 
pages in the navigation area. The property pages of the modules listed in the table are only 
available if a corresponding CP is available in the PC. For a detailed description of the 
property pages, refer to the online help for "Communication Settings". You can open the 
online help via the "Help" menu command or in the respective property page by clicking 
the"?" icon in the input/output area. 

 
Properties page in the navigation area For the modules ... 
SIMATIC NET configuration  
 OPC settings  
 Exiting OPC server All PC CPs 
 OPC protocol selection All PC CPs 
 Symbols All PC CPs 
 Safety All PC CPs 
 OPC UA certificates All PC CPs 
 Autostart All PC CPs 
Modules (PROFIBUS)  
 General All PROFIBUS PC CPs 
 Slave module CP 5614 A2/A3, CP 5624 
 Time CP 5613 A2/A3, CP 5614 A2/A3, CP 5623, CP 5624 
 COML S7 CP 5613 A2/A3, CP 5614 A2/A3, CP 5623, CP 5624, 

CP 5711 
 Version All PROFIBUS PC CPs 
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Properties page in the navigation area For the modules ... 
 Network diagnostics All PROFIBUS PC CPs 
 Bus node All PROFIBUS PC CPs 
 Bus statistics All PROFIBUS PC CPs 
 LSAP list CP 5613 A2/A3, CP 5614 A2/A3, CP 5623, CP 5624, 

CP 5711 
 Operating data CP 5613 A3, CP 5614 A3, CP 5623, CP 5624 
 USB connector CP 5711, PC Adapter USB A2 
 "Profibus, Auto, 

MPI" profile 
Address All PROFIBUS PC CPs 

 "Profibus, Auto, 
MPI" profile 

Firmware trace All PROFIBUS PC CPs 

 "FWL" profile All PROFIBUS PC CPs 
 "FWL_FAST_LOAD" profile All PROFIBUS PC CPs 
Modules (Ethernet)  
 General All Ethernet PC CPs 
 Address All Ethernet PC CPs 
 Network parameters CP 1613 
 TCP parameters CP 1613, CP 1623, CP 1628 
 Time CP 1613, CP 1623, CP 1628 
 COML S7 All Ethernet PC CPs 
 Version All Ethernet PC CPs 
 S7 Test All Ethernet PC CPs 
 SR Test All Ethernet PC CPs 
 Operating data CP 1613, CP 1623, CP 1628 
 Device details CP (SOFTNET-IE) 
 Firmware trace CP 1613, CP 1623, CP 1628 
 "TCP, Auto" profile TCP parameters CP (SOFTNET-IE) 
 "Auto" profile IE-PG access CP (SOFTNET-IE) 
 "ISO" profile CP 1613, CP 1623, CP 1628 
 "RFC1006" profile CP 1613, CP 1623, CP 1628 
PC configuration All Ethernet PC CPs 
Trace settings All Ethernet PC CPs 
OPC trace All Ethernet PC CPs 
Protocol trace All Ethernet PC CPs 
Access points All Ethernet PC CPs 
Setting parameters for the memory card All Ethernet PC CPs 
LLDP / DCP All Ethernet PC CPs 
PNIO adapter All Ethernet PC CPs 
SOFTNET-IE RNA CP (SOFTNET-IE) 

Only available if selected when installing the "SIMATIC 
NET PC Software". 

SIMATIC SHELL All Ethernet PC CPs 
System information All Ethernet PC CPs 
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5.4.2 Commissioning and operation 

5.4.2.1 Triggering a restart on the module 
The module is reset and the drivers, firmware, and databases are reloaded.  

 

 Note 

A restart is only possible if the module is not communicating and when it is not in configured 
mode. 

 

To restart the module, proceed as follows: 

1. Open the "Modules" folder in the navigation area. 

2. Select the relevant module and click on the "General" property object. 

3. Click the "Restart" button. 

If currently possible, the module is reset. The result of the restart is displayed in the text 
box. 

5.4.2.2 Forcing the OPC server to close down 
The OPC server for SIMATIC NET is started automatically by the operating system when a 
client wants to use it. The OPC server maintains reference counters to be able to recognize 
when the last registered client is closed. The OPC Server then closes itself down. This is 
only possible when the clients set and reset the user counters of the OPC Server correctly.  

If a client closes down irregularly and the user counter is not reset, the OPC server will not 
close down although no more clients are active. The server continues to keep the 
communication connections open. In this case, it is a good idea to stop the OPC server 
manually. 

Proceed as follows to shut down or start the OPC server: 

1. Open the "SIMATIC NET Configuration" folder in the navigation area. 

2. Select "OPC settings" and click on the "Quit OPC server" property object. 

3. Follow the instructions in the online help. 

 

 Note 

The OPC UA servers for which "UA" is enabled in the protocol selection are started 
automatically. However, they can also be closed and restarted via the "Exit OPC server" 
property object. 
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5.4.2.3 Activating configured protocols step by step 
By configuring a DP master system and connections, you specify which protocols will be 
used by the OPC server. 

During the commissioning of a system, it is sometimes useful to commission the protocols 
individually one after the other. With the procedure described below, you can first deactivate 
the configured protocols and then activate them again step by step. 

If you change the configuration, the manual protocol selection will be replaced by the 
automatic selection again. 

Proceed as follows to enable configured protocols step-by-step: 

1. In the navigation area, navigate to "SIMATIC NET Configuration" > "OPC Settings" > 
"OPC Protocol Selection". 

2. Deactivate the protocols you do not want the OPC server to use. 

3. Activate the protocols that were specified in the configuration and that you want to use as 
of now. 

4. Follow the instructions in the online help. 

5.4.2.4 Configuring OPC UA port 
The OPC UA servers have a default port for their TCP end point that is preset by installing 
the "SIMATIC NET PC Software". By knowing the relevant TCP/IP system configuration, you 
can configure this OPC UA port. 

Follow the steps below to configure an OPC UA port: 

1. In the navigation area, navigate to "SIMATIC NET Configuration" > "OPC Settings" > 
"OPC Protocol Selection". 

2. Select the OPC UA server for which you want to configure the OPC UA port. 

3. Follow the instructions in the online help. 

5.4.2.5 Setting a symbol file for OPC 
Proceed as follows if you want to use a symbol file for the OPC server: 

1. Open the "SIMATIC NET Configuration" > "OPC settings" > "Symbols" folder in the 
navigation area. 

2. Follow the instructions in the online help. 
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5.4.2.6 Setting traces 
A trace logs the internal sequences of the component. It allows you to check the functions, 
for example of a user program. Depending on the configuration, the actions of a software 
module are logged in a file. 

The following traces are available: 

● Traces of the OPC servers for Data Access and Alarms & Events / Alarms & Conditions 

● Trace of the protocol adapters of the OPC servers 

● Trace of the protocol libraries (using the "TraceConcept" program) 

 

 
 NOTICE 

Occurrence of unexpected timeouts 

The default setting of the traces must be used in normal operation, since changes can 
significantly reduce the execution speed of programs. Note that unexpected timeouts 
may occur as a result of the slowdown caused by the trace. 

SIMATIC NET notification service signals changes to trace settings so that you can 
immediately see that the above-mentioned operating restrictions may occur. 

 

Proceed as follows to set the traces for the OPC server or the protocol bindings: 
1. Go to "Trace settings" > "OPC trace" in the tree structure. 

Reaction: The table lists the possible traces for the protocols and the OPC servers in the 
display area. 

2. Follow the instructions in the online help. 

Follow the steps below if you want to create traces of the protocol libraries: 
1. Go to "SIMATIC NET Configuration" > "Trace settings" > "Protocol trace" in the tree 

structure. 

2. Click the "Call TraceConcept" button in the input/output area. 

3. In "TraceConcept", select the tree structure whose trace is to be enabled and make your 
settings. Click on "View Trace File" to view the results. 

 

 Note 

The settings made in "Trace Settings" are active immediately and do not need to be 
confirmed with a button. 

Updating the "View Trace File" window (if several are displayed, further tabs are shown at 
the top) takes up computing time and the window should only be displayed if you want to 
track an error online. 

Traces whose default setting has been changed are highlighted with a red exclamation mark. 
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5.4.2.7 Language setting 
The language of the program interface can be changed. The selected language is also used 
for the SIMATIC NET notification service. 

Proceed as follows to change the language setting: 

1. Click on "Language" > "Setting" in the menu bar. 

2. Follow the instructions in the online help. 

 

5.4.2.8 Automatic startup of applications and services 
Applications and services you set up on a PC station can be synchronized with the startup of 
the PC station. 

As soon as the PC station is operational, user applications and user services are started. 
 

 Note 

Do not use the Windows "Autostart" function for applications and services that are that 
require PC functionality. In Windows, the function is not synchronized with the PC station 
startup. 

 

To automatically start applications or services after the PC station has started, follow these 
steps: 

1. Open the "SIMATIC NET Configuration" folder in the navigation area. 

2. Select the "Autostart" folder. 

The applications to be started are shown in the upper list, the services to be started in the 
lower list. As default, both lists are empty. 

3. Follow the instructions in the online help. 
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Note for software developers 
Applications can be synchronized with the startup and shutdown using global events. 

● Event "SimaticNetPcStationUpEvent": 

The global event "SimaticNetPcStationUpEvent" is in the "signaled" state when the PC 
station has started up and is ready for OPC communication. Applications that require a 
started PC station and functioning OPC communication that previously had to wait for an 
undefined time can wait for the event and therefore be synchronized with the startup of 
the PC station. 

● Event "SimaticNetPcStationDownEvent": 

The global event "SimaticNetPcStationDownEvent" is in the "signaled" state when the PC 
station has not started up and is not therefore ready for OPC communication. 
Applications can wait for the event and therefore be synchronized with the shutdown of 
the PC station. 

The event objects "SimaticNetPcStationUpEvent" and "SimaticNetPcStationDownEvent" 
are never in the "signaled" state at the same time. As the state changes, however, both 
may briefly be in the "not signaled" state. 

Application example 
… 

HANDLE hUp = OpenEvent(SYNCHRONIZE, FALSE, "Global\\SimaticNetPcStationUpEvent"); 

DWORD dwResult; 

dwResult = MsgWaitForMultipleObjects(1, &hUp, FALSE, INFINITE, QS_ALLINPUT); 

// evaluate dwResult 

5.4.2.9 Security setting 
The default settings of the operating system do not allow any communication from 
applications over the network. 

The installation of the "SIMATIC NET PC Software" adds the OPC servers to the Windows 
firewall exception list, but this is not sufficient to enable operation with OPC. The firewall also 
lacks rules for other applications and ports, as well as new DCOM settings. 

To enter the missing rules for applications and ports in the firewall and make the new DCOM 
settings, follow these steps: 

1. Open the "SIMATIC NET Configuration" > "OPC settings" > "Security" folder in the 
navigation area. 

2. Follow the instructions in the online help. 
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5.4.2.10 Managing OPC UA certificates 
OPC UA certificates are used so that OPC UA clients and OPC UA servers can identify 
themselves during the OPC UA connection establishment. The OPC UA servers each have 
a server certificate with which they can identify themselves to an OPC client. Each OPC UA 
client also has a client certificate with which it identifies itself to an OPC UA server. 

Among other things, you can do the following: 

● View OPC UA server certificates and OPC UA client certificates 

● Reject or accept OPC UA client certificates 

● Import OPC UA client certificates 

● Export OPC UA server certificates and OPC UA client certificates 

● Recreate the OPC UA configuration 

 

 Note 

If you change the computer name after installing the "SIMATIC NET PC Software", the 
certificates installed for OPC UA are invalid and OPC UA will no longer work.  

Remedy: Create a new UA configuration with "Communication Settings" under "OPC UA 
Certificates" > shortcut menu "Recreate OPC UA configuration". 

 

Proceed as follows to display OPC UA certificates: 
1. Go to "SIMATIC NET Configuration" > "OPC settings" > "OPC UA certificates" in the tree 

structure. A list with the available OPC-UA certificates appears. 

2. Open the shortcut menu of the corresponding OPC UA client certificate and select 
"Display". 

3. Follow the instructions in the online help. 

Proceed as follows to accept an OPC UA client certificate: 
1. In the navigation area, navigate to "SIMATIC NET Configuration" > "OPC Settings" > 

"OPC UA Certificates". A list with the available OPC-UA certificates appears. 

2. Open the shortcut menu of the corresponding OPC UA client certificate and select 
"Accept". 

3. Follow the instructions in the online help. 

Proceed as follows to reject an OPC UA client certificate: 
1. In the navigation area, navigate to "SIMATIC NET Configuration" > "OPC Settings" > 

"OPC UA Certificates". A list with the available OPC-UA certificates appears. 

2. Open the shortcut menu of the corresponding OPC UA certificate and select "Reject". 

3. Follow the instructions in the online help. 
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Proceed as follows to import an OPC UA certificate: 
1. In the navigation area, navigate to "SIMATIC NET Configuration" > "OPC Settings" > 

"OPC UA Certificates" and open the shortcut menu of "OPC UA Certificates" with a right-
click. 

2. Select "Import client certificate" in the shortcut menu. 

3. Follow the instructions in the online help. 

Proceed as follows to export an OPC UA certificate: 
1. In the navigation area, navigate to "SIMATIC NET Configuration" > "OPC Settings" > 

"OPC UA Certificates". A list with the available OPC-UA certificates appears. 

2. Open the shortcut menu of the corresponding OPC UA certificate and select "Export". 

3. Follow the instructions in the online help. 

Proceed as follows to recreate the OPC UA configuration: 
1. In the navigation area, navigate to "SIMATIC NET Configuration" > "OPC Settings" > 

"OPC UA Certificates" and open the shortcut menu of "OPC UA Certificates" with a right-
click. 

2. Select "Recreate OPC UA configuration" in the shortcut menu. 

3. Follow the instructions in the online help. 

5.4.3 Configuration 

5.4.3.1 Configuration examples 
You can call up examples that show how certain use cases can be configured directly from 
the online help of the interface. 

Proceed as follows to call up the configuration examples: 

1. Select the entry "SIMATIC NET configuration" in the help menu. 

2. Navigate to a desired use case. 



 Tools 
 5.4 "Communication Settings" 

Commissioning PC Stations - Manual and Quick Start 
Configuration Manual, 10/2018, C79000-G8976-C156-19 209 

5.4.3.2 Editing the configuration 

Overview 
Among other things, you have the following configuration options available: 

● Change the mode of the module and set the index 

● Set the Industrial Ethernet network parameters for the CP 1613 

● Set the Industrial Ethernet station addresses for HARDNET Ethernet modules 

● Set the PROFIBUS station addresses and network parameters 

● Set the PROFIBUS station addresses and network parameters for the "AUTO" and "MPI" 
profiles 

● Set the IE PG access for SOFTNET IE modules 

● Set parameters for the memory card 

● Set the LLDP/DCP protocol 

● Set the PNIO adapter 

● Assign the application access points to the individual modules 

● Set the PROFIBUS DP slave mode 

● Set and edit the COML S7 connection lists 

● Configure the PC station 

● Select module for "SIMATIC SHELL" 

These options are described in the following sections. 

5.4.3.3 COML S7 

General 
The "COML S7" property page is assigned to each module in the "Communication Settings" 
configuration program. "COML S7" is a configuration software for S7 connections in the field 
of PC communication. With "COML S7", you can configure connections to S7 CPUs or PCs 
that are configured only at one end. One-sided means that no additional connection 
configurations have to be loaded on the partner station for these connections.  

The connections you create with "COML S7" are stored in the COML S7 connection lists. 
You will find more detailed information on COML S7 and the COML S7 connection lists in the 
online help of COML S7 properties page. 
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Settings for COML S7 connection lists 
The following basic settings are possible with the COML S7 connection lists. 

● Enable COML S7 connection lists 

● Disable COML S7 connection lists 

● Export COML S7 connection lists 

● Import COML S7 connection lists 

Follow the steps below to enable the COML S7 connection lists: 
You enable all COML S7 connection lists which are located in the navigation area under 
"Modules". You can then operate S7 communication via the created S7 connections. 

 

 Note 

Remember that enabled COML S7 connection lists cannot be modified. 
 

 Note 

S7 connections can be configured using STEP 7/STEP 7 Professional (TIA Portal) or COML 
S7. 

Simultaneous operation of these differently configured S7 connections is not possible. They 
are interlocked. After enabling the COML S7 connection lists, you cannot create any new 
components in the "Station Configuration Editor". This means that neither XDB import nor 
the downloading of a configuration in STEP 7/STEP 7 Professional (TIA Portal) is possible. 

 

1. Start "Communications settings". 

2. Right-click on "Modules" in the navigation area. 

3. Select the menu entry "Enable COML S7 connection lists...". 

4. Follow the instructions in the online help. 
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Displaying the created S7 connections in the enabled COML S7 connection lists 
You can view the created S7 connections of the COML S7 connection lists with an OPC 
client program, for example the OPC Scout V10. 

Once you have started the OPC Scout V10, follow the steps below: 

Display of the COML S7 connections to the partner stations S7-300/400 and S7-PC via the 
OPC COM interface: 

1. Open the directory of the "OPC.SimaticNET" OPC server under "Local COM servers" in 
the navigation area of OPC Scout V10. 

2. Now in the "\S7" folder, you will see all created S7 connections via which the OPC server 
communicates with the partner stations. 

Display of the COML S7 connections to the partner stations S7-300/400 and S7-PC via the 
OPC UA interface: 

1. Open the directory "UA servers" in the navigation area of the OPC Scout V10 and select 
the OPC UA server "OPC.SimaticNET.S7". 

2. Now in the "Objects > S7" folder, you will see all created S7 connections via which the 
OPC UA server communicates with the partner stations. 

Display of the COML S7 connections to the partner stations S7-1200, S7-1500 and S7-
1500S (only reachable via the OPC UA interface): 

1. Open the directory "UA servers" in the navigation area of the OPC Scout V10 and select 
the OPC UA server "OPC.SimaticNET.S7OPT". 

2. Now in the "Objects > S7OPT:" folder, you will see all created S7 connections via which 
the OPC UA server communicates with the partner stations. 

After an S7 connection has been established to the partner device, you can then read, write 
or monitor the process variables with the OPC Scout V10. 

Follow the steps below to disable the COML S7 connection lists: 
You disable all COML S7 connection lists located in the tree folder under "Modules". Before 
disabling, you should end existing S7 communication. After they have been disabled, you 
can once again make changes to the COML S7 connection lists. 

1. Start "Communications settings". 

2. Right-click on "Modules" in the navigation area. 

3. Select the menu entry "Disable COML S7 connection lists...". 

4. Follow the instructions in the online help. 
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Follow the steps below to export the COML S7 connection lists: 
You export all COML S7 connection lists located in the tree folder under "Modules" to a 
backup copy with the file extension ".lcx" or ".Icc". The export function is used to back up all 
COML S7 connection lists on this PC. Subsequent modification of the backup copy is not 
allowed. 

1. Start "Communications settings". 

2. Right-click on "Modules" in the navigation area. 

3. Select the menu entry "Export COML S7 connection lists...". 

4. Follow the instructions in the online help. 

 

 Note 
Note on the selection of the file format 

The preferred file format for exporting the COML S7 connection lists is ".lcx". This format 
contains the configuration of the earlier and newer generation of S7 CPUs (S7-300/400 or 
S7-1200, S7-1500, S7-1500S).  

The ".lcc" file format only contains the configuration of the earlier generation of S7 CPUs 
(S7-300/400). This guarantees compatibility with older versions of "Communication settings" 
that only support the ".lcc" format. 

 

 Note 
Note on password protected S7 connections 

In COML S7 it is possible to configure S7 connections to partner stations protected by a 
password (S7-1200, S7-1500, S7-1500S). 

Note that when exporting the COML S7 connection lists, these access passwords are not 
stored for reasons of data security. 
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Follow the steps below to import the COML S7 connection lists: 
You import a backup copy with the file extension ".lcx" or ",lcc" that you exported earlier. The 
COML S7 connection lists to be imported are automatically assigned to the relevant modules 
and existing COML S7 connection lists are deleted. 

Importing is only possible if the COML S7 connection lists have not yet been enabled.  

1. Start "Communications settings". 

2. Right-click on "Modules" in the navigation area. 

3. Select the menu entry "Import COML S7 connection lists...". 

4. Follow the instructions in the online help. 

 
  Note 

If a COML S7 connection list contains one or more S7 connections to partner stations 
that are protected by an access password, the following message appears: 

 

"You have imported one or more password protected connections. These must be 
enabled by entering the password. Follow these steps to enable a password protected 
connection: 

1. Select the CP with the protected connections under "Modules". 

2. Select "COML S7" in the structure tree. 

3. Select the password-protected connection. 

4. Enter the password in the "OPC" tab. 

5. Click on the "Apply" button. 

 

This message means that after importing the COML S7 connection list you need to enter 
the access password again for the corresponding S7 connections to enable access 
protection. If you do not enter a password, this connection is configured without access 
protection. 
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5.4.3.4 Changing the mode of a module 
When you first commission a module (initial configuration), the mode is specified by using 
the "Station Configuration Editor".  

In the following situations, it may be useful to change the operating mode of the module: 

● If you want to use the module for other purposes 

● If the bus parameters of the network were changed and you want to adapt the module to 
these parameters 

Follow the steps below if you want to change the operating mode of a module: 
1. Open the "Modules" folder in the navigation area. 

2. Select the required module and click on the "General" property object. 

3. Select the mode you want to use for the module: 

– Configured mode: 
The parameters for the module are set in the project engineering. 

– PG mode 
The parameters for the module are set in the "Set PG/PC Interface" or 
"Communication Settings" program. 

4. Follow the instructions in the online help. 

5.4.3.5 Displaying and setting Industrial Ethernet network parameters for CP 1613 A2 
The current settings for the following functions are displayed for the CP 1613 A2 Industrial 
Ethernet module and can be changed:  

● Duplex mode (half duplex, full duplex, automatic) 

● Medium type (AUI, TP, automatic) 

● Transmission rate (10 Mbps, 100 Mbps, automatic) 

Three sets of option buttons are available with which the user can select the duplex mode 
(half duplex, full duplex, automatic), the type of transmission medium (AUI, TP, automatic) 
and the transmission rate (10 Mbps, 100 Mbps, automatic). The default for all boxes is 
"automatic". After changing the defaults, you are requested to perform a restart. 

 

 Note 

If you select AUI as the medium type, you can no longer change the options for the 
transmission rate and duplex mode. In this case, 10 Mbps and half duplex are set. If, on the 
other hand, 100 Mbps or full duplex are selected, AUI can no longer be selected as the 
transmission medium. 
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Current setting 
Transmission parameters (current setting) 

Once the CP 1613 A2 has been restarted, the current transmission parameters are 
displayed in the respective fields. As long as no valid link to the partner is detected, the 
output box displays "unknown". 

Proceed as follows if you want to display and set the Industrial Ethernet network parameters of the 
CP 1613 A2: 

1. Open the "Modules" folder in the navigation area. 

2. Select the Ethernet module "CP 1613" and click the "Network Parameters" property 
object. 

3. Follow the instructions in the online help. 

5.4.3.6 Setting the Industrial Ethernet station addresses 
 

 Note 

The modules for SOFTNET Industrial Ethernet are managed by the Windows operating 
system. Therefore, the station addresses of these modules must be set using the standard 
mechanisms of Windows. 

 

Proceed as follows if you want to set the Industrial Ethernet station addresses of the CP 1613 A2, CP 
1623 or CP 1628: 

1. Open the "Modules" folder in the navigation area. 

2. Select a module of the type "CP 1613", "CP 1623" or "CP 1628" and click on the 
"Address" property. 

3. Follow the instructions in the online help. 

 
  Note 

The CP 1613 A2 has an adjustable MAC address which is for both NDIS and Industrial 
Ethernet. 
In contrast, the CP 1623 and CP 1628 have separate MAC addresses for NDIS and 
Industrial Ethernet. Only the Industrial Ethernet address can be set using the 
configuration. 
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5.4.3.7 Setting the PROFIBUS station address and network parameters in the "PROFIBUS" 
profile 

Proceed as follows to set the PROFIBUS station address and network parameters in the 
"PROFIBUS" profile: 

1. Open the "Modules" folder in the navigation area. 

2. Select the relevant PROFIBUS module and the "PROFIBUS" interface profile and click on 
the "Address" property object. 

3. Depending on the mode set for the module, you can modify or only check the address 
parameters. 

– Configured mode 

The parameters are set in the project engineering and cannot be changed. 

– PG mode 

The parameters can be changed. 

4. Follow the instructions in the online help. 

 

5.4.3.8 Setting the PROFIBUS station address and network parameters in the "AUTO" profile 

Follow the steps below if you want to set PROFIBUS station addresses and network parameters in 
the "Auto" profile: 

1. Open the "Modules" folder in the navigation area. 

2. Select the relevant PROFIBUS module with the "AUTO" interface profile and click on the 
"Address" property object. 

3. Depending on the mode set for the module, you can modify or only check the address 
parameters. 

– Configured mode 

The parameters are set in the project engineering and cannot be changed. 

– PG mode 

The parameters can be changed. 

4. Follow the instructions in the online help. 
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5.4.3.9 Setting the PROFIBUS station address and network parameters in the "MPI" profile 

Follow the steps below if you want to set PROFIBUS station addresses and network parameters in 
the "MPI" profile: 

1. Open the "Modules" folder in the navigation area. 

2. Select the relevant PROFIBUS module with the "MPI" interface profile and click on the 
"Address" property object. 

3. Depending on the mode set for the module, you can modify or only check the address 
parameters. 

– Configured mode 

The parameters are set in the project engineering and cannot be changed. 

– PG mode 

The parameters can be changed. 

4. Follow the instructions in the online help. 

5.4.3.10 Set the IE PG access for SOFTNET IE modules 
With TCP/IP networks, the address and the subnet mask decide which nodes belong to a 
subnet. Although many nodes can be connected to a physical network, these can be located 
in different subnets due to their address and subnet mask. If several subnets are defined, the 
PG/PC can only reach the nodes located in the same logical subnet as itself. To be able to 
reach the other automation nodes as well, "Communication Settings" provides the option of 
obtaining further IP addresses and subnet masks for the local PG/PC. This means that you 
can reach all automation nodes on this TCP/IP network with the PG. 

Follow the steps below if you want to set an IE PG access for SOFTNET IE modules: 
1. Open the "Modules" folder in the navigation area. 

2. Select the relevant SOFTNET IE module with the "TCPIP.Auto" profile and click on the 
"IE PG access" properties object. 

3. Follow the instructions in the online help. 
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5.4.3.11 Assigning access points to the individual modules 
By assigning an access point to an interface parameter assignment, you specify the access 
path of an application. This assignment is necessary only for applications that use the C 
interfaces (for example, SAPI S7, SRLib) and that use the application access point to 
address a device. 

To operate the OPC server and for applications that handle their communication over 
configured connections, it is not necessary to assign access points. 

Follow the steps below if you want to assign an access point of an interface parameter assignment to 
a module: 

1. Open the "Access points" folder in the navigation area. 

2. Follow the instructions in the online help. 

 
  Note 

Access points must not be changed during operation. 
 

  Note 
Important for PROFIBUS modules: 

With PROFIBUS modules, only one interface parameter assignment can be activated at 
any one time. If you select an interface configuration other than the active one by 
assigning an access point, it is activated and the new interface configuration is assigned 
to all access points to which interface configurations of this module are assigned! 

 

Follow the steps below if you want to create a new access point: 
1. Open the "Access points" folder in the navigation area. 

2. In the right-hand window, right-click and select "New access point" in the displayed menu. 

3. Follow the instructions in the online help. 

Follow the steps below if you want to delete an access point: 
1. Open the "Access points" folder in the navigation area. 

2. In the right-hand window, right-click on the access point you want to delete and click 
"Delete" in the displayed menu. 

3. Follow the instructions in the online help. 
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5.4.3.12 Setting parameters for the memory card 
On the "Set memory card parameters" property page, you can configure the interface of your 
PG/PC with which you can store user programs for S7 programmable controllers on memory 
cards. You can choose the following options: 

● None 

● Internal PG interface 

● External USB prommer 

Only the programming devices are shown that are available on the PC station. 

5.4.3.13 Setting LLDP/DCP 
The "LLDP/DCP" property page shows you the Ethernet modules that support LLDP and can 
respond to DCP queries. As default, all displayed modules are activated but they can be 
deactivated individually. If a PNIO controller configuration is loaded on the PC station, its 
station name will be used in the LLDP/TCP protocol. 

Proceed as follows to disable a module for the LLDP/DCP protocol: 

1. Select "LLDP/TCP" in the navigation area. 

2. Disable the check box of the modules with which you do not want to use the LLDP/TCP 
protocol. 

3. Follow the instructions in the online help. 

 

 Note 

The PC must be rebooted after enabling or disabling the LLDP/DCP function of a module. 
 

5.4.3.14 Setting PNIO adapters 
The "PNIO adapter" properties page shows you the Ethernet modules released for PNIO. As 
default, all displayed modules are enabled but they can be enabled/disabled individually with 
the relevant check box.  

Proceed as follows to disable a module for the PNIO protocol: 

1. Select "PNIO adapter" in the navigation area. 

2. Disable the check boxes of the modules with which you do not want to use the PNIO 
protocol. 

3. Follow the instructions in the online help. 

 

 Note 

After enabling or disabling the PNIO function of a module, the PC needs to be restarted. 
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5.4.3.15 Setting the PROFIBUS DP slave of the CP 5614 A2 / CP 5624 
To be able to use the DP slave module of the CP 5614 A2 or CP 5624 with OPC, configure 
the module as described below. It is not possible to configure these settings in STEP 7. The 
slave module configuration is effective only for use with the OPC interface. 

Proceed as follows to set the PROFIBUS DP slave: 

1. Open the "Modules" folder in the navigation area. 

2. Select the required module of type CP 5614 A2, CP 5614 A3 or CP 5624 and click on the 
"Slave Module" property. 

3. Follow the instructions in the online help. 

5.4.4 Diagnostics with "Communication Settings" 

Overview 
In diagnostics with "Communication Settings", you can, for example, do the following 

● Display the operability of the modules 

● Display the PROFIBUS network parameters 

● Display the Industrial Ethernet network parameters 

● Display the available network nodes 

● Display the LSAP list of individual modules 

● Display the bus statistics of individual modules 

● Read out the diagnostics data of the firmware of individual modules 

● Display the operating data of individual modules 

● Display the USB connector data of USB modules 

● Display the version information of hardware and software 

These options are described in the following sections. 

5.4.4.1 Displaying the operability of a PROFIBUS module 
Proceed as follows to display the operating property of a PROFIBUS module: 

1. Open the "Modules" folder in the navigation area. 

2. Select the module you want to diagnose and click on the "Network Diagnostics" property. 

3. The bus parameters and the version information of the module are queried and displayed 
here. 

By querying the module, the internal communication path is tested. The result of the 
operation is displayed.  

4. Follow the instructions in the online help. 
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5.4.4.2 Displaying Industrial Ethernet network parameters for CP 1613 A2 
The following current settings are displayed for the CP 1613 A2 Industrial Ethernet module: 

● Duplex mode (half duplex, full duplex, automatic) 

● Medium type (AUI, TP, automatic) 

● Transmission rate (10 Mbps, 100 Mbps, automatic) 

As long as no valid connection to the module is detected, the output boxes display the entry 
"unknown". 

Proceed as follows to display the network parameters of a CP 1613 A2: 

1. Open the "Modules" folder in the navigation area. 

2. Select the module you want to diagnose and click on the "Network Parameters" property 
object. 

3. Follow the instructions in the online help. 

5.4.4.3 Displaying PROFIBUS network nodes 
If the module is operational, a list with all the nodes on the bus is created after starting this 
function. 

If the module is currently communicating and the module supports the function, the list of bus 
parameters is created from local information of the module.  

If the module is not currently communicating or the module does not support the creation of 
a local list, the station addresses are queried over the network.  

This creates load on the bus and can take several seconds. 

Proceed as follows to display the PROFIBUS network nodes: 

1. Open the "Modules" folder in the navigation area. 

2. Select the relevant module and click on the "Bus Nodes" property object. 

3. Follow the instructions in the online help. 

5.4.4.4 Displaying PROFIBUS LSAP list 
Proceed as follows to display the PROFIBUS LSAP list: 

1. Open the "Modules" folder in the navigation area. 

2. Select the relevant PROFIBUS module and click on the "LSAP list" property object. 

After the call, the LSAPs of the module are listed with their relevant status. 

3. Follow the instructions in the online help. 
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5.4.4.5 Displaying PROFIBUS bus statistics 
Proceed as follows to display the PROFIBUS statistics: 

1. Open the "Modules" folder in the navigation area. 

2. Select the relevant PROFIBUS module and click on the "Bus statistics" property object. 

After the call, the bus events detected for the module are displayed. 

3. Follow the instructions in the online help. 

5.4.4.6 Reading our the trace of the module firmware 
Proceed as follows to read traces of the module firmware: 

1. Open the "Modules" folder in the navigation area. 

2. Select the appropriate module. If this involves a PROFIBUS module, select any interface 
profile. 

3. Click on the "Firmware trace" property object. 

4. Follow the instructions in the online help. 

5.4.4.7 Displaying operating data 
After the call, the operating data available for the module is displayed. 

● Operating time in hours 

● Operating temperature in degrees Celsius 

Proceed as follows to display operating data: 

1. Open the "Modules" folder in the navigation area. 

2. Select the relevant module and click on the "Operating data" property object. 

After the call, the operating data available for the module is displayed. 

– Operating time in hours 

– Operating temperature in degrees Celsius 

3. Follow the instructions in the online help. 
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5.4.4.8 SOFTNET IE - Show device details 
This property page displays the following information about IE modules: 

● Name 
Shows the name of the device. 

● Device Type 
Shows the type of the device. 

● Manufacturer 
Shows the manufacturer of the device. 

● Location 
Shows the slot number of the device. 

● Network connection 
Shows the name of the network connection as was assigned in the Control Panel of the 
PC for the network adapter. 

● Compatible identifier 
Shows the compatible IDs of the device. 

● Device instance identifier 
Shows the instance ID of the device. 

● Hardware identifier 
Shows the ID of the device. 

● Service 
Shows the service used by the device. 

5.4.4.9 Displaying USB connector parameters 
After the call, the USB connector parameters for the module are displayed. 

● USB version 

● USB speed 

● USB status 

You can also see whether the module is connected to an external power supply. 

Proceed as follows to view the USB port parameters: 

1. Open the "Modules" folder in the navigation area. 

2. Select the relevant module and click on the "USB connector" property object 

3. Follow the instructions in the online help. 
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5.4.4.10 Displaying version information of hardware and firmware 
After the call, the version information about the communication module is displayed. 

Proceed as follows to display the version information on the hardware and firmware: 

1. Open the "Modules" folder in the navigation area. 

2. Select the relevant module and click on the "Version" property object. 

3. Follow the instructions in the online help. 

5.4.4.11 PC configuration 
This property page displays the components of the PC station in an overview table. The 
following components are available:  

● OPC server 

● Application 

● Module 

Components describe the structure of a PC station. They are assigned to virtual slots. The 
assignment of components to slots may be required to enable loading of TIA Portal 
configurations. 

 

 Note 

If you are configuring the local PC, i.e. the TIA Cloud Connector connection is not active, you 
can use the "Station Configuration Editor" tool as an alternative.  

If you want to configure a remote PC via the TIA Portal Cloud Connector connection, this can 
only be done via this property page. 

 

Proceed as follows to display the components of the PC station: 

1. Open the "PC Configuration" element in the navigation area. 

2. Follow the instructions in the online help. 

5.4.4.12 SIMATIC SHELL 
On this property page, you can select the network adapter to be used for communication 
between WinCC and other SIMATIC products. The property page displays the available 
network adapters of the PC. 

Proceed as follows to display the selectable network adapters: 

1. Open the "SIMATIC SHELL" element in the navigation area. 

2. Follow the instructions in the online help. 
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5.4.4.13 System information 
The following information is displayed on this property page: 

● Version of the SIMATIC device drivers 

● Version of the SIMATIC device driver "WoW" (only with 64-bit systems) 

● Version of the TIA Portal Cloud Connector (if available) 

● Name, architecture and version of the operating system 

● Name of the user account and a list of the groups in which the current user is a member 

5.4.5 TIA Portal Cloud Connector mode 

5.4.5.1 Overview 
As of "SIMATIC NET PC Software V15 SP1", "Communication Settings" supports TIA Portal 
Cloud Connector mode.  

TIA Portal Cloud Connector operation offers the advantage that the SIMATIC NET 
configuration of one or more remote PCs (PC station) can be performed from a central 
location. SIMATIC NET configuration is preferably performed with a virtual machine (VM) 
located in the company cloud. 

The following two figures show an example of using the "TIA Portal Cloud Connector" in a 
virtual environment to configure the "SIMATIC NET PC Software" of a remote PC station, 
e.g. an IPC with connected production cell. The TIA Portal Cloud Connector tunnel is a TCP 
connection between the VM and the remote PC.  
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Figure 5-1 Remote Desktop Connection (RDP) to TIA Portal via separate PG/PC 

 
Figure 5-2 Remote Desktop Connection (RDP) to TIA Portal via IPC 
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5.4.5.2 Requirements for TIA Portal Cloud Connector mode 

Software requirements 
Note the following software requirements for operation between "SIMATIC NET PC 
Software" and "TIA Portal Cloud Connector": 

● A TIA Portal product is installed on the VM, which contains the "TIA Portal Cloud 
Connector" tool including "PC Identifier" as a component. The "Communication Settings" 
tool is installed via "PC Identifier", "Communication Settings" can be found in the 
"C:\Program Files\Common Files\Siemens" folder. 

● The "SIMATIC NET PC Software" including the required SIMATIC NET licenses and 
additionally the "TIA Portal Cloud Connector" is installed on the remote PC. The "TIA 
Portal Cloud Connector" can be copied from the TIA Portal Setup, for details see the 
document "Instructions on the TIA Portal Cloud Connector" on the Siemens support 
pages. 

Additional requirements 
Note the following additional requirements for using the TIA Portal Cloud Connector 
connection: 

● VM: 

– "SIMATIC NET PC Software" must not be installed on the VM, otherwise the "TIA 
Portal Cloud Connector" cannot be started as a "remote device". 

– On the VM, "PC Identifier" must have a version number that is compatible (equal to or 
higher) with the "PC Identifier" of the SIMATIC NET installation of the remote PC. 

● Remote PC (IPC): 

– "SIMATIC NET PC Software" as of version V15 SP1 must be installed on the remote 
PC. 

– To use the "TIA Portal Cloud Connector" as a "User Device", you need a 
corresponding TIA Portal Cloud Connector license. You can find detailed information 
on this license in the document "Instructions on the TIA Portal Cloud Connector" on 
the Siemens support pages. 
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5.4.5.3 Notes on installing "SIMATIC NET PC Software" 
From the VM, you can use a TIA Portal Cloud Connector connection on the remote PC (IPC) 
to make most of the available configuration settings of the "SIMATIC NET PC Software".  

Some settings cannot be made via a TIA Portal Cloud Connector connection, they must be 
made directly on the remote PC. 

 The following settings cannot be performed via a TIA Portal Cloud Connector connection, or 
only to a limited extent (*): 

● NDIS parameters of the SOFTNET IE modules (e.g. assignment of the IP address) 

● SOFTNET-IE RNA (creation of virtual network adapters) 

● Configuration of "Autostart" (starting programs after starting the PC station) 

● Setting the LLDP/DCP values and selecting the PNIO adapter (*) 

The corresponding values can be set via a TIA Portal Cloud Connector connection. The 
remote PC must be rebooted for these to take effect, however. The reboot cannot be 
triggered by the VM via "TIA Portal Cloud Connector". Setting the parameters via "TIA Portal 
Cloud Connector" is therefore only recommended if it is ensured that the remote PC is then 
rebooted in a different way. 

If you need these settings, proceed as follows: 

1. After installing "SIMATIC NET PC Software", open the "Communication Settings" tool on 
the remote PC. 

2. Set the desired values. 

3. Close "Communication Settings". 

5.4.5.4 Configuration of the remote PC via SIMATIC NET configuration 
Proceed as follows to configure the remote PC via the SIMATIC NET configuration: 

1. Log on to the VM as an administrator using a remote desktop connection (RDP). This is 
done either via a separate PG/PC or via the remote PC (IPC), see figures in the section 
"Overview (Page 225)". 

2. Start the "TIA Portal Cloud Connector" tool on the VM. 

3. Enable the TIA Portal Cloud Connector connection to the remote PC in the "TIA Portal 
Cloud Connector". 

4. Start the "Communication Settings" tool on the VM. 

The settings that you make in the "Communication Settings" tool are transferred to the 
remote PC via the "TIA Portal Cloud Connector". This receives them and forwards them to 
"SIMATIC NET PC Software", where they are applied. 
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5.4.5.5 Commissioning the TIA Portal Cloud Connector connection 
The TIA Portal Cloud Connector connection is commissioned in two steps: 

● Setting up, testing and activation of the TIA Portal Cloud Connector connection in the 
"TIA Portal Cloud Connector" tool 

● Calling up the "Communication Settings" tool in the VM 

Setting up and testing the TIA Portal Cloud Connector connection 
Proceed as follows to set up and test the TIA Portal Cloud Connector connection: 

1. Call up the "TIA Portal Cloud Connector" tool on the remote PC and set the "User Device" 
operating mode. 

2. In addition, select the type of connection and set up the connection parameters, e.g. 
secure connection based on mutual certificates. 

3. Save the settings and activate the "TIA Portal Cloud Connector", typically in autostart 
mode, so that the remote PC is ready to receive after each reboot. Successful activation 
of the "TIA Portal Cloud Connector" tool is indicated by the "yellow" color of the status 
icon for the online connection. 

4. Start the "TIA Portal Cloud Connector" tool on the VM and set the "Remote Device" 
operating mode. 

5. Select the type of connection and set up the connection parameters, for example, a 
secure connection based on mutual certificates. 

6. Test the TIA Portal Cloud Connector connection on the VM. 

7. To do this, select "Check connection" in the "TIA Portal Cloud Connector" tool. The test 
checks whether a TIA Portal Cloud Connector connection to the remote PC is possible. If 
the test is successful, save the settings and enable the "TIA Portal Cloud Connector". 
Successful activation of the "TIA Portal Cloud Connector" tool is indicated by the "yellow" 
color of the status icon for the online connection. 

 

 Note 

You can find detailed information on this topic in the document "Instructions on the TIA 
Portal Cloud Connector". 
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Calling up "Communication Settings" on the VM 
Proceed as follows to call up "Communication Settings" on the VM: 

1. Start the "Communication Settings" tool on the VM. "Communication Settings" attempts to 
establish a connection to the remote PC. 

2. Note the following information when the connection has been successfully established: 

● In the title bar of "Communication Settings", the addition "[remote:<Computer name of the 
remote PC]" is displayed after the connection is established. Check the name of the 
remote PC to make sure you are connected to the desired remote PC! 

● "Communication Settings" shows you the values of the remote PC. 

● Changes that you make in "Communication Settings" have an effect on the remote PC. 

● If you close "Communication Settings", the connection to the remote PC is closed. The 
color of the status symbol of the "TIA Portal Cloud Connector" changes from "green" to 
"yellow". 

● If you want to establish a TIA Portal Cloud Connector connection to another remote PC, 
you must enter and test the appropriate connection parameters on the VM in the "TIA 
Portal Cloud Connector" tool, as described above. 

 

 Note 

Actions performed in "Communication Settings" for TIA Portal Cloud Connector operation 
may take longer than you are used to in local mode. 

Also note the notes and restrictions in the online help of "Communication Settings" on the 
topic of TIA Portal Cloud Connector operation. 
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5.5 "OPC Scout V10" 
The OPC Scout V10 is an OPC application. You can test both local and remote OPC 
servers, read and write tags and receive alarms. 

To use OPC Scout V10, you must be familiar with the terms and mechanisms of OPC (OPC 
server and OPC client). You will find basic and detailed information on this topic in the 
"Industrial Communication with PG/PC" manual /1/. 

The operation of the OPC Scout V10 is described in detail in its online help, menu command 
"Help" > "Contents". 
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5.6 S7 connection diagnostics 
The "S7 Connection Diagnostics" program is useful for testing and commissioning 
configured S7 connections, in particular high-availability S7 connections. 

All configured S7 connections together with their states and other information are displayed 
in a list view. Both standard S7 connections and high-availability S7 connections (S7-
REDCONNECT) as well as S7 connections to optimized data blocks to an S7-1200 or S7-
1500 are supported. 

Changes of connection states or states of connection paths with high-availability S7 
connections become immediately visible. For example, you can simulate the failure of 
individual connection paths of high-availability S7 connections for a test and check with the 
S7 connection diagnostics whether the status change corresponds to the expected changes. 

See the online help of the application and a more detailed description in document /1/, 
section "High-availability S7 connections, what is this?". 
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/1/ SIMATIC NET, manual 

Industrial Communication with PG/PC Basics and 
Industrial Communication with PG/PC Volume 2 - Interfaces  
Part of 
• the manual package Industrial Communication with PG/PC 
• "SIMATIC NET PC Software" 
Siemens AG 

  
/2/ On the use of PROFINET IO and PROFINET CBA: 

PROFINET System Description  
system manual  
Siemens AG 

  
/3/ On configuring and programming PROFINET IO: 

From PROFIBUS DP to PROFINET IO 
Programming manual 
Siemens AG 

Article numbers 
● The part numbers for the above-mentioned SIEMENS documentation are contained in the 

catalogs "SIMATIC NET Industrial Communication, Catalog IK PI" and "SIMATIC 
Automation Systems SIMATIC S7 / M7 / C7 - Components for Fully Integrated 
Automation, Catalog ST70". 

● You can order these catalogs and obtain further information from your local SIEMENS 
office or national head office. 
You can find further information on catalogs and ordering details in the Siemens Industry 
Mall 
(https://mall.industry.siemens.com/goos/WelcomePage.aspx?regionUrl=/de&language=e
n). 

● You can find some of the documents mentioned here on the DVD "SIMATIC NET Manual 
Collection", which is included with some communication processors and the "SIMATIC 
NET PC Software" DVD.
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